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organizer
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Say good-bye to paper calendars and throw away those 
scribbled to-do lists. Your Treo™ Pro Smartphone by Palm is all 
you need to organize your personal information and keep it with 
you wherever you go.

You never lose your information, even if your battery is 
completely drained. All your personal information is backed up 
each time you synchronize, and your information is kept private 
when you use the security features available on your 
smartphone. Also, you can easily share info with others 
electronically.

Benefits

• Track current, future, and past 
appointments

• Make to-do lists that get done 

• Set reminders for appointments, 
birthdays, important tasks, and 
more
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Contacts

Adding a contact

1 Go to your Today screen and press 
Contacts (left softkey).

2 Press New (left softkey).

3 Use the 5-way navigator to move 
between fields as you enter 
information.

Here are some helpful tips for entering 
info:

• To enter complete name or address 
(work, home, or other) information, 
tap the arrow on the right side of the 
line and enter the information in the 
box that appears. When finished, tap 
outside the box to accept the 
information and close the box.

• To add a caller ID picture that is 
displayed when that person calls, 
select Picture, and then select 
Camera and take a picture, or select 
an existing picture from Thumbnail 
View. 

• To assign a ringtone to the entry, 
select Ring tone and select a tone.

TIP If you have set up a Windows Live account 
(see Using Windows LiveTM), you can save the 
contact as a Windows Live contact. A 
Windows Live contact synchronizes with your 
Windows Live contacts list but not with 
Microsoft Outlook on your computer.

TIP Take some time to scroll down through all 
the fields in a new contact. There are fields for 
multiple addresses, phone numbers, email 
addresses, and much more.

TIP Be sure to enter mobile numbers and 
email addresses in the correct fields so that 
Messaging can find this info when you 
address a message and Calendar can find your 
contacts when you want to invite them to 
meetings.
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• To assign the entry to one or more 
categories, select Categories and 
then check the categories under 
which you want this entry to appear. 
To add a new category, press New 
(left softkey), enter the category 
name, and press OK .

4 (Optional) To add a note to an entry, 
select the Notes tab.

5 After you have entered all the 
information, press OK . 

Viewing or changing contact information

1 Go to your Today screen and press 
Contacts (left softkey).

2 In the Contacts list (viewed by name), 
begin entering any combination of 
letters from the contact’s first and/or 

last name. If you use both first- and 
last-name letters, separate them by a 
space.

You can type letters from the last name 
first. For example, entering SM finds 
both Smilla Anderson and John Smith. 
Entering SM AN finds both Smilla 
Anderson and Ann Smith.

3 Select the entry you want to open.

4 Press Menu (right softkey) and select 
Edit.

DID YOU KNOW? If you want to create a new 
contact that shares information with an 
existing contact—for example, they both work 
at the same company—you can make a copy 
of the first contact and then edit only the 
fields you need to change for the new contact. 
In the contacts list, highlight the first contact, 
press Menu (right softkey), and then select 
Copy Contact.

TIP You can also find a contact by tapping the 
first letter of the first or last name in the 
alphabetical index at the top of the Contacts 
list screen.

DID YOU KNOW? When you select a contact 
entry, you are presented with several options 
for contacting the person, depending on what 
information you have entered for the contact. 
For example, you may see options for calling a 
number associated with the contact, sending 
an email to the contact’s email address, or 
calling the last number you dialed to call the 
contact. Select a phone number to dial, or 
select a messaging option to create a new 
message addressed to the contact.
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5 Make changes to the entry as 
necessary.

6 Press OK .

Deleting a contact

1 Go to your Today screen and press 
Contacts (left softkey).

2 In the Contacts list, highlight the 
contact you want to delete.

3 Press Menu (right softkey) and select 
Delete Contact.

4 Select Yes to confirm the deletion.

Customizing Contacts

1 Go to your Today screen and press 
Contacts (left softkey).

2 Go to the Contacts list.

3 Press Menu (right softkey) and select 
Options.

4 Set any of the following options:

Show alphabetical index: Displays the 
alphabet at the top of the Contacts list. 
You can use this index to find a contact.

Show contact names only: Enables 
you to fit more names on the Contacts 
list by hiding everything but the 
contact’s name.

Area code: Specifies the default area 
code for new contact entries.

5 Press OK .

Finding a contact in an online address 

book

In addition to having contacts on your 
device, you can also access contact 
information from your organization’s online 
address book or Global Address List (GAL).

DID YOU KNOW? You can find a contact by 
company name. Open Contacts, press Menu 
(right softkey), and select View By > 
Company. Select a company name to see the 
contacts who work there.

TIP To view a particular group of contacts, 
press Menu (right softkey), select Filter, and 
then select the category you want to view.

TIP You can quickly send a text message to a 
contact from within the Contacts application. 
Select the contact name, press Menu (right 
softkey), and select Send Text Message.
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BEFORE YOU BEGIN Do the following:

• Make sure you are accessing Exchange 
Server 2007, or Exchange Server 2003 
upgraded to Service Pack 2.

• Add access to the online address book 
to your smartphone. See Adding an 
online address book.

• After adding the online address book, 
you must synchronize with the 
Exchange server in order for the 
Company Directory option to appear.

1 Go to your Today screen and press 
Contacts (left softkey).

2 Press Menu (right softkey), select 
Company Directory, enter the name of 
the contact, and select Search. 

Sending a contact

Your smartphone provides multiple options 
for sending a contact’s information to 
someone else.

1 Go to your Today screen and press 
Contacts (left softkey).

2 In the Contacts list, highlight the 
contact you want to send.

3 Press Menu (right softkey) and select 
one of the following options:

Beam a contact to a nearby device: 
Select Send Contact > Beam, and then 
select the receiving device.

Send a multimedia message 

containing the contact information: 

Select Send as vCard. Address the 
multimedia message and press Send 
(left softkey).

Calendar

Displaying your calendar

1 Press Calendar .

2 Press Menu (right softkey) and select 
View.

3 Select one of the following views:

TIP You can also send a message to the 
highlighted contact. Press Menu (right 
softkey) and select Send video message by 

mobile or Send picture message by mobile. 
These options appear only if the contact you 
select has a mobile telephone number 
associated with it.
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Agenda: Shows your daily schedule in 
list format. Upcoming appointments are 
bold; past appointments are dimmed. 
Agenda View displays a horizontal time 
strip at the top to show at a glance 
when you have an appointment.

Day: Shows your daily schedule in 
day-planner format.

Week: Shows your schedule for an 
entire week.

Month: Shows your schedule for a 
whole month. 

 A morning appointment

 An afternoon appointment

 Both morning and afternoon 
appointments 

 An all-day event

Year: Shows a calendar for a six-month 
period.

4 Use the 5-way to move to another day, 
week, month, or year (depending on the 
current view).

Creating an appointment

1 Press Calendar .

2 Press Menu (right softkey) and select 
New Appointment.

3 Enter a subject (description) and a 
location.

DID YOU KNOW? If your schedule contains a 
conflict—two appointments that overlap—you 
can see the conflict in both Day View and 
Week View.

TIP To switch views, press the left softkey. 
Don’t confuse the view name displayed above 
the left softkey with the current view. The left 
softkey displays the name of the next view 
you see when you press the key.
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4 Select Starts and select the starting 
date and time.

5 Select Ends and select the ending date 
and time.

6 Press OK .

Adding an alarm reminder to an event

1 Create an event and then select it.

2 Press Menu (right softkey) and select 
Edit.

3 Select Reminder, and then select 
Remind me.

4 Enter the number of minutes, hours, 
days, or weeks before the event you 
would like to receive the alarm.

1 Number of time units
2 Type of time units

5 Press OK .

Creating an untimed event

An untimed event, such as a birthday, 
anniversary, or vacation, does not occur at 
a particular time of day. These events 
appear as banners at the top of your 
calendar; they don’t occupy blocks of time. 
For example, “Submit Final Draft” in the 
following illustration is an untimed event.

TIP To “pencil in” an appointment, open the 
appointment, select Status, and then select 
Tentative.

TIP You can display your appointments on your 
Today screen (see Selecting which items 
appear on your Today screen).

DID YOU KNOW? An untimed event can last 
longer than a day.

1

2
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1 Press Calendar .

2 Press Menu (right softkey) and select 
New Appointment.

3 Enter a subject (description).

4 Select the starting and ending dates.

5 Select All Day, and then select Yes.

6 Press OK .

Scheduling a repeating appointment

1 Create an appointment or untimed 
event and then select it.

2 Press Menu (right softkey) and select 
Edit.

3 Select Occurs, and then select a repeat 
pattern. To create a repeat pattern, 
select Edit pattern and follow the 
onscreen instructions.

4 Press OK .

Sending a meeting request

You can email meeting invitations to 
contacts who use Outlook or Outlook 
Mobile.

BEFORE YOU BEGIN Create contact 
entries with email addresses for the people 
you want to invite to a meeting (see Adding 
a contact). You cannot access contact 
entries without email addresses from your 
calendar.

1 Create an event and then select it.

2 Press Menu (right softkey) and select 
Edit.

3 Select Attendees. 

4 Select Add Required Attendee, and 
then select the name of the contact you 
want to invite. To invite other attendees, 
select Add Required Attendee, and 
then select the names.

TIP To enter a birthday or an anniversary, 
create an untimed event that repeats every 
year.
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5 (Optional) To invite optional attendees, 
select Add Optional Attendee, and 
then select the names.

6  Press OK .

The next time you synchronize, the 
meeting request is sent to the attendees. 
When attendees accept your request, the 
meeting is automatically added to their 
schedules. When you receive their 
response, your calendar is updated as well.

Replying to a meeting request

You receive and reply to meeting requests 
in the Messaging application (see Working 
with meeting invitations). If you accept or 
tentatively accept an invitation, it shows up 
as an appointment in your Calendar.

Marking an event as sensitive

If other people have access to your 
Outlook calendar on your computer and 
you don’t want them to see an 
appointment, you can mark that 
appointment as private to hide it from other 
Outlook users.

1 Create an event and then select it.

2 Press Menu (right softkey) and select 
Edit.

3 Select Sensitivity, and then select one 
of the following:

Personal: Displays the event on your 
smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Personal” near the 
top of an open appointment.

Private: Displays the event on your 
smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Private” near the 
top of an open appointment. If you sync 
with an Exchange server, other users 
who can access your folders can’t see 
your private events; they see private 
events as unavailable time slots.

DID YOU KNOW? If you are using Exchange 
Server 2007, or Exchange Server 2003 SP2, 
you can use your corporate Global Address 
List to find contact information for an 
attendee. Select Attendees, select Add 

Required Attendee or Add Optional 

Attendee, press Menu (right softkey), and 
then select Company Directory. Enter the 
name of the attendee and select Find.
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Confidential: Displays the event on 
your smartphone and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Confidential” near 
the top of an open appointment. 

4 Press OK .

Organizing your schedule

Use categories to view various types of 
events.

1 Create an event and then select it.

2 Press Menu (right softkey) and select 
Edit.

3 Select Categories and check the 
categories that apply to this event. 
To add a new category, press New (left 
softkey), enter the category name, and 
press OK .

4 Press OK  two more times.

5 After you assign events to categories, 
press Menu (right softkey) and select 
Filter.

6 Select the type of events you want to 
view.

Deleting an event

1 Highlight the event you want to delete.

2 Press Menu (right softkey) and select 
Delete Appointment.

3 Select Yes to confirm the deletion.

TIP If you don’t see an option on the screen, 
press Down on the 5-way to scroll to other 
options. For example, when editing an event, 
you don’t see the Sensitivity option until you 
scroll toward the bottom of the entry.

TIP Wonder why you’re not seeing all the 
events in your day? Check to make sure that 
the filter is set to All Appointments.
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Customizing Calendar

1 Press Menu (right softkey) and select 
Tools > Options.

2 On the General tab, set any of the 
following options:

Start in: Specifies which view is 
displayed when you open Calendar.

1st day of week: Specifies Sunday or 
Monday as the first day of the week for 
all Calendar views.

Week view: Specifies whether five, six, 
or seven days appear in Week View.

Show half hour slots: Specifies 
whether time slots appear in hour or 
half-hour increments in Day View and 
Week View.

Show week numbers: Specifies 
whether week numbers (1 through 52) 
appear in Week View.

3 Select the Appointments tab and set 
any of the following options:

Set reminders for new items: 
Specifies whether a reminder is 
automatically added to new events and 
how long before the event the reminder 
appears. You can override this setting 
for individual events.

Show icons: Specifies which icons 
appear next to events. 

 The event has a reminder.
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 The event repeats in a specified 
pattern.

 The event has a note attached.

 A location has been assigned to the 
event.

 The event is a meeting.

 The event is marked private.

Send meeting requests via: Specifies 
the email account used to send meeting 
requests.

4 Press OK .

Sending an appointment

1 Press Calendar .

2 Highlight the appointment you want to 
send.

3 Select one of the following: 

Beam an appointment to a nearby 

device: Press Menu (right softkey) and 
select Beam Appointment. Select the 
receiving device.

Send a multimedia message 

containing the appointment: Press 
Menu (right softkey) and select Send as 

vCalendar. Address the multimedia 
message and press Send (left softkey). 

Tasks

You can use Tasks to remind you of tasks 
you need to complete and to keep a record 
of completed tasks.

Adding a task

1 Press Start  and select Programs.

2 Select Tasks .

3 Press Menu (right softkey) and select 
New Task.

4 Enter a description of the task in the 
Subject field.

TIP Not all icons appear in all Calendar views.



Y O U R  P E R S O N A L  I N F O R M A T I O N  O R G A N I Z E R

T A S K S216

10
C

H
A

P
T

E
R

5 Set any of the following:

Priority: Specifies the priority level for 
this task. Later you can arrange your 
tasks based on the importance of each 
task.

Status: Indicates whether the task is 
now completed.

Starts: Specifies when the task begins.

Due: Specifies the due date for the 
task.

Occurs: Indicates if the task repeats at 
regular intervals and how often it 
repeats.

Reminder: Sets an alarm for this task 
and indicates when you want to be 
reminded.

Categories: Assigns the task to one or 
more categories. To add a new 
category, press New (left softkey), enter 
the category name, and press OK .

Sensitivity: Marks this task as Normal, 
Personal, Private, or Confidential (see 
Marking an event as sensitive for 
descriptions of these terms).

6 (Optional) Select the Notes tab and 
enter additional text for the task.

7 Press OK .

TIP You can also add a task by selecting the 
Tasks entry bar at the top of the task list 
screen, entering the task description, and 
pressing Center on the 5-way. Select the 
icons to the left of the bar to set the task as 
high or low priority.

TIP You can display your tasks on your Today 
screen (see Selecting which items appear on 
your Today screen).
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Checking off a task

1 Highlight the task you want to check off.

2 Press Complete (left softkey).

Organizing your tasks

1 In the Tasks list, press Menu (right 
softkey) and select Filter.

2 Select which tasks you want to view: 
All Tasks, Recently Viewed, 
No Categories, Active Tasks, 
Completed Tasks, or a specific 
category, such as Business or Personal.

3 Press Menu (right softkey) and select 
Sort By.

4 Select the sort method: Status, 
Priority, Subject, Start Date, or 
Due Date.

Deleting a task

1 Highlight the task you want to delete.

2 Press Menu (right softkey) and select 
Delete Task.

3 Select Yes to confirm the deletion.

Customizing Tasks

1 Go to the Tasks list.

2 Press Menu (right softkey) and select 
Options.

3 Set any of the following options:

Set reminders for new items: 
Automatically adds a reminder to new 
tasks. The default reminder is set to 
8:00 on the morning the task is due. You 
can override this setting for individual 
tasks by using the Reminder field on the 
task entry screen.

TIP You can also mark a task complete by 
tapping the check box next to the task on the 
Tasks list.

DID YOU KNOW? Overdue tasks appear in red.
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Show start and due dates: Displays 
task start and due dates in the Tasks 
list.

Show Tasks entry bar: Displays the 
Tasks entry bar at the top of the Tasks 
list.

4 Press OK .

Notes

Notes are a great way to capture thoughts, 
questions, and meeting notes on your 
smartphone. You can also create a voice 
note or add a recording to an existing note.

BEFORE YOU BEGIN On a Windows XP 
computer, to take advantage of all the sync 
features available in the Notes application, 
install ActiveSync desktop software from 
your smartphone (see Installing Desktop 
Sync Software: Windows XP and Windows 
Vista).

Creating a note

1 Press Start  and select Programs. 

2 Select Notes .

3 Press New (left softkey).

4 Do one of the following:

• Type the text by using the keyboard.

• If you turned on writing mode (see 
Customizing Notes), write the text 
with the stylus.

• Press Menu (right softkey), select 
Draw, and draw a sketch with the 
stylus, crossing at least three ruled 
lines.

5 Press OK .

Creating a voice note

1 Press Start  and select Programs.

2 Select Notes .

3 Do one of the following:
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To create a new voice note: Press 
New (left softkey).

To add a voice recording to an 

existing note: Open the note to which 
you want to add the recording.

4 If the voice note controls are not visible 
at the bottom of the screen, press 
Menu (right softkey) and select View 

Recording Toolbar. 

5 Tap the Record  icon.

* Voice note controls

6 Speak into the microphone on your 
smartphone, or hold it close to another 
sound source.

7 After you finish recording, tap the 
Stop  icon. A Recording  icon 
appears in the note or note list, 
depending on where you recorded the 
note.

8 Press OK .

Creating a note from a template

1 Go to the Notes list.

2 Tap the Show list in the upper-left 
corner and select Templates. If you do 
not see the Templates folder, select 
More Folders.

3 Open the template you want to use.

4 Enter the information.

5 Press OK .

6 Rename the note and move it to the 
appropriate folder. See Organizing your 
notes for details.

*

DID YOU KNOW? You can add several voice 
notes within a single note.

TIP To play a recording, select the voice note 
in the Notes list, or open the note containing 
the recording and tap the Recording icon. Tap 
the controls at the bottom of the screen to 
control playback and volume.
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Organizing your notes

You can rename your notes, move notes to 
another folder, and move notes between 
your smartphone and an expansion card 
(sold separately) inserted into your 
smartphone.

1 Go to the Notes list and highlight a note 
you want to move or rename.

2 Press Menu (right softkey) and select 
Rename/Move.

3 Select Name and enter a new name for 
the note.

4 Select Folder, and then select the 
folder in which you want to store the 
note.

5 Select Location, and then select Main 

memory or Storage Card. The Storage 
Card option appears only if you have an 
expansion card (sold separately) 
inserted into your smartphone.

6 Press OK .

Deleting a note

1 Go to the Notes list and highlight the 
note you want to delete.

2 Press Menu (right softkey) and select 
Delete.

3 Select Yes to confirm the deletion.

Customizing Notes

1 Go to the Notes list.

2 Press Menu (right softkey) and select 
Options.

3 Set any of the following options:

Default mode: Makes the default entry 
mode either Writing or Typing. The 
default is Typing; if you change it to 
Writing, you can write notes directly on 
the screen using the stylus.

TIP To create a new template, open the note 
you want to save as a template. Press Menu 
(right softkey) and select Tools > Rename/

Move. Select Name and enter a name for the 
template. Select the Folder list and select 
Templates. Press OK.

TIP To create a new folder, go to the Notes list, 
tap the Show list in the upper-left corner, and 
select Add/Delete. Select New, enter a 
name for the folder, and press OK.
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Default template: Specifies the default 
template for new notes.

Save to: Indicates the default location 
where new notes are stored.

Record button action: Specifies what 
happens when you press and hold the 
Side button to record a voice note while 
in another application: whether the 
Notes application opens or whether you 
stay in the current application. This 

option applies only if you have changed 
the function of the Side button to open 
Notes (see Reassigning buttons).

4 Press OK .

TIP Tap Global Input Options to set options 
for entering text in any application (see Setting 
input options).
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Your Microsoft Office and 
other document tools

11

Your Treo™ Pro Smartphone by Palm enables you to take your 
office with you—including your Microsoft Office files. With 
Microsoft Office Mobile®, you can carry, create, view, and edit 
Microsoft Word, Excel®, and OneNote files directly on your 
smartphone. You can also view, carry, and manage PowerPoint® 
files on your smartphone. You can keep updated copies of the 
files on both your smartphone and your computer so that you 
can work on them in the most convenient location at any time.

You can also use Adobe Reader to view PDF files on your 
smartphone.

Benefits

• Manage Word, Excel, PowerPoint, 
and OneNote files on your 
smartphone

• Improve productivity by taking 
important docs, spreadsheets, and 
presentations with you

• Work with PDF files
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Synchronizing your 
Microsoft Office files

You can create and edit Microsoft Office 
files on your computer or on your 
smartphone and then synchronize the files 
so that changes you make show up on both 
your computer and your smartphone. How 
synchronization happens depends on two 
conditions:

Operating system: Do you use Windows 
XP or Windows Vista®?

Sync direction: Are you transferring files 
from your smartphone to your computer, or 
from your computer to your smartphone?

For information about installing desktop 
sync software and about synchronizing 
with your computer, see Installing Desktop 
Sync Software: Windows XP and Windows 
Vista.

Synchronizing files that are on your 

smartphone: Windows XP or Windows 

Vista

BEFORE YOU BEGIN Turn on the option to 
synchronize files (see Changing which 
applications sync).

To synchronize files that you capture on or 
copy to your smartphone, simply follow 
one of the procedures for synchronizing 
with your computer described in 
Synchronizing with desktop sync software. 

After you synchronize, you can view and 
edit the items on your computer (see 
Where are the changes I made to my file?).

Synchronizing files that are on your 

computer: Windows XP

1 Connect your smartphone to your 
computer with the USB cable.

NOTE Most ActiveSync desktop software 
options are available only when your 
smartphone is connected to your 
computer.
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2 On your computer, double-click the 
ActiveSync®  icon in the taskbar in 
the lower-right corner of your computer 
screen to open the ActiveSync desktop 
software window.

3 Under Information Type, double-click 
Files to view a list of all synchronized 
files.

4 Do either of the following:

• To copy a file from your computer to 
your smartphone, click Add, browse 
to and highlight the file, and click 
Open.

• To delete a file from the file sync 
folder on your computer and from 
your smartphone, highlight the file 
name and click Remove.

NOTE If you receive an error while 
synchronizing files, make sure that all the 
files you’re trying to sync are closed on 
both your computer and your smartphone.

TIP If the ActiveSync icon does not appear in 
the taskbar, click Start > Programs > 
Microsoft ActiveSync to open the 
ActiveSync window.

TIP If Files doesn’t appear under Information 
Type, open the Tools menu and select 
Options. Make sure the Files box is checked.

TIP If a Treo My Documents sync folder has 
been created on your computer, you can also 
synchronize by dragging files into the 
appropriate subfolder under that folder.



Y O U R  M I C R O S O F T  O F F I C E  A N D  O T H E R  D O C U M E N T  T O O L S

W O R D  M O B I L E ® 227

11

C
H

A
P

T
E

R

Synchronizing files that are on your 

computer: Windows Vista

1 On your computer, copy or save the file 
to the Documents\Documents on 
username’s Smartphone folder.

2 Connect your smartphone to your 
computer with the USB cable. 
Synchronization takes place 
automatically.

Where are the changes I made to my file?

Don’t look for the changed file in its original 
location on your computer. Only the 
synchronized version contains the changes, 
and that version is in the file sync folder. To 
find this folder, do one of the following:

Windows XP: On your computer desktop, 
double-click the file sync folder icon. This is 
a shortcut to the file sync folder.

Windows XP: In ActiveSync desktop 
software, double-click Files. The location of 
the file sync folder appears in the File 

Synchronization Settings dialog box (under 
On this computer, synchronize the files in 
this folder).

Windows Vista: Open the Documents\ 
Documents on username’s Smartphone 
folder.

On your smartphone, you can find the 
synchronized file by doing either of the 
following:

• Press Start  and select Office 

Mobile. Select the application that 
opens the file: Word Mobile , Excel 
Mobile , PowerPoint Mobile . or 
OneNote Mobile .

• Press Start , select Programs, and 
then select File Explorer . Tap the 
Show list in the upper-left corner and 
select My Device > My Documents.

Word Mobile®

With Microsoft Office Word Mobile®, you 
can create and edit documents and 
templates and save them as DOC, RTF, 
TXT, and DOT files. You can also edit 

DID YOU KNOW? The Documents on 
username’s smartphone folder is created 
when you select the option to sync Files.
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Microsoft Office Word documents and 
templates that you create on your 
computer. However, keep in mind that 
some of the information and formatting 
may be lost when you save the document 
on your smartphone.

The following features are not supported in 
Word Mobile:

• Backgrounds.

• Bidirectional text.

• Document protection.

• Metafiles.

• Artistic page borders. Lined page 
borders are supported.

• Password-protected files. Remove 
password protection on your computer 
before opening the file on your 
smartphone.

• Shapes and text boxes.

• Smart tags.

The following features are partially 
supported in Word Mobile:

Picture bullets: Regular bullets are 
supported.

Revision marks: Documents appear as 
though all revisions were accepted; if the 
document is saved, revision marks are lost.

Table styles: Some or all of the formatting 
is lost if the document is saved.

Underline styles: Unsupported styles are 
mapped to one of the four supported 
styles: regular, dotted, wavy, or thick/bold/
wide.

Legacy Pocket Word files: You can open 
PSW files, but if you edit a file, you need to 
save it in DOC, RTF, TXT, or DOT format.

The following features are not supported 
on your smartphone, but they remain in the 
file so that when you open the file on your 
computer, they appear as expected: 

Fonts and font sizes: Original fonts are 
listed on your smartphone and are mapped 
to the closest font available.

Footnotes, endnotes, headers, and 

footers.

DID YOU KNOW? If you have a PDF file (.pdf), 
you can view the file using Adobe Reader. 
Press Start, select Programs, and then select 
Adobe Reader (see Adobe® Reader® LE).
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Lists: Indented lists are mapped to the 
closest indentation level supported by 
Word Mobile.

Page breaks: Although not displayed, all 
page breaks, except a break placed at the 
end of a document, are retained in the 
document.

Creating a document

1 Press Start  and select Office 

Mobile.

2 Select Word Mobile .

3 The first time you open Word Mobile, a 
new document opens. Otherwise, 
press New (left softkey). 

4 Enter the text of the document.

5 Press OK  to save the file. When 
you save a new document, it is 
automatically named after the first 
several words in the file.

Opening an existing document

1 Press Start  and select Office 

Mobile.

2 Select Word Mobile .

3 In the document list, select the 
document you want to open.

Creating a document from a template

1 Go to the documents list.

2 Tap the Show list in the upper-left 
corner and select Templates. If you 
don’t see Templates in the Show list, 
select More Folders to access this 
folder.

3 Open the template you want to use.

4 Press Menu (right softkey) and select 
File > Save As.

5 Select Name and enter a new name for 
the file.

6 Select the Folder list, and then select 
the folder where you want to save the 
file.

7 Select the Type list, and then select the 
format in which you want to save the 
file.

8 Select the Location list, and then select 
whether you want to store the file on 

TIP To zoom in or out, press View (left 
softkey), select Zoom, and then select the 
zoom level.
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your smartphone (Main memory) or on 
an expansion card (Storage card). The 
Storage card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

9 Select Save.

Finding or replacing text in a document

1 Open the document containing the text 
you want to find.

2 Press Menu (right softkey) and select 
Edit > Find/Replace.

3 Select Find what and enter the text you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in the text you entered step 3.

5 (Optional) Check the Match whole 

words only box to find only full words 

that match the text you entered in 
step 3.

6 Select Find to locate the first instance 
of the text you entered in step 3, or 
select Replace and enter the 
replacement text.

7 Select Next to find the next instance of 
the text, or select Replace to replace it. 
To replace all instances of the text, 
select Replace All.

8 When you see a message indicating 
that the search is done, press OK .

Moving or copying text

1 Open the document containing the text 
you want to move or copy.

2 Highlight the text you want to move or 
copy.

3 Press Menu (right softkey) and select 
Copy to copy the text, or select Cut to 
move the text.

4 Open the document where you want to 
insert the text, and position the cursor 
where you want the text to appear.

5 Press Menu (right softkey) and select 
Paste.

TIP To create a new template, open the 
document you want to save as a template. 
Press Menu (right softkey) and select File > 
Rename/Move. Select Name and enter a 
name for the template. Select Folder, and 
then select Templates. Press OK.
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Saving a copy of a document

NOTE If a document was previously saved 
on a computer, any unsupported formatting 
may be lost when you save the file.

1 Open the document you want to copy.

2 Press Menu (right softkey) and select 
File > Save As.

3 Select Name and enter a new name for 
the file.

4 Select the Folder list, and then select 
the folder where you want to save the 
file.

5 Select the Type list, and then select the 
format in which you want to save the 
file.

6 Select the Location list, and then select 
whether you want to store the file on 
your smartphone (Main memory) or on 
an expansion card (Storage card). The 
Storage card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

7 Select Save.

Formatting text

1 Open the document you want to 
format.

2 Highlight the text you want to format.

3 Press Menu (right softkey) and select 
Format > Font.

4 Set any of the following options for the 
highlighted text:

Font: Specifies the typeface.

Font color: Specifies the color.

Size: Specifies the point size. 

Bold: Indicates whether the text 
appears normal or thick. 

Italic: Indicates whether the text 
appears upright or slanted.

Underline: Indicates whether the text 
appears with an underscore.

Highlight: Indicates whether the text 
appears with a yellow highlight.

Strikethrough: Indicates whether the 
text appears with a line through it.

5 Press OK  to return to the 
document.
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Formatting paragraphs and lists

1 Open the document you want to 
format.

2 Position the cursor in the paragraph you 
want to format.

3 Press Menu (right softkey) and select 
Format > Paragraph.

4 Set any of the following options:

Alignment: Aligns the text paragraph 
with the left, right, or center of 
the page.

List: Creates a bulleted or numbered 
list.

Indentation: Changes the paragraph 
margins.

• Left: Sets the left margin for the 
entire paragraph.

• Right: Sets the right margin for the 
entire paragraph.

• Special: Lets you indent the first line 
or set a hanging indent.

• By: Sets the size of the special 
indentation.

5 Press OK  to return to the 
document.

Checking spelling in a document

1 Open the document you want to check.

2 Press Menu (right softkey) and select 
Tools > Spelling. To check the spelling 
of specific text, highlight it before you 
select Spelling.

3 If an unknown or misspelled word is 
encountered, do one of the following:

• Select the correct word in the list if 
the word is spelled incorrectly.

• Select Ignore if the word is spelled 
correctly. Select Ignore All to skip all 
instances of the word.

• Select Add to add a new word to the 
spelling dictionary.

Organizing your documents

You can rename your documents, move 
your documents to another folder, and 
move your documents between your 
smartphone and an expansion card (sold 
separately) inserted into your smartphone.

TIP You can also use the Formatting toolbar to 
create a list and to align text. To indent text in 
lists, you must use the Formatting toolbar. 
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1 Go to the documents list.

2 Highlight a file.

3 Press Menu (right softkey) and select 
Rename/Move.

4 Select Name and enter a new name for 
the document.

5 Select the Folder list, and then select 
the folder to which you want to move 
the document.

6 Select the Location list, and then select 
whether you want to store the file on 
your smartphone (Main memory) or on 
an expansion card (Storage card). The 
Storage card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

7 Press OK .

Deleting a document

1 Go to the documents list.

2 Highlight the document you want to 
delete.

3 Press Menu (right softkey) and select 
Delete.

4 Select Yes to confirm the deletion.

Customizing Word Mobile

1 Go to the document list.

2 Press Menu (right softkey) and select 
Options.

3 Set any of the following options:

Default template: Sets the default 
template for new documents.

Save to: Sets the default location 
where new documents are stored.

Display in list view: Sets the types of 
files that appear in the documents list.

4 Press OK .

TIP To create a new folder, go to the 
documents list, tap the Show list in the 
upper-left corner, and select Add/Delete. 
Select New, enter a name for the folder, and 
press OK.

TIP When you go to a folder, you can easily 
search your documents by sorting by type.
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PowerPoint Mobile®

With Microsoft Office PowerPoint Mobile®, 
you can open and view slide show 
presentations created on your computer. 
Many presentation elements such as slide 
transitions, animations, and URL links are 
also supported. Microsoft Office 
PowerPoint features not supported on your 
smartphone include the following: 

• Notes written for slides 

• Rearrangement or editing of slides

• Files created in PPT format earlier than 
Microsoft PowerPoint 97

• HTML files in HTM and MHT formats

Playing a presentation

1 Press Start  and select Office 

Mobile.

2 Select PowerPoint Mobile .

3 In the presentation list, select the 
presentation you want to play.

4 Do any of the following:

• Press Right  to advance to the next 
slide, or Left  to view the previous 
slide.

NOTE If a presentation is set up as a timed 
slide show, the slides advance 
automatically. Presentations pause during 
zooming.

• Press Center , select Go to Slide, 
and then select the slide you want to 
view.

• Press Center  and select Next or 
Previous to play animations.

• To zoom in, press Center  and 
select Zoom In. Tap and drag the 
slide to scroll it.

5 To end the slide show, press Center  
and select End Show.

Setting presentation playback options

1 Highlight the presentation for which you 
want to change the settings.

2 Press Menu (right softkey) and select 
Set up show.

3 On the Orientation tab, select the 
orientation you want. To select the 
orientation that best fits your 
smartphone screen, select Default.
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4 Select the Playback tab, and check the 
Override playback options for all files 
box.

5 Set any of the following options:

Show without animation: Turns off 
builds and other animations.

Show without slide transition: Turns 
off transition effects between slides.

Use timings, if present: Enables the 
timings recorded with each slide in a 
presentation. If a presentation is set up 
as a timed slide show, the slides 
advance automatically. Presentations 
pause during zooming.

Loop continuously: Advances to the 
first slide after playing the last slide in a 
presentation.

6 Press OK .

Excel Mobile®

With Microsoft Office Excel Mobile®, you 
can create and edit workbooks and 
templates on your smartphone. You can 
also edit workbooks and templates that 
you create on your computer. However, 
you may lose some of the information and 
formatting when you save the workbook on 
your smartphone.

Note the following formatting 
considerations:

Alignment: Vertical text appears 
horizontal.

Borders: Appear as a single line.

Cell patterns: Patterns applied to cells are 
removed.

Fonts and font sizes: The original font is 
listed on your smartphone and mapped to 
the closest font available. Original 
fonts reappear on your computer.

Number formats: Microsoft Office 
Excel 97 conditional formatting is displayed 
in Number format.

TIP To turn the presentation into a 
continuously looping slide show, check both 
the Use timings, if present and the Loop 

continuously boxes.
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Formulas and functions: Unsupported 
functions are removed, and only the 
returned value of the function appears. 
Formulas containing the following are also 
converted to values:

• An array or array argument, for example, 
=SUM({1;2;3;4}).

• External link references or an 
intersection range reference.

• References past row 16384 are 
replaced with #REF!.

Protection settings: Most protection 
features are disabled but not removed. 
However, password protection is removed. 
You must remove the password protection 
in Microsoft Office Excel on your computer 
before opening the file on your 
smartphone.

Zoom settings: Worksheet-specific zoom 
settings are not retained. The zoom setting 
applies to the entire workbook.

Worksheet names: Names that refer to 
other workbooks, arrays, array formulas, or 
intersection ranges are removed from the 
name list, causing those formulas to be 
resolved as “#NAME?” All hidden names 
are not hidden.

AutoFilter Settings: AutoFilters that cause 
rows to be hidden are supported. Use the 
Unhide command to display hidden rows. 
Other AutoFilters are removed, but you can 
use the AutoFilter command in Excel 
Mobile to perform similar functions.

Chart Formatting: All charts are saved as 
they appear in Excel Mobile. Unsupported 
chart types are changed to one of these 
supported types: Column, Bar, Line, Pie, 
Scatter, and Area. Background colors, 
gridlines, data labels, trend lines, shadows, 
3D effects, secondary axes, and 
logarithmic scales are turned off.

The following features aren’t supported in 
Excel Mobile and are removed or modified 
when you open a workbook on your 
smartphone:

• Hidden, dialog, and macro sheets

• VBA modules

• Text boxes

• Drawing objects and pictures

• Lists

• Conditional formats and controls

• Pivot table data (converted to values)
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Creating a workbook

1 Press Start  and select Office 

Mobile.

2 Select Excel Mobile . If this is your 
first time to open Excel Mobile, a new 
workbook appears, and you can go to 
step 4.

3 Press New (left softkey).

4 Highlight a cell where you want to enter 
text or other info.

5 Enter the info into the cell and press 
Return .

6 Repeat steps 4 and 5 to enter the 
remaining info.

7 Press OK  to save the file. When 
you save a new workbook, it is 
automatically named and placed in the 
workbook list.

Creating a workbook from a template

1 Go to the workbook list.

2 Tap the Show list in the upper-left 
corner and select Templates. If you 
don’t see Templates in the Show list, 
select More Folders to access this 
folder.

3 Open the template you want to use.

4 Press Menu (right softkey) and select 
File > Save As.

5 Select Name and enter a new name for 
the workbook.

6 Select the Folder list, and then select 
the folder where you want to save the 
workbook.

7 Select the Type list, and then select the 
format in which you want to save the 
workbook.

8 Select Save.

Viewing a workbook

1 Press Start  and select Office 

Mobile.

2 Select Excel Mobile .

3 In the workbook list, select the 
workbook you want to view.

TIP To create a new template, highlight the 
workbook you want to save as a template. 
Press Menu (right softkey), select Rename/

Move, select Name, and then enter a name 
for the template. Select the Folder list, and 
then select Templates. Press OK.
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4 Press View (left softkey) and select any 
of the following:

Full Screen: Shows as much data as 
possible on the screen. To return to the 
normal view, tap Restore in the 
upper-right corner.

Zoom: Sets the magnification level so 
that you can easily read the worksheet.

Sheet: Lets you switch to a different 
worksheet.

Split: Divides the window into two 
scrollable areas. To move the split bar, 
tap and drag it. To remove the split bar, 
press View (left softkey) and select 
Remove Split.

Freeze Panes: Locks rows and columns 
so that they remain visible while you 
scroll. Highlight the cell at the point at 
which you want to lock before you 
select this command. To unlock the 
rows or columns, press View (left 
softkey) and select Unfreeze Panes.

Toolbar: Indicates whether the toolbar 
appears onscreen.

Status Bar: Indicates whether the 
status bar appears onscreen.

Show: Indicates whether headings and 
scroll bars appear onscreen.

Calculating a sum

1 Press View (left softkey) and select 
Toolbar.

2 Highlight the cell where you want to 
insert the sum.

3 Tap . 

4 Tap and drag the stylus across the cells 
you want to add. 

5 Press Return .

DID YOU KNOW? You can also switch 
worksheets by tapping the sheet list at the 
bottom of the screen.

TIP To jump to a cell or region, press Menu 
and select Edit > Go To. Select Cell 

reference or name and enter the target cell 
info, or select Current region. Select OK.

TIP For simple calculations, use the Calculator 
(see Calculator). 
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Entering a formula

1 Highlight the cell where you want to 
enter the formula.

2 Enter an equals sign ( = ) followed by 
any values, cell references, name 
references, operators, and functions.

Examples:

• =(B4/25)+100

• =Revenue-Expenses

3 Press Return . 

Referring to a cell or range in a formula

1 Open the workbook where you want to 
refer to a cell or range in a formula.

2 Begin entering a formula in a cell.

3 Navigate to the cell you want to refer to 
in the formula. To refer to a range, tap 
and drag the stylus over the cells you 
want to include in the range.

4 Finish entering the formula and press 
OK .

Inserting a function

1 Open the workbook where you want to 
insert the function.

2 Press Menu (right softkey) and select 
Insert > Function.

TIP Use the Alt key to insert an equals sign.

TIP To insert a symbol, place the cursor where 
you want the symbol. Press Menu (right 
softkey) and select Insert > Symbol. 
Highlight the symbol you want to insert, and 
select Insert.

TIP To refer to a cell from another worksheet 
in your formula, enter the worksheet name 
followed by an exclamation point (!) and the 
cell, range, or name reference. 
Example: =Sheet1!Earnings

TIP To create a 3-D reference in your formula, 
specify two or more sheets in a workbook. 
Use a colon between the first and last 
worksheet names.
Example: =SUM(Sheet2:Sheet6!$A$2:$C$5)
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3 Select the Category list, and then 
select the type of function you want to 
insert.

4 Select the Function list, and then select 
the specific function you want to insert.

5 Select OK.

Entering a sequence automatically

1 Tap and drag with the stylus to highlight 
both the cells containing the info you 
want to automate and the adjacent 
destination cells.

2 Press Menu (right softkey) and select 
Edit > Fill.

3 Select the Direction list, and then 
select the direction you want to 
populate.

4 Select the Fill type list, and then 
select Series.

5 Select the Series type list, and then 
select the type of series you want. If 
you select Date or Number, enter a 
Step value increment.

6 Select OK.

Adding cells, rows, and columns

1 Open the workbook you want.

2 Highlight the area where you want to 
insert elements.

3 Press Menu (right softkey) and select 
Insert > Cells.

4 Select how you want to insert the 
elements:

Shift cells right: Inserts the same 
number of new cells as the number of 
cells you highlighted horizontally in step 
2. For example, if you selected an area 
containing two cells horizontally (A1 and 
B1), selecting Shift cells right inserts 
two horizontal cells; so the original A1 
and B1 (and their contents) are now C1 
and D1. The highlighted area and all 
cells on the right move the same 

TIP Select Autofill as the series type to 
quickly fill cells with repetitive data such as 
numbers or repeated text. Autofill takes the 
content of the first cell in the highlighted row 
or column and copies it down or across the 
rest of the selection.
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number of columns—two in this 
example—to the right.

Shift cells down: Inserts the same 
number of new cells as the number of 
cells you highlighted vertically in step 2. 
For example, if you selected an area 
containing two cells vertically (A1 and 
A2), selecting Shift cells down inserts 
two vertical cells; so the original A1 and 
A2 (and their contents) are now A3 and 
A4. The highlighted area and all cells 
below it move the same number of 
rows—two in this example—down.

Entire row: Inserts the same number of 
new rows as the number of cells you 
highlighted vertically in step 2. For 
example, if you selected an area 
containing two cells vertically (A1 and 
A2), selecting Entire row inserts two 
rows; so the original rows 1 and 2 (and 
their contents) are now rows 3 and 4. 
The rows containing the highlighted 
area and all rows beneath it move the 
same number of rows—two in this 
example—down.

Entire column: Inserts the same 
number of new columns as the number 

of cells you highlighted horizontally in 
step 2. For example, if you selected an 
area containing two cells horizontally 
(A1 and B1), selecting Entire column 
inserts two columns; so the original 
columns A and B (and their contents) 
are now columns C and D. The columns 
containing the highlighted area and all 
columns on the right move the same 
number of columns—two in this 
example—to the right.

5 Select OK.

Formatting cells

1 Open the workbook you want to format.

2 Highlight the cells you want to format.

3 Press Menu (right softkey) and select 
Format > Cells.

TIP To add a new worksheet, press Menu and 
select Format > Modify Sheets. Select 
Insert, enter a name for the worksheet, and 
press OK. To change the order of the 
worksheets, highlight a worksheet you want 
to move, select Move Up or Move Down, 
and press OK.
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4 Select any of the following tabs:

Size: Sets the row height and column 
width.

Number: Sets the type of information 
the cells contain.

Align: Sets whether text wraps within 
the highlighted cells, and sets horizontal 
and vertical alignment position.

Font: Sets the typeface, color, size, and 
style attributes.

Borders: Turns borders on and off for 
various cell edges, and sets the border 
and background colors.

5 Press OK .

Formatting rows and columns

1 Open the workbook you want to format.

2 Highlight the rows or columns you want 
to format.

3 Press Menu (right softkey) and select 
Format > Row or Format > Column.

4 Select any of the following:

AutoFit: Adjusts the size of the 
highlighted rows or columns to their 
contents.

Hide: Hides the highlighted rows or 
columns.

Unhide: Displays hidden rows or 
columns in the highlighted area.

Renaming a worksheet

1 Open the workbook containing the 
worksheet you want to rename.

2 Press Menu (right softkey) and select 
Format > Modify Sheets.

3 In the Sheets list, highlight the 
worksheet you want to rename.

TIP To name the highlighted cell or range of 
cells, press Menu and select Insert > Define 

Name. Enter the name and select Add. Press 
OK.

DID YOU KNOW? You can adjust the column and 
row size by tapping and dragging the right 
edge of the column or the bottom edge of the 
row. To automatically fit rows and columns to 
their contents, double-tap the lower edge of 
the row heading or the right edge of the 
column heading.
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4 Select Rename, enter a new name for 
the worksheet, and press OK  
twice.

Sorting info in a worksheet

1 Highlight the cells you want to sort.

2 Press Menu (right softkey) and select 
Tools > Sort.

3 Select the Sort by list, and then select 
the primary sort column.

4 Check the Ascending box to sort in 
ascending (A–Z or 0–9) order. Leave the 
box unchecked to sort in descending (Z–
A or 9–0) order.

5 (Optional) Select the Then by lists, and 
then select second- and third-level 
sorting options.

6 Check or uncheck the Exclude header 

row from sort box to indicate whether 
you want to sort the header row.

7 Select OK.

Filtering info in a worksheet

1 Tap and drag the stylus to highlight the 
cells that contain the info you want to 
filter.

2 Press Menu (right softkey) and select 
Tools > AutoFilter. In each column 
containing a highlighted cell, an arrow 
appears on the right side of the cell 
nearest the top of the column.

3 Tap the arrow to open a list and select a 
filter. This hides all rows that do not 
include the selected filter.

4 (Optional) Do any of the following:

• Open the other lists, and select other 
filters.

• To display all rows again, open the 
filter lists and select All. 

• To turn off filtering, press Menu (right 
softkey) and select Tools > AutoFilter 

again.

Creating a chart

1 Open the workbook in which you want 
to create a chart.

2 Highlight the cells you want to include 
in the chart.

DID YOU KNOW? You can also create custom 
filters where you specify comparisons. Open 
a filter list and select Custom.
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3 Press Menu (right softkey) and select 
Insert > Chart.

4 Select the type of chart, and press Next 
(right softkey).

5 Confirm the area you want the chart to 
include, and press Next (right softkey).

6 Select the data layout, and press Next 
(right softkey).

7 Check the boxes to indicate whether 
the first row and column represent 
labels.

8 Select whether you want the chart to 
appear as a separate worksheet within 
the current workbook, or as part of the 
current worksheet.

9 Press Finish (right softkey).

Formatting or changing a chart

1 Open the workbook that contains the 
chart you want to format.

2 Open the chart.

3 Press Menu (right softkey) and select 
Format > Chart.

4 Select any of the following tabs:

Titles: Specifies the title of the chart 
and headings, whether a legend 

appears, and the placement of the 
legend.

Scale: Specifies the minimum and 
maximum scales for charts with x and y 
axes.

Type: Specifies the chart style. You can 
use this setting to convert your chart to 
a different format.

Series: Lets you add, modify, format, or 
delete related data points without 
affecting the info in your worksheet.

5 Press OK .

Finding or replacing info in a workbook

1 Open the workbook containing the info 
you want to find.

2 Press Menu (right softkey) and select 
Edit > Find/Replace.

3 Select Find what and enter the info you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in any text you entered.

5 (Optional) Check the Match entire cells 
box to find only cells whose contents 
exactly match the text you entered.
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6 Select Find to locate the first instance 
of the info you entered, or select 
Replace and enter the replacement 
info.

7 Select Next to find the next instance of 
the info, or select Replace to replace it. 
To replace all instances of the info, 
select Replace All.

8 When you see a message that the 
search is done, press OK .

Organizing your workbooks

You can rename your workbooks. You can 
also move them to another folder or move 
them between your smartphone and an 
expansion card (sold separately) inserted 
into your smartphone.

1 Go to the workbook list.

2 Highlight a file.

3 Press Menu (right softkey) and select 
Rename/Move.

4 Select Name and enter a new name for 
the workbook.

5 Select the Folder list, and then select 
the folder to which you want to move 
the workbook.

6 Select the Location list, and then select 
whether you want to store the file on 
your smartphone (Main memory) or on 
an expansion card (Storage Card). The 
Storage Card option appears only if you 
have an expansion card (sold separately) 
inserted into your smartphone.

7 Press OK .

Deleting cells, rows, and columns

1 Open the workbook containing the 
elements you want to delete.

2 Highlight the area you want to delete.

3 Press Menu (right softkey) and select 
Edit > Delete Cells.

4 Select how you want to remove the 
elements:

Shift cells left: Deletes the highlighted 
cells and moves all cells on their right to 
the left.

Shift cells up: Deletes the highlighted 
cells and moves all cells below them up.

TIP When you go to a folder, you can easily 
search your files by sorting by type. 
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Entire row: Deletes the entire row(s) in 
which the highlighted cells are located, 
and moves all rows below up. 

Entire column: Deletes the entire 
column(s) in which the highlighted cells 
are located, and moves all columns on 
their right to the left.

NOTE Excel Mobile adjusts formulas to 
reflect the new cell locations. However, a 
formula that refers to a deleted cell 
displays the #REF! error value.

5 Select OK.

Customizing Excel Mobile

1 Go to the workbook list.

2 Press Menu (right softkey) and select 
Options.

3 Set any of the following options:

Template for new workbook: 
Specifies the default template for new 
workbooks.

Save new workbooks to: Specifies 
where new workbooks are stored.

Files to display in list view: Specifies 
which types of files appear in the 
workbook list.

4 Press OK .

OneNote Mobile

OneNote Mobile lets you create digital 
notes that contain text, pictures, and audio 
and video. You can then synchronize these 
notes with Microsoft Office OneNote 2007 
on your computer. During synchronization, 
all the notes you create on your 
smartphone are copied to a notebook 
called OneNote Mobile on your computer; 
you can then drag your notes to other 

TIP To delete a workbook, go to the workbook 
list and highlight the workbook you want to 
delete. Press Menu (right softkey) and select 
Delete. Select Yes to confirm.

TIP To delete a worksheet, press Menu (right 
softkey) and select Format > Modify Sheets. 
Highlight the worksheet you want to delete 
and select Delete. Select Yes and press OK.
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locations on your computer. You can use 
OneNote Mobile to do any of the following:

• Take pictures of business cards and 
then insert them into OneNote. 

• Take pictures of flip charts and 
whiteboards in conference rooms, and 
then insert them into OneNote. 

• Create text notes and voice recordings 
(for example, reminders of important 
events, ideas for projects, price 
comparisons, recommendations, blog 
ideas, and so on) and synchronize them 
with your notes. 

• Prepare meeting or travel information in 
OneNote on your computer and then 
transfer it to your smartphone so you 
can access the information on the road. 

Creating a note

1 Press Start  and select Office 

Mobile.

2 Select OneNote Mobile .

3 Press New (left softkey).

4 Begin typing your note text, or do any of 
the following:

Format text: Press Menu (right 
softkey), select Format, and then select 
the formatting option you want: Bold, 
Italic, Underline, or Strikethrough. 
Enter the text you want formatted. 

To resume entering unformatted text, 
press Menu (right softkey), select 
Format, and then select the formatting 
option again.

Enter a list: Press Menu (right softkey), 
select List, and then select Numbered 
or Bulleted. When you have finished 
entering the list items, press Menu 
(right softkey), select List, and then 
select the list option again to turn off list 
formatting.

TIP You can apply more than one formatting 
style to text. Press Menu (right softkey) and 
select Format for each style you want to 
apply to the text you are going to enter.

TIP To clear the formatting from entered text, 
highlight the text with the stylus, press Menu 
(right softkey), and select Format > Clear All.
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Create a hyperlink: Enter the website 
address for which you want to create 
the hyperlink. For example, to create a 
hyperlink to the Microsoft website, 
enter http://www.microsoft.com.

Insert a picture: Press Menu (right 
softkey) and select Take Picture to take 
a picture with your smartphone’s 
camera or Insert Picture to insert an 
existing picture.

Insert an audio recording: Press 
Menu (right softkey) and select Insert 

Recording. Tap the onscreen controls 
to create your recording. Tap OK to 
accept the recording and add it to the 
note.

5 When you have finished creating your 
note, press Done (left softkey).

Viewing or editing an existing note

1 Press Start  and select Office 

Mobile.

2 Select OneNote Mobile .

3 In the OneNote Mobile list, select the 
note that you want to open. 

4 Do any of the following:

Open a hyperlink: Place the cursor 
anywhere in the link, and then press 
Center .

View picture detail: Highlight the 
picture, press Center , and then 
press Menu (right softkey) and select 
Zoom In. To zoom in further, press 
Menu (right softkey) and select Zoom 
In again. Use the 5-way to view 
different parts of the picture. To zoom 
out, press Menu (right softkey) and 
select Zoom Out; you can also select 
Actual Size or Fit to Screen.

TIP To remove list formatting from entered 
text, highlight the text with the stylus, press 
Menu (right softkey), and select List > Clear.

TIP While you are composing the note, use 
menu items to undo and redo your last action, 
and to cut, copy, and paste text. After you 
have completed the note and pressed Done, 
use menu commands to delete or rename the 
note.
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Play a voice note: Highlight the voice 
note and press Center ,. 

5 Press Done (left softkey) to close the 
note.

Renaming a note

1 In the OneNote Mobile list, select the 
note that you want to rename. 

2 Press Menu (right softkey), and then 
select Rename.

3 Enter the new name.

4 Press Done (left softkey) to accept the 
new name.

Sorting your notes

1 Press Start  and select Office 

Mobile.

2 Select OneNote Mobile .

3 Press Menu (right softkey) and select 
Options.

4 In the Sort notes by list, press Up  or 
Down  to select Name or Date 

modified.

5 Press Done (left softkey).

Deleting a note

1 In the OneNote Mobile list, select the 
note that you want to delete. 

2 Press Menu (right softkey), and then 
select Delete.

3 Select Yes to confirm deletion.

Adobe® Reader® LE

Adobe® Reader® LE lets you view PDF files 
whether they are saved to your 
smartphone, attached to email messages, 
stored on an expansion card (sold 
separately) inserted into your smartphone’s 
expansion card slot, or downloaded from 
the web. You can customize the document 
display.

Viewing a file

Adobe Reader LE supports 
password-protected PDF files with up to 
128-bit encryption. When you open a 
password-protected PDF file, you must 
enter the password to open the file.
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1 Press Start  and select Programs.

2 Select Adobe Reader .

3 Navigate to and select the file you want 
to open.

4 Press Down  to scroll to the next 
page (in Single Page mode) or to scroll 
the display down (in Continuous mode). 
Press Up  to scroll to the preceding 
page or to scroll the display up.

5 Tap any of the following to move around 
within the PDF file:

6 To open another file, press Menu (right 
softkey) and select Open. Select a 
recently opened file, or select Browse 
and navigate to the file you want.

TIP To open additional files, press Menu (right 
softkey) and select Open. Select the file you 
want from the list, or select Browse to 
navigate to and select the file.

Move to the next page.

Move to the previous page.

Jump to the first page of the file.

Jump to the last page of the file.
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Changing display options

You can change the display size, the scroll 
option, and more.

1 Press Tools (left softkey), select View, 
and then select any of the following:

Rotate Right/Left: Rotates the page in 
the selected direction.

Single Page: Displays the pages so that 
when you use Up  or Down  to 
scroll the file, the display jumps a page 
at a time.

Continuous: Displays the pages so that 
when you use Up  or Down  to 
scroll the file, the display scrolls 
continuously up or down without 
jumping.

2 Press Tools (left softkey), select Zoom, 
and then select one of the following 
options:

In: Increases the file display size to 
enlarge font and image size.

Out: Decreases the file display size to 
fit more of the file on the screen.

To %: Specifies a specific zoom level for 
the display.

Fit screen: Sizes the display so an 
entire page fits on the screen from top 
to bottom.

Fit width: Sizes the display so that the 
width of the page fills the display from 
side to side.

Finding text in a file

1 With the file open, press Tools (left 
softkey) and select Find > Text.

2 Enter the text you want to find.

3 (Optional) Check the Match case box to 
find text that matches the capitalization 
in the text you entered.

4 (Optional) Check the Whole word box 
to find only full words that match the 
text you entered.

TIP To go to a specific page, press Tools (left 
softkey) and select Go To.

DID YOU KNOW? If the file was created with 
bookmarks, Adobe Reader LE displays the 
bookmarks pane on the left side of the screen. 
Select a heading in the bookmarks pane to 
jump to that section.

DID YOU KNOW? To view detailed information 
about the file you are viewing, press Menu 
(right softkey) and select Details.
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5 (Optional) Check the Backwards box to 
search the file backward.

6 Press Find (left softkey).

7 To find the next occurrence of the text, 
press Tools (left softkey) and select 
Find > Next.
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Your Treo™ Pro Smartphone by Palm comes equipped with a 
variety of tools for managing and organizing your information. 
Find nearby businesses and driving directions. Get the most 
out of your smartphone: Install some of the thousands of 
business, education, or leisure-time applications available. Use 
one of several options to share business and personal info with 
others. Insert expansion cards (sold separately) for a compact 
and virtually limitless answer to the storage dilemma. And 
because there’s one on your smartphone, you never need to 
carry a separate calculator.

Benefits

• Locate info in any application, or 
locate any address on a map

• Install applications, games, and 
other software

• Keep others up-to-date with 
meaningful business and personal 
information

• Store, carry, and exchange info

• Always have a calculator with you
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Finding information

Quickly find who or what you’re looking for 
by using one of these search features:

Search: Look through the text in all the 
applications on your smartphone.

File Explorer: Browse through the files 
and folders on your smartphone or on an 
expansion card.

Lookup: Find and dial your contacts by 
name or phone number. See Dialing by 
contact name for details.

Global Address List Lookup: Look up 
names in your online corporate address list 
(see Finding a contact in an online address 
book).

Email message search: Display only those 
messages whose senders, recipients, or 
subjects match the text you enter (see 
Finding messages).

Using Search

Search for files and other items stored in 
the My Documents folder on your 
smartphone or on an expansion card (sold 
separately) inserted into your smartphone. 
You can search by file name or by words 
located in the item. For example, you can 
search for words within notes, 
appointments, contacts, and tasks.

1 Press Start  and select Programs.

2 Select Search .

3 Select Search for and enter the file 
name, word, or other info you want to 
find.

TIP For information on opening and closing 
apps, see Opening and closing applications.

DID YOU KNOW? You can also open Search by 
pressing Option + left Shift.
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4 Select the Type list, and then select the 
kind of information you want to find.

5 Press Search (left softkey).

6 Use the 5-way to select and view an 
item from the results of the search. A 
storage card symbol appears next to the 
names of files that are located on an 
expansion card.

Exploring files and folders

You can use File Explorer to browse the 
contents of folders on your smartphone or 
on an expansion card (sold separately) 
inserted into your smartphone. The root 

folder on your smartphone is named My 
Device. My Device is similar to My 
Computer (Windows XP) or Computer 
(Windows Vista) on your computer.

1 Press Start  and select Programs.

2 Select File Explorer .

3 Select the folder you want to explore. If 
the folder you want is not displayed, tap 
the Show list in the upper-left corner 
and select My Device to view all 
folders.

1 Show list
2 Sort by list

TIP If you’ve looked for an item before, select 
the Search for list, and then select the item in 
the list. 

TIP When two or more words are entered in 
the Search for field, the search results 
contains only items that contain all the words.

TIP If you are searching for information in 
certain applications, such as Messaging or 
Word Mobile, press Advanced (right softkey) 
for more search options. 

2
1
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4 Do any of the following:

To open an item: Select it.

To quickly delete, rename, beam, or 

email an item: Highlight the item, 
press and hold Center  to open the 
shortcut menu, and then select the 
appropriate command.

IMPORTANT Do not delete any files that 
you cannot identify. These files may be 
required for your smartphone to function 
properly.

To move a file to another folder: 
Highlight the item, press and hold 
Center  to open the shortcut menu, 
and select Cut or Copy. Open the 
destination folder, press and hold 
Center  to open the shortcut menu, 
and then select Paste.

To highlight multiple items: Tap and 
drag the stylus.

Installing applications

Your smartphone comes with several 
built-in and ready-to-use applications. You 
can also install third-party applications that 
are compatible with Microsoft Windows 
Mobile® 6.1 Professional edition devices, 
such as business software, games, and 
more.

Applications you download to your 
computer are likely to be in a compressed 
format such as ZIP. If the file is 
compressed, you need to decompress the 
file before you install the application on 
your smartphone. You can decompress the 
file on your smartphone in File Explorer or 
on your computer using a decompression 
utility such as WinZip.

TIP When the items in a folder are displayed, 
you can sort them by name, date, size, or 
type. Select the Sort by list in the upper-right 
corner, and then select the sort method.

DID YOU KNOW? The storage card symbol 
appears next to the names of files that are 
stored on an expansion card.

TIP You can also send the file to yourself as an 
email attachment, and then open the 
attachment on your smartphone to 
automatically decompress the file (see 
Opening attachments).
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The following instructions tell you how to 
install basic files onto your smartphone. 
Some software uses an installer or wizard 
to guide you through the process. For 
details, consult the documentation that 
came with the software.

Installing third-party applications

When installing third-party applications, 
note the following:

• Install only apps that are designed for 
Microsoft Windows Mobile 6.1 
Professional. Apps designed for other 
versions of Microsoft Windows Mobile 
may not be compatible with your 
smartphone.

• If you can try a free or trial version of 
the software before purchasing it, you 
can test it first to make sure it works 
properly.

NOTE If you encounter a problem with a 
third-party application (such as an error 
message), contact the application’s vendor. 
For general troubleshooting of third-party 
applications, see Third-party applications.

Installing applications from the Internet

You can use Internet Explorer Mobile to 
install Windows Mobile apps in the CAB 
file format directly from the Internet. For 
files in the ZIP file format, you must unzip 
the files in File Explorer or on your 
computer before you install them. For files 
in any format other than CAB or ZIP, you 
must first download the files to your 
computer and then install them to your 
smartphone by synchronizing.

BEFORE YOU BEGIN Make sure your 
phone is on and that you are in a coverage 
area (see Turning your phone on).

TIP If an application does not have a Microsoft 
Mobile to Market certificate, you see a 
message indicating that the application is 
untrusted. If this occurs, you can indicate 
whether you want to continue the installation.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® by 
ACCESS applications on your smartphone.
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1 Press Start  and select Internet 

Explorer.

2 Go to the page that contains the link to 
the application you want to download.

3 Highlight the link to the file, and then 
press Center  to start the download 
process.

4 If prompted, select the folder where 
you want to store the file.

5 When the download has finished, press 
Start  and select Programs.

6 Select File Explorer .

7 Go to the folder you selected in step 4. 
If you did not select a folder, go to the 
My Documents folder.

8 Select the file you downloaded to start 
the installation program.

Installing applications from your 

computer

There are many applications available for 
your smartphone. To get started, check out 
the selection at palm.com/treopro.

BEFORE YOU BEGIN To install an 
application from your computer to your 
smartphone, you must first install the 

desktop sync software on your computer 
(see Installing Desktop Sync Software: 
Windows XP and Windows Vista).

1 Connect your smartphone to your 
computer to synchronize and install the 
application(s) on your smartphone.

2 Open My Computer or Windows 

Explorer on your computer.

3 Double-click the icon representing your 
smartphone.

4 Copy the application file(s) into the 
folder.

Installing applications onto an expansion 

card

BEFORE YOU BEGIN To install an 
application from your computer to an 
expansion card, you must first install the 
desktop sync software on your computer 
(see Installing Desktop Sync Software: 
Windows XP and Windows Vista).

1 Insert the expansion card (sold 
separately) into the expansion card slot 
(see Inserting and removing expansion 
cards).

http://www.palm.com/treopro
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2 Connect your smartphone to your 
computer using the USB cable.

3 Open My Computer or Windows 

Explorer on your computer.

4 Double-click the icon representing your 
smartphone.

5 Navigate to the folder representing the 
expansion card.

6 Copy the application file(s) into the 
expansion card folder.

Installing Java games and applications

You can install Java application files called 
Midlets onto your smartphone, either from 
your computer or from the Internet.

1 Press Start  and select Programs.

2 Select Java .

3 Press Menu (right softkey), select 
Install, and then select Local (to install 
a file from your computer) or Internet.

After you install the file, press Menu (right 
softkey) to perform various tasks using the 
file.

Removing 
applications

To free up memory on your smartphone, 
you can remove applications that you no 
longer use. You can remove only 
applications, patches, and extensions that 
you install; you cannot remove the built-in 
applications that reside in the Read-Only 
Memory (ROM) portion of your 
smartphone.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Remove Programs .

3 Select the application that you want to 
remove.
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4 Select Remove.

5 Select Yes to confirm the deletion.

Sharing information

Your smartphone comes equipped 
with a variety of options for sharing 
information, so that you can choose the 
quickest, most convenient way to send 
your info or to receive info from another 
device.

• In many applications, you can send a file 
or an entry by email or by beaming. 
Open the app to the file or entry list and 
highlight the item you want to send. 
Press Menu (right softkey) and select 
the Send or Beam option.

• In the Messaging application, you can 
insert a picture or attach a note or other 
file to an email. You can also receive 
pictures and attachments (see Your 
email).

• You can attach a picture, video, or sound 
file to a multimedia message (see 
Creating and sending a multimedia 
message).

• You can synchronize to share info 
between your smartphone and your 
computer or between your smartphone 
and Microsoft Exchange Server 2003 
SP2 or 2007 (see Synchronizing 
information).

• If you are near someone, you can beam 
files and applications between your 
smartphone and your neighbor’s device 
using the IR port or Bluetooth® wireless 
technology (see Beaming information).

• You can also store files on an expansion 
card and share the expansion card (see 
Using expansion cards).

Beaming information

Your smartphone is equipped with an IR 
(infrared) port that enables you to beam 
information to another device with an IR 
port. The IR port is located on the side of 
your smartphone closest to the stylus, near 

DID YOU KNOW? Built-in applications that 
cannot be deleted are not listed in the 
Remove Programs list.
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the top. You can also beam using the 
Bluetooth wireless technology on your 
smartphone.

The normal range for beaming with IR is 
about eight inches (20 centimeters). The 
maximum range for beaming with 
Bluetooth technology is about 30 feet (10 
meters). Performance and range are 
affected by physical obstacles, radio 
interference from nearby electronic 
equipment, and other factors.

Beaming an entry or file 

BEFORE YOU BEGIN To beam using 
Bluetooth technology, make sure your 
smartphone has the Bluetooth feature 

turned on (see Entering basic Bluetooth 
settings).

1 Highlight the entry or file you want to 
beam.

2 Press Menu (right softkey) and select 
Beam… (the menu item changes 
names based on the type of item you 
highlighted). In Contacts, press Menu 
(right softkey) and select Send Contact 
> Beam.

3 Select one of the following options:

Bluetooth: When the name of the 
receiving device appears, select it to 
begin the transfer. A blue icon indicates 
a Bluetooth connection.

TIP For best results, the path between the 
two devices must be clear of obstacles, and 
both devices must be kept stationary. If you 
have difficulty beaming, shorten the distance 
and avoid bright sunlight.

DID YOU KNOW? The type of information you 
can beam depends on the type of device you 
are beaming to. Other Windows Mobile 6 
Professional devices are always compatible 
with your Treo Pro smartphone.
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IR: Select Infrared. Point the IR port on 
your smartphone directly at the IR port 
of the receiving device. A red icon 
indicates an IR connection.

4 Wait for Done to appear next to the 
name of the receiving device before you 
continue using your smartphone.

Turning on the option to receive beamed 

information

By default, the option to receive beamed 
information on your smartphone is turned 
off. You need to turn the beam option on 
before you can receive information being 
beamed from another device.

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Beam .

3 Check the Receive all incoming 

beams box.

Receiving beamed information

1 Press End  to turn on your screen if it 
is not already on.

2 If you are beaming over an IR 
connection, point the IR port on your 
smartphone directly at the IR port of the 
transmitting device.

3 When the Receiving Data message 
appears, select Yes to receive the 
beam.

TIP The regional setting determines the list of 
characters that can be used when info is 
beamed between devices. If you try to send 
or receive a character that is not on the list, it 
appears as a question mark (see Setting 
display formats).
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Using expansion 
cards

The expansion card slot on your 
smartphone enables you to add microSD 
cards to extend the storage capacity of 
your smartphone. For example, microSD 
expansion cards can store the following:

Expansion cards are sold separately.

Inserting and removing expansion cards

1 With the back panel facing you, press 
the lower-right corner of the panel with 
your right thumb. Then use both 
thumbs and firmly slide the panel away 
from you to release it.

• Pictures 

• Videos

• Games

• Applications

• MP3 audio files

• Email attachments

• Databases

TIP We recommend that you purchase 
preformatted expansion cards. To format a 
card on your own, you may need to connect a 
card reader (sold separately) to your 
computer.
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2 Insert a microSD card (sold separately) 
into the expansion card slot.

1 Notch
2 Wi-Fi button

3 Push the card into the slot until you feel 
the card click into place.

4 Replace the back panel.

5 To remove an expansion card, repeat 
step 1 to remove the back panel, and 
then push the card in to release it.

6 Replace the back panel.

Opening applications on an expansion 

card

After you insert an expansion card into the 
expansion card slot, you can open any of 
the applications stored on the expansion 
card.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left 
corner and select Storage Card.

TIP The expansion card slot has a push-push 
mechanism: push in gently to insert a card; 
push in gently to remove it.

21
TIP To run an application on an expansion card, 
your smartphone must have enough free 
space in the internal memory to run the 
application.
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* Show list

5 Select the application you want to open.

Saving files to an expansion card

You can save space on your smartphone by 
saving files to an expansion card. For 
example, when you create new Word 
Mobile documents, notes, Excel® Mobile 
workbooks, pictures, videos, and audio 
files, you can save them directly to an 
expansion card. Saving files to an 
expansion card also makes it easy to share 
those files with others. (Some applications 
may not support this feature.)

1 Insert an expansion card into the 
expansion card slot.

2 Open the application from which you 
want to save the info.

3 Press Menu (right softkey) and select 
Options or Tools > Options.

4 Select the option for where to save info, 
and then select Storage Card. The 
option name changes depending on the 
application you are in.

5 Press OK .

Moving info between your smartphone 

and an expansion card from within an 

application

In certain applications—for example, 
Pictures & Videos and the Office Mobile 
applications—you can move files directly to 
another location. For applications that do 
not support this feature, see Moving info 
between your smartphone and an 
expansion card using File Explorer.

*

TIP If you don’t see a Save to option on the 
Options screen, look on the other tabs (if 
present). If you still can’t find a Save to list, the 
application may not support this feature.
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1 Insert an expansion card into the 
expansion card slot. 

2 Open the application from which you 
want to move the info.

3 Go to the list view, tap the Show list in 
the upper-left corner, and highlight the 
file or application you want to move.

4 Press Menu (right softkey) and select 
Rename/Move.

5 Select the Location list, and then select 
where you want to move the info: 
Storage card or Main memory.

6 Press OK .

Moving info between your smartphone 

and an expansion card using File Explorer

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Highlight the file or application you want 
to copy or move (see Exploring files and 
folders).

5 Press Menu (right softkey) and select 
Edit > Copy or Edit > Cut.

6 Go to the folder where you want to 
place the selected item.

7 Press Menu (right softkey) and select 
Edit > Paste.

8 Press OK .

Viewing available expansion card 

memory

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Memory .

4 Select the Storage Card tab.

5 Press OK .

Exploring files on an expansion card

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left 
corner and select Storage Card.

TIP Your applications are usually located in the 
My Device/Program Files folder.
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5 Select the folder or files you want to 
view.

6 Press OK .

Renaming an expansion card

If you change the contents of an expansion 
card, you may want to rename the card to 
better match its contents.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer .

4 Tap the Show list in the upper-left 
corner and select My Device.

5 Highlight the current expansion card 
name (Storage Card by default).

6 Press Menu (right softkey) and select 
Rename.

7 Enter a new name for the card.

8 Press OK .

Encrypting an expansion card

When you encrypt an expansion card, the 
info on the card can be read only by your 
smartphone—so no one can see what’s on 
the card if it gets lost or stolen.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Encryption.

4 Check the Encrypt files when placed 

on a storage card box.

NOTE If your organization enforces an 
encryption policy, you can see that the box 
is checked, but you cannot uncheck it.

Accessing 
information on a 
remote computer

Remote Desktop Mobile is a technology 
that allows you to use your smartphone to 
connect to a remote computer in a 
different location through the internet 

TIP Before copying information to or renaming 
the files or folders on an expansion card, or 
renaming the card itself, make sure the card is 
not write-protected. See the instructions that 
came with your card for details.
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(using a data or Wi-Fi connection). For 
example, you can connect to your work 
computer and have access to all of your 
applications, files, and network resources 
as though you were in front of your 
computer at work. You can leave 
applications running at work and then see 
your work computer’s desktop displayed 
on your smartphone, with the same 
applications running.

BEFORE YOU BEGIN Do the following:

• Be sure to subscribe to data services 
from your wireless service provider. 
This is necessary for browsing the web.

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• If you have access to a Wi-Fi network, 
verify that Wi-Fi is on and gather any 
necessary network connection settings 
(see Connecting to a Wi-Fi network).

• Ensure that the target computer is on 
and connected to the internet.

Accessing a remote computer

BEFORE YOU BEGIN Ask the remote 
computer administrator for your computer 

username, password, and domain if you 
don’t know them.

1 Press Start  and select Programs.

2 Select Remote Desktop Mobile .

3 Enter the name of the computer you 
want to access. If you are accessing a 
computer you’ve already entered, select 
the computer name from the list.

4 Enter the username, password, and 
domain you use to access the remote 
computer.

5 Press OK .

Customizing Remote Desktop Mobile

1 Press Start  and select Programs.

2 Select Remote Desktop Mobile .

3 Press Menu (right softkey) and select 
Options.

4 On the Display tab, select any of the 
following options:

Colors: Set how to display colors from 
the remote computer on your 
smartphone screen.
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Full screen: Set whether you want the 
remote computer display to take up 
your entire smartphone screen.

Fit remote desktop to screen: Set 
whether you want to resize the remote 
computer display so that the entire 
display fits on your smartphone screen.

5 Select the Resources tab, and then 
select one or both of the following 
options:

Device storage: Set whether to map 
your smartphone’s storage memory to 
the remote computer.

Remote desktop sound: Sets whether 
sounds from the remote computer are 
muted completely, played on the 
remote computer, or played on your 
smartphone.

6 Press OK .

Calculator

You can use Calculator for basic arithmetic 
calculations, such as addition, subtraction, 
multiplication, and division.

Performing calculations

1 Press Start  and select Calculator.

2 Enter numbers and perform 
calculations, including the following:

 Clears the last digit in a multidigit 
entry.

 Clears the current calculation or the 
displayed number.
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 Calculates the reciprocal of a 
number.

 Calculates percentage.

 Calculates the square root of a 
number.

 Switches a number between 
negative and positive.

Using the Calculator memory

• To store a displayed number, tap the box 
to the left of the entry box. An M 
appears in the box.

• To add the displayed number to the 
number stored in memory, tap  or 
press P.

• To display the number stored in 
memory, tap . 

• To clear the memory, tap .

TIP You can paste numbers into Calculator as 
well as copy calculation results to be pasted 
into another app.

TIP For more advanced calculations, use Excel 
Mobile. See Excel Mobile® for details.

DID YOU KNOW? When you store a number in 
memory, it replaces the number that is 
currently stored.
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Your personal settings

13

Customizing is optional. But why not personalize your Treo™ 
Pro Smartphone by Palm to make it match your lifestyle and 
work even harder for you?

You can easily customize the sounds, fonts, screen colors, and 
more on your smartphone. Take advantage of various levels of 
security. Prevent making an accidental (and expensive) phone 
call by locking the keyboard. Some preference settings can help 
extend the life of your battery. There are lots of ways to make 
your smartphone work better for you.

Benefits

• Conserve power

• Secure your phone and your data

• Make your screen easy to read

• Streamline smartphone use
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Today screen settings

Selecting your Today screen background

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, check the Use 

this picture as the background box.

4 Select Browse.

5 Select the picture you want to use.

6 Press OK .

Selecting which items appear on your 

Today screen

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 Select the Items tab.

4 Check the boxes next to the items you 
want to appear on your Today screen, 
and uncheck any items that you do not 
want to appear.

TIP You can also open Settings from your 
Today screen by pressing Settings (right 
softkey).

TIP To change the color theme for your 
smartphone, select a new theme from the 
Appearance tab in Today Settings (see 
Changing the system color scheme). 
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5 (Optional) Highlight an item and select 
Move Up or Move Down to change the 
order in which items appear on the 
Today screen.

6 (Optional) Highlight an item and select 
Options (if available) to configure the 
settings for the item. Press OK  to 
return to Today Settings.

7 Press OK .

System sound 
settings 

When you’re in a meeting, at the movies, 
or anywhere that silence is required, you 
can immediately silence all sounds on your 
smartphone, including Calendar 
notifications and system sounds. This does 
not mute the speaker during phone calls.

Silencing sounds

1 Slide the Ringer switch to Sound 

Off . The smartphone vibrates 
briefly.

2 To hear all sounds again, slide the 
Ringer switch to Sound On .

When you slide the Ringer switch back to 
the Sound On position, it restores the 
previous sound settings. For example, if 
the smartphone ring volume is set to the 
loudest setting and you slide the Ringer 
switch to Sound Off, you do not hear the 
smartphone ring. When you move the 
Ringer switch back to Sound On, the 
smartphone ring volume is still set to the 
loudest setting.

1 Sound On
2 Sound Off

DID YOU KNOW? There are lots of third-party 
plug-ins available for your Today screen.

1 2
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Selecting Sounds & Notifications

1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

3 On the Sounds tab, set any of the 
following options:

Events: Turns sounds on/off for system 
warnings and error messages.

Programs: Turns sounds on/off in the 
applications on your smartphone.

Notifications: Turns alarms and 
reminders on/off in the applications on 
your smartphone.

Screen taps: Turns sounds associated 
with tapping the screen on/off, and sets 
the volume level when this sound is 
turned on.

Hardware buttons: Turns sounds 
associated with pressing buttons on/off, 
and sets the volume level when this 
sound is turned on.

TIP Can’t get music to play out of the built-in 
MP3 player? Check the Ringer switch. If it’s 
set to Sound Off, you won’t be able to hear 
music. 

DID YOU KNOW? Your smartphone includes a 
silent alarm that can vibrate even when the 
Ringer switch is set to Sound Off. 

TIP To add, preview, delete, and send sounds, 
select the Manage tab. To add a sound, press 
Menu (right softkey), select Add, and navigate 
to the sound file. To play a sound, select it and 
press Play (left softkey). To delete a sound, 
highlight it and press Backspace. To send a 
sound, highlight it, press Menu (right softkey), 
and select Beam Sound or Send Sound.
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4 Select the Notifications tab and set 
any of the following options:

Event: Specifies the action for which 
you want to change the settings. 

NOTE The settings described here apply to 
all event types except phone calls. To set 
notifications for the various phone call 
types, see Selecting ringtones and display 
notices.

Play sound: Lets you turn the sound 
on/off for the selected event. To select a 
different sound, select the list to the 
right of this setting, and then select a 
different sound. To preview the sound, 
select Play Sound, and then select 
Play.

Repeat: Indicates whether the sound 
plays more than once, if turned on.

Display message on screen: Indicates 
whether a notification message appears 
onscreen for the selected event.

Vibrate when ringer switch off/on: 
Indicates whether your smartphone 
vibrates to notify you about the selected 
event.

5 Press OK .

Display and 
appearance settings

Adjusting the brightness

1 Press Option  and then press . 

2 Press Left  and Right  to adjust the 
brightness for when your smartphone is 
running on battery power and when it is 
running on external power.

3 Press OK .
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Changing the text size and clarity

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the Text Size tab.

4 Press Left  and Right  to adjust the 
text size.

5 Select the Clear Type tab.

6 To smooth the edges of screen fonts, 
check the Enable Clear Type box.

7 Press OK .

Displaying the clock

You can display a clock at the top of every 
screen. You can also choose between a 
digital and an analog clock display.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the More tab.

4 To display the clock, check the Display 

the clock on the title bar in all 

programs box.

5 Press OK .

6 To change the clock display format, tap 
and hold the clock and select Analog or 
Digital. If you select analog format, a 
clock icon  appears displaying the 
time.

Setting display formats

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Regional Settings .
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3 On the Region tab, select a region from 
the list. The region selection determines 
all display formats (date, time, and so 
on) on your smartphone unless you use 
another Regional Settings field to select 
a different format for a specific type of 
display item.

4 (Optional) Select any of the following 
tabs to customize individual format 
settings:

Number: Sets the decimal symbol and 
number of decimal places, the digit 
grouping symbol and group size, list 
separators, negative number sign 
symbol and format, leading zero display, 
and measurement system (metric 
versus U.S.).

Currency: Sets the currency symbol 
and position, the decimal symbol and 
position, digit grouping symbol and 
group size, and negative number 
format.

Time: Sets the time style, separators, 
and AM and PM symbols.

Date: Sets the short date style, 
separators, and long date style.

5 Press OK .

Aligning the screen to correct tapping 

problems

Occasionally, your screen may need to be 
readjusted. You know your screen needs 
adjustment if the wrong feature is 
activated when you tap the screen. To fix 
the problem, align the screen.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 On the General tab, select Align 

Screen. 

4 Tap the screen where indicated.

5 Press OK .
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Changing the system color scheme

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, select a theme 
in the list.

4 Press OK .

Application settings

Arranging the Start menu

You can change the seven applications 
listed on the Start menu. You can still 
access the remaining applications by 
selecting Programs from the Start menu, 
and then selecting the application’s icon.

1 Press Start  and select Settings.

2 On the Personal tab, select Menus .

3 Check the boxes next to the 
applications you want to see in the Start 
menu.

4 Press OK .

Reassigning buttons

You can use Buttons Settings to select 
which applications to associate with many 
of the buttons and key combinations on 
your smartphone.

TIP You can also set the background for your 
Today screen (see Selecting your Today 
screen background).

TIP Don’t forget the six icons across the top of 
the Start menu. They’re the apps you opened 
most recently, and it’s easy to get back to 
them: just use the 5-way to select one of the 
icons.
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1 Press Start  and select Settings.

2 On the Personal tab, select Buttons .

3 On the Program Buttons tab, highlight 
the button or key combination you want 
to change in the Button list. The 
hardware buttons are mapped to the 
following items:

Start  = Start menu

OK  = OK/Close

Option  + Phone/Send  = 
Internet Explorer

Option  + Start  = File Explorer

Option  + OK  = Task Manager

Option  + Calendar  = Calculator

Option  + Messaging  = Tasks

Hold Side = Camera

4 Select the Assign a program list, and 
then select the application you want to 
assign to the button or key combination 
you selected.

5 Select the Up/Down Control tab and 
adjust the settings for the Up  and 
Down  buttons on the 5-way.

6 Press OK .

Setting up voice commands

IMPORTANT The Voice Command 
application is available only for English, 
French, and German.

Voice commands enable you to use speech 
to execute some commands on the Start 
menu and the Programs screen.

1 Assign the Hold Side button to Voice 
Command. See Reassigning buttons for 
details.

2 Press Start  and select Settings.
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3 On the Personal tab, select Voice 

Command .

4 Check the Enabled box.

5 Select the items you want to enable. If 
an item is highlighted and the Options 
button is active, select Options to 
choose the features you want enabled 
for the highlighted item.

6 Select Notifications and select the 
options for how you want to receive 
voice command notifications.

Using voice commands

IMPORTANT Do not use voice commands 
in your car until you read the End user 
notice about this kind of usage; see the 

safety and legal information included in 
your smartphone package for information.

1 Set the Ringer switch at the top of your 
smartphone to Sound On .

2 Hold your device close to your mouth, 
and press and release the assigned 
Voice Command button (see Setting up 
voice commands). A tone plays and a 
microphone icon appears at the top of 
your screen.

3 In a clear voice, say the command. For 
example:

To access Help: Say “Help.” After Voice 
Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer. For 
example, say “General” to access 
general Help topics.

To access your Calendar: Say “Start 
Calendar.”

To access your music: Say “Start 
Windows Media.” After Voice 
Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer.
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Setting input options

1 Press Start  and select Settings.

2 On the Personal tab, select Input .

3 On the Input Method tab, set any of the 
following options:

NOTE The Input Method options you 
specify apply only to entering info using the 
screen. You can still enter info using your 

smartphone’s keyboard regardless of the 
onscreen input method you choose.

Input method: Specifies which 
onscreen input method you want to 
use:

• Block Recognizer: Use a single 
stroke to write letters, numbers, 
symbols, and punctuation, which are 
then converted into typed text. Use 
gestures to enter Return and 
Backspace.

• Keyboard: Tap keys on the onscreen 
keyboard to enter text.

• Letter Recognizer: Write individual 
letters, numbers, and punctuation, 
which are converted into typed text.

Large/Small keys: If you selected 
Keyboard, select whether to use large 
or small onscreen keys. If you select 
Large keys, check the box if you want to 
use gestures for the space bar and the 
Backspace, Shift, and Return keys.

Options: If you selected Letter 
Recognizer, select Options and select 
the options you want.

TIP You can move quickly through voice 
commands by stopping the voice command 
response before it finishes. When Voice 
Command responds, you can press the Voice 

Command button before it completes the 
question. After the microphone icon is visible, 
you may say your answer.
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4 Select the Word Completion tab and 
set any of the following options:

Suggest words when entering text: 
Indicates whether word suggestions 
appear as you enter text. You can also 
specify how many letters you want to 
enter before a suggestion appears, how 
many suggestions you want to see, and 
whether a space appears after you 
insert a suggested word. This option is 
disabled by default.

Clear Stored Entries: Deletes the 
database of word suggestions.

Enable Auto Correct: Indicates 
whether common misspellings such as 
“teh” are corrected automatically.

5 Select the Options tab and set any of 
the following options:

Voice recording format: Specifies the 
format in which you save voice notes.

Default zoom level for writing: 
Specifies the initial size of text entered 
from onscreen writing methods.

Default zoom level for typing: 
Specifies the initial size of text entered 
using the keyboard.

Capitalize first letter of sentence: 
Specifies whether the first letter of a 
sentence automatically appears in 

TIP To enter a suggested word, press Down 
to highlight the suggestion, and then press 
Center to accept it. 
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uppercase, without requiring you to 
press a Shift key.

Scroll upon reaching the last line: 
Specifies whether the display 
automatically scrolls when you select 
the last line of visible info.

6 Press OK .

Locking your 
smartphone and info

Your smartphone includes several features 
that help you protect it from inadvertent 
use and keep your information private. The 
security software lets you use your 
smartphone for emergency calls, such as 
dialing your national emergency number 
(such as 911, 112, or 999), even if it is 
locked.

Keyguard: Manually disables all buttons 
and the screen’s touch-sensitive feature 
to prevent accidental presses.

Auto-Keyguard and touchscreen 

lockout: Automatically enables Keyguard 
after a period of inactivity and lets you 
disable the screen’s touch-sensitive feature 
during an active call.

System password lock: Requires a 
password to see any information on your 
smartphone.

Locking your keyboard (Keyguard)

By default, your keyboard locks so that you 
don’t accidentally press buttons or activate 
screen items.

To dismiss Keyguard: Press Center .

TIP To avoid accidentally pressing onscreen 
buttons while you’re holding your smartphone 
up to your ear to speak, you can disable the 
screen’s touch-sensitive feature during active 
calls. When the screen’s touch-sensitive 
feature is disabled, you must use the 5-way 
navigator to access items on the screen.
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To manually turn on Keyguard when 

your smartphone screen is on: Do one of 
the following:

• Press and hold End .

• Press Option  + End .

Turning on Auto-Keyguard

Auto-Keyguard enables you to configure 
the Keyguard feature.

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Select the Auto-Keyguard list and 
disable the Auto-Keyguard feature or set 
the period of inactivity that passes 
before the keyboard automatically locks.

4 Press OK .

Locking your screen

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Under Disable touchscreen, check or 
uncheck the While on a phone call box 
to determine whether the screen’s 
touch-sensitive feature is disabled 
during a call.

4 Press OK .

Locking your smartphone

To protect your personal information, you 
can lock the system so that you need to 
enter your password to access any of your 

TIP If you’re using a headset or hands-free 
device, you can manually turn on Keyguard 
during a call to prevent accidental key 
presses.

TIP If your Today screen is displayed and 
you’re not on a call, you can also turn on 
Keyguard by pressing End.
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information or use other features of 
your smartphone.

IMPORTANT If you lock your system, you 
must enter the exact password to unlock it. 
If you enter an incorrect password, you are 
given another chance. Each time an 
incorrect password is entered, you are 
given progressively longer time periods 
between your chances to enter the 
password. If you forget the password, you 
need to perform a hard reset to resume 
using your smartphone. Performing a hard 
reset deletes all the entries in your 
smartphone. However, you can restore all 
previously synchronized info the next time 
you sync (see Synchronizing information).

1 Press Start  and select Settings.

2 On the Personal tab, select Lock .

3 On the Password tab, check the 
Prompt if device unused for box to 
turn on the password feature.

4 Select the first list, and then select how 
long a period of inactivity must pass 
before you are prompted to enter a 
password to unlock the system.

5 Select the Password type list, and then 
select a format for your password:

Strong alphanumeric: A strong 
alphanumeric password must contain at 
least seven characters and must contain 
a combination of letters, numerals, and 
punctuation. You must press Option or 
Alt before entering numerals or 
punctuation.

Simple PIN: A simple PIN must contain 
at least four characters and includes 
numerals only. You do not need to press 
Option before entering the PIN 
numerals.

6 Select Password and enter your 
password.

7 Select Confirm and enter the password 
again.

8 (Optional) Select the Hint tab and enter 
a hint to help you recall your password.

9 Press OK .
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Entering owner information

You can enter personal information that you 
want to associate with your smartphone, 
such as your name, company name, and 
phone number. You can also set whether 
you want this information to appear when 
you turn on your smartphone. If you lose 
your smartphone, this feature can help the 
person who finds it return it to you.

1 Press Start  and select Settings.

2 On the Personal tab, select Owner 

Information .

3 On the Identification tab, enter any of 
the information you want to include.

4 Select the Notes tab and enter any 
additional text you want to include.

5 Select the Options tab and check the 
boxes to indicate which info (if any) you 
want to appear on the screen when you 
turn on your smartphone.

6 Press OK .

TIP If you lock your smartphone and use a 
Simple PIN as the password, you can dial an 
emergency number by entering the number in 
the password field and pressing Phone/Send. 
You do not need to press Option before 
entering the number. However, if you select 
Strong alphanumeric as the password type, 
you must first press Option twice before 
entering an emergency number in the 
password field.

TIP You can also display your Owner 
Information on your Today screen. See 
Selecting which items appear on your 
Today screen for details.
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System settings

Setting the date and time

Use Clock & Alarms Settings to set the 
time zone, time, and date for your home 
location and a location that you visit.

To set the display format for the date and 
time, see Setting display formats.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 On the Time tab, select Home.

4 Select the first list, and then select the 
time zone for your home location.

5 Select the hour and press Up  or 
Down  to increase or decrease the 
hour setting. Repeat this process for the 
minute, seconds, and AM/PM settings.

6 Select the month and press Up  or 
Down  to increase or decrease the 
month setting. Repeat this process for 
the date and year settings

7 (Optional) Select Visiting and set the 
info for a location that you visit often.

8 Press OK .

9 If prompted, select Yes to accept your 
changes.

Synchronizing the date, time, and time 

zone with the network

By default, your smartphone synchronizes 
the date, time, and time zone with your 
wireless service provider’s network 
whenever your phone is on and you are 
inside a coverage area. 

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the More tab.
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4 To disable this option, uncheck the 
Enable local network time box. 

5 If you want to keep your smartphone 
date and time set for your selected 
location, uncheck the Use network 

time zone box.

Setting system alarms

System alarms let you set alarms that are 
not associated with a task or appointment. 
For example, you can use your smartphone 
as an alarm clock when you travel, or set 
alarms to remind you when it’s time to take 
medication or pick up the kids. 

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the Alarms tab.

4 Check a box to turn on that alarm.

5 Select Description next to the box you 
checked and enter a description for the 
alarm.

6 Tap the days of the week you want the 
alarm to go off. You can select multiple 
days for each alarm.

7 Tap the time, set the time you want the 
alarm to go off, and press OK .

8 Select the alarm  icon and check the 
boxes to select how you want the alarm 
to go off. You can choose a single 
sound, a repeating sound, a flashing 
light, or vibration.

9 Press OK  twice.

10 If prompted, select Yes to accept your 
changes.

TIP To change the alarm sound, select the 
alarm sound icon, select the Play Sound list, 
and then select the alarm sound you want to 
use.
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Managing identity certificates

Your smartphone may include preinstalled 
certificates. Certificates are digital 
documents that are used to authenticate 
and exchange information on networks. 
Certificates can be issued for a user, a 
device, or a service.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Certificates .

3 Select any of the following tabs:

Personal: Displays certificates that 
establish your identity when you log in 
to a secured network, such as a 
corporate network.

Intermediate: Displays certificates 
issued from a root certificate whose 
purpose is to then issue personal 
certificates.

Root: Displays certificates that identify 
the computers, such as servers, to 
which you connect. These certificates 
help prevent unauthorized users from 
accessing your smartphone and 
information.

4 To view certificate details, select the 
certificate.

5 Press OK .

Enabling error reporting

Error Reporting sends info that helps 
diagnose application errors for devices 
running Windows Mobile® software. When 
an error is detected, a text file is created. 
You can review the file and choose 
whether you want it delivered to Microsoft 
Support. The information is used by 
programming groups at Microsoft for 
quality control and is not used for tracking 
individual users or installations for any 
marketing purpose. The info that is 
collected is technical info about the state of 
your system when the error occurred. No 
documents (or any info contained in them) 
are intentionally sent with the report. To 
ensure further security, the report is 
transmitted by means of a secure 

TIP To delete a certificate, highlight the 
certificate name, press and hold Center on 
the 5-way, and then select Delete from the 
shortcut menu.
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connection and is kept confidential and 
anonymous in a limited-access database.

Your smartphone must be connected to 
your computer when you send the error 
report—provided your computer is 
connected to the Internet.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Error Reporting .

3 Select whether you want to enable or 
disable error reporting.

4 Press OK .

How much storage space do I have left?

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Memory .

3 Select either of the following tabs:

Main: Displays the amount of memory 
assigned to your applications and info, 
as well as the amount of memory in use 
versus the available memory.

DID YOU KNOW? This error-reporting method 
meets the privacy regulations of the European 
Union (EU) as well as the Fair Information 
Practice Principles of the Federal Trade 
Commission in the United States. To view the 
Fair Information Practice Principles, visit the 
Federal Trade Commission website at ftc gov/
reports/privacy3/fairinfo htm

TIP If storage memory is low, consider using 
an expansion card to store files (see Using 
expansion cards). If program memory is low, 
close some applications to avoid slow 
smartphone performance (see Closing 
applications). You can also tap Find at the 
bottom of the screen to search for large files 
to delete so that you free up memory

TIP You can also open Memory settings by 
selecting the running programs icon in the 
upper-right corner of the Today screen, and 
then selecting the memory icon.

http://www.ftc.gov/reports/privacy3/fairinfo.htm
http://www.ftc.gov/reports/privacy3/fairinfo.htm
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Storage Card: Displays the amount of 
memory available on an expansion card 
that has been inserted into the 
expansion slot on your smartphone.

4 Press OK .

Optimizing power settings

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Power .

3 On the Battery tab, view the power 
remaining in your battery.

4 Select the Advanced tab and set 
whether your smartphone screen turns 
off automatically after a specified period 
of inactivity. You can assign different 
intervals for battery power and external 
power.

5 Select the Screen Saver tab, and check 
the box to enable the screen saver 
feature, or uncheck it to disable the 
screen saver.

6 Press OK .

TIP An easy way to check the battery level is 
by tapping the battery icon in the title bar.
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Turning wireless services on/off 

To quickly turn all wireless services on or 
off, press and hold Power .

Follow these steps to turn individual 
wireless features on or off:

1 On the Today screen, select your 
wireless service provider name, or 
select Phone off / Digital Roam if your 
wireless service provider name is not 
displayed.

2 Select a wireless feature to turn it on or 
off. The current state of the feature, ON 
or OFF, appears on a gray background. 
The description of the feature tells you 
what you can change it to. In the 
illustration, Airplane Mode and Wi-Fi are 
off, and Phone and Bluetooth are on.

3 Press OK .

You can also turn wireless services on and 
off by tapping the signal-strength  icon 
at the top of the screen and selecting 
Comm Manager. 

TIP To conserve additional battery power, 
disable the screen saver or adjust the display 
backlight setting. Press Start and select 
Settings. Select the System tab, and then 
select Backlight. On the Battery Power tab, 
set whether the display backlight turns off 
automatically after a period of inactivity. You 
can also select the External Power tab to turn 
off the backlight when your smartphone is 
connected to an external charging source.

TIP To change the settings for one of the 
displayed wireless features, press Settings 
(right softkey) and select the wireless feature 
you want to change.
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Updating the system software

Windows Update for Windows Mobile lets 
you download security updates and other 
important updates to the Windows Mobile 
operating system software on your 
smartphone.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Windows Update.

3 On the Update Setup screen, press 
Next (right softkey).

4 Select whether you want to run 
Windows Update manually or you want 
it to check for updates automatically, 
and press Next (right softkey).

5 If you selected automatic updates, 
check the Use my data plan to check 

for and download updates box if you 
want to use your data plan instead of 
your basic wireless plan to update your 
smartphone. Using your data plan 
means that updates may occur more 
frequently but may result in additional 
data charges. Press Next (right softkey).

6 Press Finish (left softkey).

If you selected Automatic in step 4, 
Windows Update periodically checks for 
and downloads updates automatically. If 
you selected Manual in step 4, you can 
check for updates at any time by opening 
Windows Update and pressing Check 

Now (left softkey).

To view detailed results of the last check 
for updates, press Menu (right softkey) and 
select View details.

TIP Select View privacy statement to read 
about how using Windows Update affects the 
personal information on your smartphone.



Y O U R  P E R S O N A L  S E T T I N G S

C O N N E C T I O N  S E T T I N G S 297

13

C
H

A
P

T
E

R

Connection settings

Managing ISP settings

Your smartphone is already set up to 
connect to the Internet using a high-speed 
data connection on your wireless service 
provider’s network. To connect to the 
Internet, simply start Internet Explorer 
Mobile.

For special situations, such as connecting 
to your Internet service provider (ISP) or to 
a remote access server (RAS), you can set 
up another connection.

BEFORE YOU BEGIN Obtain the following 
information from your ISP or system 
administrator:

• ISP server phone number or access 
point

• Username

• Password

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Manage 

existing connections.

4 Select the Modem tab. 

5 Highlight the connection you want to 
view or change and select Edit, or 
select New to create a new connection.

6 Follow the onscreen instructions to edit 
or create the connection.

Connecting to a VPN

If you want to use your smartphone to 
access your corporate email account or 
other files on your corporate server, you 
may need to set up a VPN (virtual private 
network). A VPN enables you to log in to 
your corporate server through the 
company’s firewall (security layer).

BEFORE YOU BEGIN Check with your 
company’s system administrator to see if a 
VPN is required for accessing the corporate 
network. If you need a VPN, you 

TIP To switch between manual and automatic 
updates, open Windows Update, press Menu 
(right softkey), and select Change Schedule. 
To select or deselect the option to use your 
data plan to check for and download updates, 
press Menu (right softkey) and select 
Connections.
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must purchase and install a third-party VPN 
client in order to use this feature.

Ask your corporate system administrator 
for the following information:

• Your username and password

• Your server’s domain name

• Your server’s TCP/IP settings 

• Your server’s host name or IP address

1 Install your third-party VPN client (see 
Installing applications).

2 Press Start  and select Settings.

3 Select the Connections tab, and then 
select Connections .

4 On the Tasks tab, select Add a new 

VPN server connection.

5 Follow the onscreen instructions to 
enter the settings provided by your 
corporate system administrator.

Setting up a proxy server

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Set up my 

proxy server.

4 Check both the This network connects 

to the Internet and the This network 

uses a proxy server to connect to the 

Internet boxes.

5 Select Proxy server and enter the proxy 
server name.

6 Press OK .

Ending a data connection

If your service plan includes 
minutes-of-use fees for data connections, 
you can reduce costs by ending the data 
connection when you’ve finished browsing 
the web.

TIP To manually start a data connection on 
your wireless service provider network or 
another network, go to Connections 

Settings, and on the Tasks tab, select 
Manage existing connections. Tap and hold 
the connection you want to start, and then 
select Connect from the shortcut menu

TIP To change settings such as the port 
number, proxy server type, or credentials, 
select Advanced.
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1 On the Today screen, press Down  to 
select your wireless service provider 
name, and then press Center .

2 Select Data Connection.

Enrolling a domain

If your company uses Microsoft System 
Center Mobile Device Manager, you may 
need to use the Domain Enroll settings to 
register your smartphone within your 
company’s network.

IMPORTANT After you enroll your 
smartphone in your company’s network, 
your system administrator can turn various 

features on your smartphone on and off. If 
a feature, such as the camera or 
messaging, worked previously and this 
feature no longer works after enrollment, 
contact your system administrator to find 
out if this feature is disabled on your 
smartphone.

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Domain Enroll .

3 Press Enroll (right softkey).

4 Follow the onscreen instructions to 
complete the enrollment process.
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Although we can’t anticipate all the questions you might have, 
this chapter provides answers to some of the most commonly 
asked questions. For additional information and answers to 
other common questions, visit palm.com/treopro.

http://www.palm.com/treopro
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Transferring info from 
another device

For information on transferring your info 
from a previous Windows Mobile® device 
or from a Palm OS® by ACCESS device to 
your new Treo™ Pro Smartphone by Palm 
smartphone, visit palm.com/treopro for 
instructions.

IMPORTANT Do not use a backup utility to 
transfer your info from another device to 
your new smartphone. This can cause your 
smartphone to malfunction.

Reinstalling the 
desktop software

If you have problems synchronizing when 
using your desktop synchronization 
software, you may need to reinstall the 
software.

BEFORE YOU BEGIN Make sure your 
computer profile includes administrator 
rights to install software. In large 
organizations, these are usually granted 
by the system administrator.

1 Shut down your computer and turn it on 
again.

2 On your computer, click Start > Control 

Panel > Add or Remove Programs.

3 Remove your desktop software. For 
computers running Windows XP, the 
software is called Microsoft ActiveSync. 
For computers running Windows Vista, 
the software is called Windows Mobile 
Device Center.

4 Quit any active applications, including 
virus scanners and Internet security 
applications.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your smartphone.

DID YOU KNOW? If you have questions about 
Windows Mobile, you can go to 
windowsmobile.com. Search for Palm devices 
for information.

http://www.palm.com/treopro
http://www.windowsmobile.com
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5 On your smartphone, press Start  
and select Programs.

6 Select PC Setup .

7 Select Set up my PC.

8 Press OK .

9 Connect the USB cable to your 
smartphone by inserting it into the 
microUSB connector on the bottom of 
the smartphone. Installation starts 
automatically.

Resetting your 
smartphone

Performing a soft reset

Performing a soft reset is similar to 
restarting a computer. If your smartphone 
is not responding or you have trouble 
synchronizing with your computer, a soft 
reset may help.

1 If your smartphone responds to key 
presses, press and hold Power  to 
turn off your phone.

2 If the screen display is on, press 
Power  to turn off the screen.

3 Remove the back panel from your 
smartphone (see Removing the back 
panel).

4 Slide the stylus out from its slot.

5 Use the stylus tip to gently press the 
reset button.
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6 Wait for the progress bar on the Palm® 
logo screen to fill before continuing to 
use your smartphone.

7 Slide the back panel into place.

Performing a hard reset

A hard reset erases all personal 
information, such as appointments, 
contacts, and tasks, as well as programs 
you have added, such as third-party 
software on your smartphone. Never do a 
hard reset without first trying a soft reset. 
You can restore previously synchronized 
information the next time you sync.

IMPORTANT Synchronize to restore your 
Outlook data, such as Outlook email, 
Calendar, Contacts, Notes, and Tasks. You 
can use a backup-and-restore solution. 
Make sure it’s an application that’s 
approved by Palm, such as the one 
included on your smartphone. 

A hard reset can tell you whether a 
problem stems from your smartphone or 
from an application installed on it. If you do 
not experience the problem after you 
perform a hard reset, the problem may be 
related to software you installed. See 
Third-party applications for suggestions on 
diagnosing third-party software issues.

1 Synchronize your smartphone with your 
computer so that your smartphone 
applications and info can be restored by 
synchronizing again after you perform 
the hard reset.

TIP You can also do a soft reset by removing 
the battery and reinserting it.

DID YOU KNOW? If the phone or the Bluetooth® 
wireless technology feature was on before a 
reset, these automatically turn on after the 
reset.

TIP Some third-party applications do not 
create a backup on your computer when you 
synchronize. If you do a hard reset, you may 
lose info in these applications and you need to 
reinstall the application on your smartphone 
after the hard reset. Please contact the 
application vendor to find out if your info is 
backed up during synchronization.

DID YOU KNOW? When you synchronize after a 
hard reset, the source folder in My 
Documents changes from Treo My 
Documents to WM_your name.
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2 Remove the back panel from your 
smartphone (see Removing the back 
panel).

3 Slide the stylus out from its slot.

4 If the screen is off, press Power  to 
wake up the screen.

5 While pressing and holding End , 
use the tip of the stylus to gently 
press and release the reset button.

6 Continue pressing and holding End  
until the “Erase all data?” prompt 
appears. 

7 Press Up  to confirm the hard reset.

8 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your smartphone.

9 Slide the back panel into place.

10 (Optional) Synchronize to restore your 
previously synchronized info. If you use 
a backup utility, you may also need to 
restore a backup to recover additional 
info and settings.

Replacing the battery

Your smartphone comes with a replaceable 
battery. Be sure to use a replacement 
battery from Palm that is compatible with 
Treo Pro models. Do not use a battery from 
any earlier model of the smartphone.

1 Press Power  to turn off the 
screen.

2 With the back panel facing you, push 
the lower-right corner of the back panel 
with your right thumb. Then use both 
thumbs and firmly slide the panel away 
from you to release it.

NOTE The back panel might be difficult to 
remove the first few times. If you have 
trouble removing the back panel as 
described, go to the Knowledge Library at 
kb.palm.com. Enter 30457 in the solution 

TIP Be sure to dispose of your old battery in an 
environmentally responsible and legal way. In 
some areas, disposal in household or 
business trash is prohibited. Visit palm.com/
environment for more information.

DID YOU KNOW? Your smartphone stores all 
your info even when you remove the battery.

http://www.palm.com/environment
http://www.palm.com/environment
http://kb.palm.com/
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id field to learn different ways to remove 
the back panel.

3 Place a fingernail behind the small tab at 
the upper-left of the battery, and pull the 
end of the battery up and out of the 
compartment to remove the battery.

4 Align the metal contacts on the new 
battery with the contacts of the battery 
compartment, and then press the 
battery into place.

1 Battery contacts
2 Smartphone contacts

5 Slide the back panel into place.

2

1
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Performance

The applications are running slower than 

usual

1 Press and hold OK  to open Task 
Manager.

2 Select Stop All to close all your open 
applications.

3 Press OK .

If the previous steps don’t fix the problem, 
try doing a soft reset (see Performing a soft 
reset). If the problem persists, follow these 
steps to turn off the Voice Command 
setting, if it is enabled:

1 Press Start  and select Settings.

2 Select Personal, and then select Voice 

Command .

3 Uncheck the Enabled box.

4 Press OK .

My battery seems to drain quickly

If you have a push email solution or if you 
have set up a schedule for wireless 
synchronization, check with your email 
provider or system administrator to make 
sure that the server is set up properly to 
work with your smartphone. Incorrect 
server setup can cause excessive drain on 
your battery.

For more tips on conserving battery life, 
see Maximizing battery life).

I want to charge my smartphone by 

connecting it to my computer, but when I 

connect them, a Setup screen appears

If you want to use the connection between 
your smartphone and your computer just to 

TIP Be sure that any third-party applications 
you use on your smartphone are designed for 
Windows Mobile 6.1 Professional. 
Applications written for Windows Mobile 6.1 
Standard or earlier versions of Windows 
Mobile software do not work with your 
smartphone. 

If you can try a free version of the software 
before purchasing it, you can test it first to 
make sure it works properly.
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charge your smartphone (and not to sync), 
you need to turn off setup mode. When the 
Setup screen appears on your computer, 
on your smartphone, press Cancel (right 
softkey), and then press Exit (right 
softkey).

Screen

The screen appears blank

1 If this is the first time you are turning on 
your smartphone, you need to take out 
and reinsert the battery to turn on the 
screen (see Replacing the battery). 
Alternately, connect your smartphone to 
a wall outlet using the USB AC charger 
(see Charging the battery).

2 If you’re on a call, when the time period 
specified in Backlight Settings expires, 
the screen dims; one minute later, the 
screen automatically turns off. 
Press any key except End to wake up 
the screen. Pressing End hangs up the 
call.

3 Look closely at the screen. If you can 
see a dim image, try adjusting the 

screen brightness (see Adjusting the 
brightness).

4 If that doesn’t work, perform a soft 
reset (see Performing a soft reset).

5 If that doesn’t work, connect your 
smartphone to the USB AC charger (see 
Charging the battery) and perform a soft 
reset again.

6 If you are using a third-party application, 
make sure that the application supports 
320x320 screen resolution.

7 If that doesn’t work, perform a hard 
reset (see Performing a hard reset).

The screen doesn’t respond accurately to 

taps or activates wrong features

1 Make sure there is no debris trapped 
under the edges of the screen.

2 Press Start  and select Settings. 

3 Select the System tab, and then select 
Screen .

4 On the General tab, select Align 

Screen.

5 Tap the screen where indicated.

6 Press OK .
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Network connection

Signal strength is weak

1 If you’re standing, move about 10 feet (3 
meters) in any direction.

2 If you’re in a building, move near a 
window. Open any metal blinds.

3 If you’re in a building, move outdoors or 
to a more open area.

4 If you’re outdoors, move away from 
large buildings, trees, or electrical wires.

5 If you’re in a vehicle, move your 
smartphone so that it’s level 
with a window.

6 Try using a hands-free Bluetooth 
headset to see if that improves the 
signal strength.

My smartphone won’t connect to the 

mobile network

1 Try the preceding suggestions for weak 
signals.

2 Turn off your phone and turn it on again 
(see Turning your smartphone on/off).

3 Perform a soft reset (see Performing a 
soft reset).

My phone seems to turn off by itself

If a system error and reset occur, the 
phone automatically turns on if it was on 
before the reset. However, if your 
smartphone can’t determine if your phone 
was on before the reset, it does not 
automatically turn on the phone (see 
Turning your phone on).

TIP Become familiar with low coverage areas 
where you live, commute, work, and play so 
you know when to expect signal-strength 
issues.
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I can’t tell if data services are available 

The following icons appear in the title bar 
to indicate whether data services are 
available:

You are in an area that supports 
mobile broadband (EVDO) data 
services. EVDO (Evolution Data 
Optimized) is a wireless 
broadband technology that is 
designed for very high-speed 
data transfer, with average 
download speeds of 400 to 
600Kbps. It is capable of 
reaching download speeds up to 
3.1Mbps and upload speeds up 
to 1.8Mbps.

Your phone is on, and a mobile 
broadband data connection is 
active. You can still make or 
answer calls. When you make or 
answer a call, the data 
transmission is automatically 
interrupted.

Your phone is on and is 
connected to a mobile 
broadband network, but you are 
not actively transmitting data. 
You can still make and answer 
calls.

You are in an area that supports 
1xRTT data services. The 1xRTT 
(single-carrier [1x] radio 
transmission technology) 
wireless technology can provide 
fast data transfer and Internet 
access with average speeds of 
60 to 80Kbps and bursts up to 
144Kbps.

Your phone is on, and a 1xRTT 
data connection is active. When 
you make or receive a call, the 
data transmission is 
automatically interrupted.

Your phone is on and is 
connected to a 1xRTT network, 
but you are not actively 
transmitting data. You can still 
make and answer calls.
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My smartphone won’t connect to the 

Internet using a data connection

Your smartphone supports EVDO or 1X 
wireless data networks. To connect to the 
Internet using this method, you must 
subscribe to data services with your 
wireless service provider.

• Contact your wireless service provider 
to verify that your subscription plan 
includes data services and that these 
services have been correctly activated. 
Your wireless service provider should 
also be able to tell you if there are any 
outages in your location.

• Press and hold Power  to turn off 
your phone, and then press and hold 
the same button to turn it back on.

• Perform a soft reset (see Performing a 
soft reset).

• Confirm that data services are correctly 
configured on your smartphone by 
doing the following:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections . 

3 On the Tasks tab, select Manage 

existing connections.

4 If your wireless service provider’s name 
appears in the list, press OK . If not, 
contact your wireless service provider 
for assistance.

• Try using a Wi-Fi connection if you are in 
an area that supports it.

I can’t send or receive text or multimedia 

messages

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• Contact your wireless service provider 
to verify that your plan includes 
messaging services, that these services 
have been correctly activated, and that 
they are available at your location. Your 
wireless service provider should be able 
to tell you if messaging services have 
been experiencing transmission delays.

• If possible, contact the recipient or 
sender of the message, and make sure 
the receiving device can handle the type 
of message you’re sending.
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• If a text message arrives but does not 
display a notification, perform a soft 
reset (see Performing a soft reset).

I can’t make or receive calls using a 

hands-free device with Bluetooth® 

wireless technology

Verify all the following:

• The Turn on Bluetooth box is checked 
in Bluetooth Settings.

• Your Bluetooth device is charged and 
turned on.

• Your smartphone is within range of the 
hands-free device. Bluetooth range is 
up to 30 feet (10 meters) in optimum 
environmental conditions, which include 
the absence of the following: obstacles, 
radio interference from nearby 
electronic equipment, and other factors.

• The Bluetooth Settings screen is closed.

• You are away from other devices using 
the 2.4 GHz radio frequency, such as 
cordless phones, microwaves, and 
Wi-Fi equipment. If this is impossible, 
move the phone closer to the 
hands-free device.

• The device specifications are 
compatible with your smartphone.

I lost the connection between my 

smartphone and my Bluetooth headset

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Bluetooth.

3 Select the Devices tab.

4 Select your headset name from the list.

5 In Partnership Settings, make sure the 
Hands Free box is checked.

6 Select Save.

7 Highlight the headset name.

8 Press and hold Center  to open the 
shortcut menu and select Set as 

Hands-Free.

9 Test your headset by making or 
receiving a call.

If the headset still doesn’t work, delete the 
existing partnership and create a new one. 
To delete the partnership:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Bluetooth.
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3 Highlight the headset device name.

4 Press and hold Center  to open the 
shortcut menu, and select Delete.

5 Create a new partnership (see 
Connecting to devices with Bluetooth® 
wireless technology.

Synchronization

Synchronization enables you to back up the 
information on your smartphone onto your 
computer or your server. If you ever need 
to perform a hard reset or otherwise erase 
all your information on your smartphone, 
you can synchronize your smartphone with 
your computer to restore the info. To make 
sure you always have an up-to-date backup 
of your info, synchronize frequently.

You can synchronize email and other 
information directly with Microsoft 
Exchange Server 2007, or Exchange Server 
2003 SP2, using Microsoft Exchange 
ActiveSync®, or you can synchronize your 
smartphone with your computer, using the 
desktop sync software that came with your 
smartphone.

Desktop sync software

This section covers issues with 
synchronizing using the desktop sync 
software that came with your smartphone. 
If you have a Windows XP computer, the 
desktop sync software is called 
ActiveSync® desktop software. If you have 
a Windows Vista computer, the desktop 
sync software is called Windows Mobile 
Device Center.

NOTE See Exchange ActiveSync (wireless 
synchronization) for help with direct 
wireless synchronization with an Exchange 
server.

DID YOU KNOW? You can go to the Windows 
Mobile website for more information at 
windowsmobile.com. 

DID YOU KNOW? A common cause of sync 
problems is the presence of protective 
software, such as VPNs or firewalls, on your 
computer or network.

http://www.windowsmobile.com
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My smartphone does not sync when I 

connect it to my computer with the USB 

cable. Instead, I see a Treo Setup screen.

Your connection did not switch to sync 
mode. Follow these steps to switch modes 
manually.

1 On your smartphone, press Start  
and select Programs.

2 Select PC Setup .

3 Select Synchronize.

4 If you still cannot synchronize, go to 
palm.com/treopro for synchronization 
support.

I am in sync mode, but synchronization 

isn’t working.

Even if you are in sync mode, 
synchronization cannot take place unless 
you have the desktop sync software 
installed on your computer. If you did not 
install the software during initial setup but 
want to synchronize, switch to setup mode 
so that you can install the software.

1 On your smartphone, press Start  
and select Programs.

2 Select PC Setup .

3 Select Set up my PC.

4 Connect your smartphone to your 
computer using the USB cable.

5 On your computer, follow the onscreen 
prompts to update or install the 
appropriate sync software for your 
computer (ActiveSync for Windows XP, 
or Windows Mobile Device Center for 
Windows Vista).

6 If you still cannot synchronize, go to 
palm.com/treopro for synchronization 
support.

The desktop sync software does not 

respond to sync attempt

As you complete the following steps, 
synchronize after each step. If the 
synchronization is successful, you do not 
need to complete the remaining steps.

1 Verify that the USB cable is securely 
connected at all points (see Setting up 
your computer for synchronization).

2 Make sure that all the files you’re trying 
to sync are closed on both your 
computer and your smartphone.

3 On a Windows XP computer, look for 
the ActiveSync  icon at the top of 

http://www.palm.com/treopro
http://www.palm.com/treopro
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your smartphone screen and the 
ActiveSync  icon in the taskbar on 
your computer to make sure ActiveSync 
desktop software is running on your 
computer. On a Windows Vista 
computer, look for the connection  
icon at the top of your smartphone 
screen. 

If the correct icons are not displayed, do 
the following:

Smartphone: Press Start , select 
Programs, and select ActiveSync . 
Press Menu (right softkey) and select 
Connections. Make sure the 
Synchronize all PCs using this 

connection box is checked, and that 
USB is selected from the list.

Windows XP computer: Click Start > 
Programs > Microsoft ActiveSync.

Windows Vista computer: Click Start 
> All Programs > Windows Mobile 

Device Center.

4 Do one of the following:

Windows XP computer: Double-click 
the ActiveSync  icon in your 
taskbar. From the File menu, select 

Connection Settings. Make sure the 
Allow USB connections box is 
checked and click Connect.

Windows Vista computer: Click Start 
> All Programs > Windows Mobile 

Device Center. Select Connect 

without setting up your device, and 
then select Connection settings. Make 
sure the Allow USB connections box 
is checked, and click Connect.

5 On your smartphone, press Start , 
select Settings, select the 
Connections tab, and then select USB 

to PC . If the Enable advanced 

network functionality box is checked, 
uncheck it. If this box is currently 
unchecked, then check it.

6 Perform a soft reset (see Performing a 
soft reset).

7 Restart your computer and make sure 
the desktop sync software is running.

8 If problems persist and you’re 
synchronizing through a USB hub, try 
connecting the USB cable to a different 
USB port or directly to your computer’s 
built-in USB port.
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9 If you’re already synchronizing through a 
built-in USB port on the front of your 
computer, move the USB cable to a 
USB on the back of your computer if 
your computer has USB ports in both 
places.

10 Uninstall the desktop software that 
came with your smartphone, and then 
repeat the installation process (see 
Reinstalling the desktop software).

11 For a Windows XP computer only, 
delete the existing partnership between 
your smartphone and your computer 
and create a new one by doing the 
following steps in turn:

• Disconnect your smartphone and your 
computer from the USB cable.

• Right-click the gray ActiveSync  
icon in the taskbar in the lower-right 
corner of your computer screen, and 
select Open Microsoft ActiveSync.

• Click File, and then click Delete 

Mobile Device. When asked to 
confirm, click Yes.

• Connect your smartphone and your 
computer to the USB cable.

• When the Synchronization Setup 
Wizard appears, follow the steps to 
establish a sync relationship between 
your smartphone and your computer.

12 If your organization uses a firewall or a 
VPN connection, synchronizing with 
ActiveSync may not work. For a 
Windows XP computer only, go to 
microsoft.com and search for the 
following topics to help with specific 
firewall setup situations:

• ActiveSync USB Connection 
Troubleshooting Guide

• ActiveSync with Sygate Personal 
Firewall

• ActiveSync with TrendMicro PC-cillin 
Internet Security

• ActiveSync with Norton Personal 
Firewall

• ActiveSync with Zone Alarm Security 
Suite

• ActiveSync with McAfee Personal 
Firewall

• ActiveSync with Windows Firewall

13 Verify with your computer hardware 
vendor that your operating system 
supports your internal USB controller.

http://www.microsoft.com
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Synchronization finishes but info doesn’t 

appear where it should

• With the included desktop sync 
software, your smartphone can 
synchronize with the root folders of 
Microsoft Office Outlook Contacts, 
Calendar, Tasks, and Notes (Outlook 
sold separately). If you want to 
synchronize with a global Exchange 
Address Book, you must copy the 
addresses to your local Contacts list in 
Microsoft Office Outlook (right-click the 
addresses and select Add to Personal 

Address Book).

• Microsoft Office Outlook subfolders and 
public folders are not accessible with 
the included software. You may want to 
use a third-party solution instead.

• If you’re trying to sync offline, be sure 
to set your Microsoft Office Outlook 
Calendar, Contacts, Notes, and Tasks to 
be available offline.

• For music files, update the library in 
Windows Media Player Mobile (see 
Working with libraries).

• For pictures and videos, see 
Synchronizing your pictures, videos, and 

music for information on the location of 
synchronized items.

• For Office Mobile files, see Where are 
the changes I made to my file? for 
information on the location of 
synchronized files.

• If you’re still having problems, try the 
following:

1 Make sure you’re synchronizing with 
the intended desktop personal 
information manager (PIM). The 
desktop sync software lets you 
synchronize with Microsoft Office 
Outlook for Windows. If you use a 
different PIM, you need to install 
third-party software to synchronize. For 
more information, consult the company 
that makes the PIM.

2 Open the desktop sync software on 
your computer, and make sure the Files 
synchronization option is selected (see 
Changing which applications sync).

3 Uninstall the desktop sync software, 
reboot your computer, and then repeat 
the installation process (see Reinstalling 
the desktop software).
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Synchronization starts but doesn’t finish

Make sure that you installed the desktop 
software that came with your smartphone. 
If you’re not sure whether this software is 
installed, reinstall it (see Reinstalling the 
desktop software).

My video and music files won’t sync

1 Make sure you have Windows Media 
Player 10 or later installed on your 
computer.

2 Reinstall the desktop sync software 
(see Reinstalling the desktop software). 
Media file synchronization fails if you 
installed the desktop sync software 
before you installed Windows Media 
Player.

My appointments show up in the wrong 

time slot after I sync

1 Make sure that you installed the 
desktop sync software that came with 
your smartphone. If you’re not sure 
whether this software is installed, 
reinstall it (see Reinstalling the desktop 
software).

2 Open Microsoft Office Outlook and 
correct the wrong entries.

3 Manually enter any information you 
added to your smartphone since the last 
time you synchronized.

4 Synchronize your smartphone and your 
computer.

My scheduled sync doesn’t work

By default, a scheduled sync does not work 
while you are roaming. This is to prevent 
roaming charges on your account. If 
roaming charges are not a concern, follow 
these steps to continue your sync schedule 
while roaming:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu (right softkey) and select 
Schedule.

4 Check the Use above setting when 

roaming box.

5 Press OK .
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An alert tells me that ActiveSync 

encountered a problem on the server

There is a temporary problem with the 
server or the server may be temporarily 
overloaded. Try again later. If the problem 
persists, contact your system 
administrator.

An alert tells me that there is not enough 

free memory to sync my info

The ActiveSync application on your 
smartphone ran out of storage space. Try 
the following:

1 Go to Memory Settings and close all 
running programs (see Closing 
applications).

2 If the problem persists, see Making 
room on your smartphone for 
suggestions on other ways to free up 
space on your smartphone.

An alert tells me that ActiveSync 

encountered a problem with [item type] 

[item name]

An error occurred during the sync of a 
single item. This error can usually be 
corrected only by removing the item that 

caused the error. If you sync again to see if 
the error persists, be aware that items 
causing this type of error are skipped and 
do not show up again.

My Today screen settings are not restored 

after a hard reset

Settings such as the background image and 
plug-in choices are not backed up during 
synchronization, so they can’t be restored 
after a hard reset. If you use a backup 
utility, you may be able to restore a backup 
to recover your Today screen settings and 
other additional info.

Exchange ActiveSync (wireless 

synchronization)

For issues with direct wireless 
synchronization with an Exchange server, 
see Desktop sync software.

TIP If you are synchronizing with an Exchange 
server and you’re unable to change your lock 
settings, check with your system 
administrator to find out if a systemwide 
locking policy is in place.
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An alert tells me that the server could not 

be reached

Your smartphone had to wait too long to 
connect to the Exchange server. The 
connection may have been lost, the server 
may be temporarily overloaded, or the 
server may have encountered an internal 
error. Check your Exchange server name 
and proxy server settings (see Setting up 
wireless synchronization), and try 
again later.

An alert tells me that my account 

information could not be detected

When you set up the Exchange server sync 
options, the credentials page was left 
blank. Correct the credentials (see Setting 
up wireless synchronization), or set up your 
smartphone to sync only with a computer, 
and try to sync again.

An alert tells me the device timed out 

while waiting for credentials

The Exchange server credentials screen 
was left open too long. Re-enter the 
Exchange server credentials, and try to 
sync again.

Email

I have problems using my account

Occasionally you may experience problems 
using an email account after you set it up. If 
you followed the account setup procedure 
and are experiencing problems in using the 
account, verify that the account complies 
with your email provider’s requirements by 
following these steps:

• Verify both your password and your 
username for your email account.

• Some email service providers require 
you to be on their network to use your 
email account. If this is the case, be 
sure to use your provider’s network as 
the connection type for the account.

• Some email service providers have 
other requirements specific to their 
service. Check with your service 
provider to see if any provider-specific 
requirements exist.

• Service provider settings frequently 
change. If your email account was 
working but you are currently 
experiencing problems, check with your 
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service provider to see if any of the 
account settings have changed.

I have problems sending and receiving 

email

Short periods of time when email is 
unavailable are common due to server 
problems or poor wireless coverage. If you 
have problems sending or receiving mail 
for an extended period of time, check with 
your ISP or email service provider to verify 
that the service is working properly.

Scheduled email synchronization is not 

working

If email synchronization is occurring and 
you turn your smartphone off or the 
connection to your email service provider is 
disconnected, the synchronization fails.

• Check the synchronization schedule to 
make sure that email sync is set to 
occur at the expected day and time. See 
Setting the synchronization schedule for 
details.

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu (right softkey) and select 
Configure Server. Make sure the verify 

password setting is on. This is required 
for over-the-air synchronization.

I have problems sending email

If you are able to receive email messages 
but cannot send them, try the following 
steps, in turn:

• Make sure your ISP or email provider 
allows you to access email on a 
smartphone. Some providers do not 
offer this option at all; other providers 
require an upgrade for accessing email 
on a smartphone.

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu (right softkey) and select 
Configure Server. Make sure the SSL 
box is checked.

• Enter the name of a different outgoing 
mail server for sending mail. Many ISPs, 
such as cable companies, require that 
you have an Internet connection to their 
network to send email through their 
servers. In this case, you can almost 
always receive email from these 
accounts, but if you want to send email, 
you must send it through another server 
(see Setting up a POP/IMAP account in 
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the Messaging application: Common 
email providers).

My vCard or vCal email attachment isn’t 

forwarding correctly

Microsoft Office Outlook provides several 
features, including vCard and vCal, that 
work with email client software on a 
Windows computer. For these features to 
work correctly, the email client software 
must be properly set up. Follow these 
steps to check the settings:

1 Click Start on your computer and select 
Settings.

2 Select Internet Options and click the 
Programs tab.

3 Make sure that the email field is set to 
the correct email client software. 

4 Click OK.

5 Start the email client software and 
make sure it is configured as the default 
MAPI client. Consult the documentation 
for your desktop email application for 
more information.

When I sync with my Exchange server my 

info is not downloading to my 

smartphone

Check with your system administrator to 
obtain the name of the mail server that 
offers you wireless access to the corporate 
mail system. If you cannot obtain the name 
of this server (some companies do not give 
it out, because they do not want wireless 
access to their servers), you cannot use 
Exchange ActiveSync to synchronize with 
the Exchange server.

It’s possible that the SSL setting is turned 
off. Verify the setting by following these 
steps:

1 Press Start  and select Programs. 

2 Select ActiveSync . 

3 Press Menu (right softkey) and select 
Configure Server. 

4 Make sure the SSL box is checked.



T R O U B L E S H O O T I N G

W E B324

14
C

H
A

P
T

E
R

Web

I can’t access a web page

First, make sure you have Internet access. 
Open Internet Explorer Mobile and try to 
view a web page you’ve loaded before. To 
ensure that you’re viewing the page 
directly from the Internet, press Menu 
(right softkey) and select Refresh. After 
confirming your Internet connection, try to 
view the page in question again. If it comes 
up blank, press Menu (right softkey) and 
select Refresh.

If you’re still having trouble, the page may 
contain elements that are not supported by 
Internet Explorer Mobile, such as Flash, 
Shockwave, VBScript, WML script, and 
other plug-ins.

Some websites use a redirector to their 
true home page. For example, if you enter 
the address http://palm.com/support, it 
may resolve to http://palm.com/us/support. 
If Internet Explorer Mobile can’t follow the 
redirect, try using a desktop browser to 

see the landing page of the redirector, and 
enter that address in Internet Explorer 
Mobile.

An image or map is too small on my 

smartphone screen

Internet Explorer Mobile has several 
viewing modes: Full Screen, Mobile, and 
Desktop. Switch to Full Screen or Desktop 
mode to see the full-size image (see 
Viewing a web page).

A secure site refuses to permit a 

transaction

Some websites don’t support certain 
browsers for transactions. Please contact 
the site’s webmaster to make sure the site 
allows transactions using Internet Explorer 
Mobile.

TIP Your smartphone can open your email 
application when you select an email address 
on a web page. If nothing happens when you 
select the link, try setting up your email 
application first.

http://www.palm.com/support
http://www.palm.com/us/support
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Camera

Here are some tips for taking good pictures 
with the built-in camera:

• Clean the camera’s lens with a soft, 
lint-free cloth.

• Take pictures in bright lighting 
conditions. Low-light images may be 
grainy, due to the sensitivity of the 
camera.

• Hold the camera as still as possible. Try 
supporting your picture-taking arm 
against your body or a stationary object 
(such as a wall).

• Keep the subject of the pictures still. 
Exposure time is longer with lower light 
levels, so you may see a blur.

• For best results, verify that you have the 
brightest light source coming from 
behind you, lighting the subject’s face. 
Avoid taking indoor pictures with the 
subject in front of a window or light.

• Make sure the subject is at least 18 
inches (0.5 meters) away from the 
camera to ensure good focus.

When you synchronize with a Windows XP 
computer, your Camera images are stored 
in the C:\Documents and 
Settings\<Username>\My Documents\Treo 
My Documents folder on your hard drive 
(see Camera).

When you synchronize with a Windows 
Vista computer, your Camera images are 
stored in the C:\Documents and 
Settings\<Username>\Documents\Docum
ents on <User>’s Treo Pro folder on your 
hard drive (see Camera).

The Camera preview image looks strange

Some third-party applications overwrite the 
color settings on your smartphone with 
their own 8-bit color settings. This can 
affect the Camera Preview mode. Delete 
third-party applications one by one until the 

DID YOU KNOW? Pictures are 16-bit color. 
Resolution settings range from the low end of 
VGA (160 x 120 pixels) to a high end of 2 
megapixels (1600 x 1200). Video resolution 
settings range from a low end of 176 x 144 
pixels to a high end of 352 x 288 pixels. You 
can change the resolution setting by pressing 
Menu (right softkey) and selecting Resolution 
(still images) or Quality (video).
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preview image improves (see Removing 
applications).

Third-party 
applications

Sometimes third-party applications can 
cause conflicts on your smartphone. 
Third-party applications that modify 
wireless features may affect the 
performance of your smartphone and may 
require extra troubleshooting. Use caution 
when installing the following types of 
applications:

• Ringtone managers

• Caller ID applications

• Instant messaging

• Applications that modify when your 
phone or data connections turn on or off 
and how your phone behaves

If you recently installed an application and 
your smartphone seems to be stuck, try 
the following:

1 Perform a soft reset (see Performing a 
soft reset).

2 Make sure the third-party application is 
compatible with the Windows Mobile 
6.1 Professional operating system on 
your smartphone.

3 Delete the most recently installed 
application from your smartphone (see 
Removing applications).

4 If the problem persists, perform another 
soft reset.

5 If possible, synchronize or use a backup 
utility to back up your most recent info.

6 Perform a hard reset (see Performing a 
hard reset).

7 Synchronize or restore your backup to 
restore the info in your built-in 
applications.

8 If the problem is resolved, begin 
reinstalling your third-party applications 
one at a time.

9 If the problem recurs, delete the last 
application you installed and report the 
problem to its developer.
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Getting more help

Contact the vendor of any third-party 
software if you require further assistance. 

Making room on your 
smartphone

If you store a large amount of information, 
or install many third-party applications, the 
internal memory on your smartphone may 
fill up. Here are some common ways to 
clear space on your smartphone:

Camera: Large images or videos take up a 
lot of memory. Move images to an 
expansion card or delete images from your 
smartphone (see Pictures & Videos).

Messaging: Multimedia content and email 
attachments can consume excessive 

memory. Move multimedia content and 
attachments to an expansion card, or 
delete large files from your smartphone 
(see Deleting messages for information 
about deleting email messages, and 
Deleting messages for information about 
deleting text and multimedia messages). 
You may also want to empty the deleted 
items folder.

Internet: If you save links to pages you’ve 
visited in Internet Explorer Mobile, you may 
want to clear all recent pages 
(see Customizing your Internet Explorer 
Mobile settings).

Third-party applications: You can delete 
infrequently used applications or move 
them to an expansion card (see Moving 
info between your smartphone and an 
expansion card using File Explorer).

Also, remember that your smartphone 
includes an expansion card slot, and that 
you can store applications and information 
on expansion cards. However, you still 
need free memory on the smartphone 
itself to run applications from an expansion 
card.

TIP Remember that not all third-party 
applications were written with the Treo Pro 
smartphone keyboard and 5-way navigator in 
mind. You may encounter strange behavior or 
errors in these applications if you use the 
keyboard and the 5-way navigator.
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Voice quality

Is the other person hearing an echo?

• Try decreasing the volume on your 
smartphone to avoid coupling 
or feedback on the other person’s end. 
This applies to both the speakerphone 
and the handset earpiece.

• Position the smartphone closer to your 
ear to prevent sound leaking back to the 
microphone. Keep your hand away from 
the microphone hole, which is on the 
lower-right side of your smartphone.

• If you’re using Speakerphone mode 
with your smartphone lying on a flat 
surface, try turning the smartphone face 
down (screen facing the surface).

Are you hearing your own voice echo?

Ask the other person to turn down their 
volume or to hold the phone closer to 
their ear.

Is your voice too quiet on the other end?

Be sure to hold the bottom of the 
smartphone, or the hands-free 
microphone, close to your mouth.

Check the signal-strength indicator. If the 
signal is weak, try to find an area with 
better coverage.
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Terms

ActiveSync®

The software that exchanges and updates 
the information on your Treo™ Pro 
Smartphone by Palm with the information 
on your computer. 

ActiveSync desktop software

The software on your Windows XP 
computer that exchanges and updates the 
information on your computer with the 
information on your smartphone. To open 
ActiveSync on your computer, double-click 
the ActiveSync icon in the taskbar in the 
lower-right corner of your screen. If the 
icon does not appear, click Start > All 

Programs (or navigate to the Programs 
group) > Microsoft ActiveSync. See 
Installing Desktop Sync Software: 
Windows XP and Windows Vista.

auto-off interval

The time of inactivity that passes before 
the screen on your smartphone turns off. 
The wireless features on your smartphone 
are unaffected by this setting. See 
Optimizing power settings.

beam

The process of sending or receiving an 
entry or application using the infrared (IR) 
port on your smartphone or using 
Bluetooth® wireless technology. See 
Beaming information.

Bluetooth® wireless technology

Technology that enables devices such as 
smartphones, mobile phones, and 
computers to connect wirelessly to each 
other so that they can exchange 
information over short distances. For more 
info, visit bluetooth.com. See Connecting 
to devices with Bluetooth® 
wireless technology.

desktop software

A Personal Information Manager (PIM) 
application for computers, such as 
Microsoft Outlook®, that helps you manage 
your personal information and keep it 
synchronized with your smartphone. See 
Installing Desktop Sync Software: 
Windows XP and Windows Vista.

http://www.bluetooth.com
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dialog box

A set of options and command buttons that 
is enclosed by a border and that enables 
you to carry out a specific task.

EXIF (Exchangeable Image File Format)

A standard for storing interchange 
information in image files that enables 
images to be interoperable across multiple 
devices.

infrared (IR)

A way of transmitting information using 
light waves. You use the IR port on 
your smartphone to transfer information 
between other IR devices within a 
short radius. See Beaming information.

lithium-ion (li-ion)

The rechargeable battery technology used 
in your smartphone. See Charging the 
battery.

Microsoft Exchange ActiveSync®

Technology that allows your smartphone to 
synchronize email, contacts, calendar 
events, and tasks wirelessly with Microsoft 
Exchange Server 2003 SP2 or 2007. See 
Setting up wireless synchronization.

MMS (Multimedia Messaging System)

An enhanced messaging system that 
enables you to send pictures, animations, 
and ringtones almost instantly. See 
Creating and sending a multimedia 
message.

Mobile Device

The component on your Windows XP 
computer that enables you to install 
applications and other information on your 
smartphone. To access it, open Windows 
Explorer or My Computer and look for the 
icon that represents your smartphone. See 
Installing applications from your computer.

partnership

The connection that you make between 
two devices by means of Bluetooth 
wireless technology. The devices recognize 
each other because each device finds the 
same passkey on the other device. After 
you create a partnership between the 
devices, you no longer need to enter the 
passkey. Partnership is also known as 
paired relationship, pairing, trusted device, 
and trusted pair on some devices. See 
Connecting to devices with Bluetooth® 
wireless technology.
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Phone Off

Appearing on the Today screen, this 
indicates that your smartphone is not 
connected to any network, and you cannot 
make calls except those to emergency 
numbers. You can still use the organizer 
features, however. See Turning your phone 
on.

piconet

An ad-hoc network of devices that uses 
Bluetooth wireless technology to connect 
one master device with up to seven active 
slave devices. The network can include up 
to 255 inactive, or parked, slave devices 
that the master device can bring into active 
status at any time.

PIM (personal information manager)

A genre of software that includes 
applications such as Microsoft Outlook, 
Palm® Desktop software, Lotus Notes, and 
ACT!. PIMs generally store contacts, 
schedules, tasks, and memos. 

Secure Sockets Layer (SSL)

A security protocol that enables you to 
send personal information in a more secure 
manner over the Internet.

SMS (Short Messaging Service)

The service that exchanges short text 
messages almost instantly between 
mobile devices. Your smartphone can send 
and receive text messages while you are 
on a call. See Creating and sending a text 
message.

streaming

Technology that enables you to access 
media content—for example, watch video 
or listen to an audio program—directly 
from the Internet on your smartphone 
without needing to download and save a 
file on your smartphone. See Viewing a 
video.

synchronization

The process in which information that is 
entered or updated on your smartphone, 
your computer, or a server is automatically 
updated in one of the other locations either 
wirelessly or by means of a cable 
connection. See Synchronizing information.
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username

The name associated with your 
smartphone that distinguishes it from 
other Windows Mobile® devices. If you 
install desktop software, you are asked to 
give your smartphone a username. If you 
only synchronize wirelessly using Microsoft 
Exchange ActiveSync, you do not need to 
give your smartphone a username. See 
Installing Desktop Sync Software: 
Windows XP and Windows Vista.

Windows Mobile

The operating system of your Treo Pro 
smartphone. Your smartphone uses 
Windows Mobile® 6.1 Professional edition. 
When installing third-party applications to 

your smartphone, be sure to install only 
apps that are written for Microsoft 
Windows Mobile 6.1 Professional. Apps 
designed for Microsoft Windows Mobile 
6.1 Standard or any edition of Windows 
Mobile 5.0 software are not compatible 
with your Treo Pro smartphone. See 
Installing third-party applications.

Windows Mobile Device Center

The software on your Windows Vista 
computer that enables you to synchronize 
content and manage music, pictures, and 
videos between your smartphone and your 
computer. To open Windows Mobile 
Device Center on your computer, click 
Start > All Programs > Windows Mobile 
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Regulatory and safety information
FCC Statements

This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

This phone meets the FCC Radiofrequency Emission Guidelines and 
is certified with the FCC as: 

FCC ID: O8F-SKYC.

The FCC ID on your Palm smartphone is located on a label inside the 
battery compartment. The battery must be removed as shown below 
to view the label.

CAUTION Changes or modifications not expressly approved by the 
party responsible for compliance could void the user’s authority to 
operate the equipment.

Antenna Care/Unauthorized Modifications

Use only the supplied integral antenna. Unauthorized antenna 
modifications or attachments could damage the unit and may violate 
FCC regulations.

Industry Canada

Operation is subject to the following two conditions: (1) this device 
may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause 
undesired operation.

This Class B digital apparatus complies with Canadian ICES-003.

The term “IC” before the equipment certification number only 
signifies that the Industry Canada technical specifications were met.

IC: 3905A-SKYC

L ‘ utilisation de ce dispositif est autorisée seulement aux conditions 
suivantes: (1) il ne doit pas produire de brouillage et (2) l’ utilisateur du 
dispositif doit étre prêt à accepter tout brouillage radioélectrique reçu, 
même si ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif. 
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Cet appareil numérique de la classe [*] est conforme à la norme 
NMB-003 du Canada.

RF Safety Exposure

General statement on RF energy: Your smartphone contains a 
transmitter and a receiver. When it is ON, it receives and transmits 
RF energy. When you communicate with your smartphone, the 
system handling your call controls the power level at which your 
smartphone transmits.

Specific Absorption Rate (SAR): Your mobile device is a radio 
transmitter and receiver. It is designed not to exceed the limits for 
exposure to radio waves recommended by international guidelines. 
These guidelines were developed by the independent scientific 
organization ICNIRP and include safety margins designed to assure 
the protection of all persons, regardless of age and health.

In order to certify this unit for sale to the public, this unit has been 
tested for RF exposure compliance at a qualified test laboratory and 
found to comply with the regulations regarding exposure to RF 
Energy under the recommendations of the International Commission 
on Non-Ionizing Radiation Protection (ICNIRP). The tests are 
performed in positions and locations as required by the FCC and IC 
for each model. 

As SAR is measured utilizing the device’s highest transmitting power, 
the actual SAR of this device while operating is typically below that 
indicated below. This is due to automatic changes to the power level 
of the device to ensure it only uses the minimum power required to 
communicate with the network.

The SAR limit for mobile devices set by FCC/IC is 1.6 W/kg averaged 
over 1 gram of tissue for the body or head (4.0 W/kg averaged over 
10 grams of tissue for the extremities—hands, wrists, ankles, and 
feet). 

The highest reported SAR values of the Palm smartphone are:

In order to comply with FCC and IC RF exposure safety guidelines, 
users MUST use one of the following types of body worn 
accessories:

1 A Palm® brand body-worn accessory that has been tested for 
(specific absorption rate) SAR compliance and is intended for use 
with this product.

2 An accessory that contains NO metal (snaps, clips, etc.) and 
provides AT LEAST 1.5 cm (0.6 in.) of separation between the 
user’s body and the unit.

Do NOT use the device in a manner such that it is in direct contact 
with the body (i. e. on the lap or in a breast pocket). Such use will 
likely exceed the FCC RF safety exposure limits. See www.fcc.gov/
oet/rfsafety for more information on RF exposure safety.

To view the most recent SAR values of the Treo Pro smartphone, visit 
palm.com/55058.

Body worn operation: Important safety information regarding radio 
frequency radiation (RF) exposure: To ensure compliance with RF 
exposure guidelines the smartphone must be used with a minimum 
of 1.5 cm (0.6 in.) separation from the body. Failure to observe these 
instructions could result in your RF exposure exceeding the relevant 
guideline limits.

Limiting exposure to radio frequency (RF) fields: For individuals 
concerned about limiting their exposure to RF fields, the World 
Health Organization (WHO) provides the following advice:

Precautionary measures: Present scientific information does not 
indicate the need for any special precautions for the use of mobile 
phones. If individuals are concerned, they might choose to limit their 
own or their children’s RF exposure by limiting the length of calls, or 
using ‘hands-free’ devices to keep mobile phones away from the 
head and body.

Further information on this subject can be obtained from the WHO 
home page http://www.who.int/mediacentre/factsheets/fs193/en/
index.html WHO Fact sheet 193: June 2000.

Maximum scaled SAR values (FCC)

Head 1.4 W/kg

Body 1.29 W/kg

http://www.fcc.gov/oet/rfsafety
http://www.fcc.gov/oet/rfsafety
http://palm.com/55058
http://www.who.int/mediacentre/factsheets/fs193/en/index.html 
http://www.who.int/mediacentre/factsheets/fs193/en/index.html 
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HAC

Using your phone with a hearing device

Your smartphone is compliant with the FCC Hearing Aid Compatibility 
(HAC) requirements. For additional HAC information, including the 
HAC rating of this product, please refer to http://www.palm.com/
treopro-t850-hac.

Your device has been tested for hearing aid compatibility. When 
some wireless phones are used near some hearing devices (hearing 
aids and cochlear implants), users may detect a buzzing, humming or 
whining noise. Some hearing devices are more immune than others 
to this interference noise, and phones also vary in the amount of 
interference they generate.

The wireless telephone industry has developed ratings for some of 
their mobile phone, to assist hearing-device users in finding phones 
that may be compatible with their hearing devices. Not all phones 
have been rated. Phones that have been rated have a label on the 
box. Your Treo Pro has an M3/T3 rating. Your smartphone has not 
been HAC rated with respect to its Wi-Fi operation because currently 
no HAC standards exist for Wi-Fi.

These ratings are not guarantees. Results will vary, depending on the 
level of immunity of your hearing device and the degree of your 
hearing loss. If your hearing device happens to be vulnerable to 
interference, you may not be able to use a rated phone successfully. 
Trying out the phone with your hearing device is the best way to 
evaluate it for your personal needs.

M-Ratings: Phones rated M3 or M4 meet FCC requirements and are 
likely to generate less interference with hearing devices than phones 
that are not labeled. M4 is the better/higher of the two ratings.

T-Ratings: Phones rated T3 orT4 meet FCC requirements and are 
likely to be more usable with a hearing device's telecoil (“T switch” 
or “Telephone Switch”) than unrated phones. T4 is the better/higher 
of the two ratings.

The more immune your hearing aid device is, the less likely you are to 
experience interference noise from your wireless phone. Hearing aid 
devices should have ratings similar to those of phones. Ask your 
hearing health-care professional for the rating of your hearing aid. Add 

the rating of your hearing aid and your phone to determine probable 
usability:

• Any combined rating equal to or greater than six offers the best 
use.

• Any combined rating equal to five is considered normal use.

• Any combined rating equal to four is considered usable.

Thus, if you pair an M3 hearing aid with an M3 phone, you will have a 
combined rating of six for “best use.” This is synonymous for T 
ratings.

Palm further suggests that you experiment with multiple phones 
(even those not labeled M3/T3 or M4/T4) while in the store to find the 
one that works best with your hearing aid device. If you experience 
interference or find the quality of service unsatisfactory after 
purchasing your device, promptly return it to the store within 30 days 
of purchase. With the Palm 30-day Risk-Free Guarantee, you may 
return the device within 30 days of purchase for a full refund, and you 
will only be responsible for charges based on your actual usage.

Getting the Best Hearing Device Experience with Your Device

To further minimize interference:

• Set the phone's screen and keyboard backlight settings to ensure 
the minimum time interval.

• Move the phone around to find the point with the least 
interference.

Battery handling:

• Do not disassemble or open, crush, bend or deform, puncture or 
shred.

• Do not modify or remanufacture, attempt to insert foreign objects 
into the battery, immerse or expose to water or other liquids, or 
expose to fire, explosion, or other hazard. 

• Only use the battery for the system for which it is specified. 

• Only use the battery with a charging system that has been 
qualified with the system per the IEEE/CTIA-1725 standard. Use 
of an unqualified battery or charger may present a risk of fire, 
explosion, leakage, or other hazard. 

http://www.palm.com/treopro-t850-hac
http://www.palm.com/treopro-t850-hac
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• Do not short-circuit a battery or allow metallic conductive objects 
to contact battery terminals. 

• Replace the battery only with another battery that has been 
qualified with the system per IEEE/CTIA-1725. Use of an 
unqualified battery may present a risk of fire, explosion, leakage 
or other hazard. 

• Promptly dispose of used batteries in accordance with local 
regulations.

• Battery usage by children should be supervised. 

• Avoid dropping the phone or battery. If the phone or battery is 
dropped, especially on a hard surface, and the user suspects 
damage, take it to a service center for inspection. 

• Do not handle a damaged or leaking lithium-Ion (li-ion) battery as 
you can be burned.

• Improper battery use may result in a fire, explosion or other 
hazard. 

Based on DOT rules, spare batteries must not be transported in 
checked luggage on commercial flights. Spare batteries can only be 
transported in carry-on luggage. For more information:
http://safetravel.dot.gov/whats new batteries.html.

Protecting Your Battery

The guidelines listed below help you get the most out of your 
battery’s performance.

Recently there have been some public reports of wireless phone 
batteries overheating, catching fire, or exploding. It appears that 
many, if not all, of these reports involve counterfeit or inexpensive, 
aftermarket-brand batteries with unknown or questionable 
manufacturing standards. Use only manufacturer-approved batteries 
and accessories found at Carrier Stores or through your device’s 
manufacturer. Buying the right batteries and accessories is the best 
way to ensure they're genuine and safe.

• In order to avoid damage, charge the battery only in temperatures 
that range from 32° F to 122° F (0° C to 50° C).

• Don’t use the battery charger in direct sunlight or in high humidity 
areas, such as the bathroom.

• Never dispose of the battery by incineration.

• Keep the metal contacts on top of the battery clean.

• Don’t attempt to disassemble or short-circuit the battery.

• The battery may need recharging if it has not been used for a long 
period of time.

• It’s best to replace the battery when it no longer provides 
acceptable performance. It can be recharged hundreds of times 
before it needs replacing

• Don’t store the battery in high temperature areas for long periods 
of time. It’s best to follow these storage rules:

• Less than one month: 14° F to 140° F (–10° C to 60° C)

• More than one month: 14° F to 113° F (–10° C to 45° C)

Power Specifications

Use only power accessories approved by Palm, such as AC-power 
adapters and batteries. Unauthorized and non-approved batteries will 
NOT operate with the Palm smartphone.

AC Power Adapter source: Foxlink
Model: 5890-712V-02K0
Part Number: 157-10108-00
Input Rating: 100–240 Vac, 50/60Hz, 0.2A
Output Rating: 5Vdc, 1000mA

Battery Source: Palm
Type: Rechargeable Li-ion Polymer
Model: 157-10105-00
Rating: 3.7Vdc, 1500mAh (minimum)

Recycling and Disposal

This symbol indicates that Palm products should be 
recycled and not be disposed of in unsorted 
municipal waste. Please return Palm products to the 
electrical and electronic equipment collection points 
in your municipality or county. These collection 
points are available free of charge. For detailed 

http://safetravel.dot.gov/whats_new_batteries.html
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information please refer to your municipality or county. For 
information on Palm's environmental programs, visit www.palm.com/
environment.

Hazardous substances that may be included in electronic products 
can potentially affect human health and the environment. Recycling 
benefits the environment by diverting waste from landfills and by 
recovering materials that may be recycled into other products. 
Responsible recycling ensures materials are properly collected and 
disposed. Palm is committed to support the European Union WEEE 
directive (2002/96/EC) and the protection of the environment for 
future generations.

It is everyone’s responsibility to ensure that electrical and electronic 
products are properly reused, recycled or recovered.

As part of Palm's corporate commitment to be a good steward of the 
environment, we strive to use environmentally friendly materials, 
reduce waste, and develop the highest standards in electronics 
recycling. Our recycling program keeps Palm handheld devices, smart 
phones and accessories out of landfills through evaluation and 
disposition for reuse and recycling.

In the USA, Palm customers may participate in the recycling program 
free of charge. Visit palm com/recycle for additional details and 
information about how you can help reduce electronic waste.

User Safety 

Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT 
OPERATION. Read this information before using your smartphone. 
For the safe and efficient operation of your smartphone, observe 
these guidelines.

Potentially explosive atmospheres: Turn off your smartphone when 
you are in any areas with a potentially explosive atmosphere, such as 
fueling areas (gas or petrol stations, below deck on boats) storage 
facilities for fuel or chemicals, blasting areas and areas near electrical 
blasting caps, and areas where there are chemicals or particles (such 
as metal powders, grains and dust) in the air.

Interference to medical and personal Electronic Devices: Most but 
not all electronic equipment is shielded from RF signals and certain 
electronic equipment may not be shielded against the RF signals 
from your smartphone.

Pacemakers: The Health Industry Manufacturers Association 
recommends that a minimum separation of 15 centimeters (6 inches) 
be maintained between a smartphone and a pacemaker to avoid 
potential interference with the pacemaker. These recommendations 
are consistent with the independent research by the 
recommendations of Wireless Technology Research.

Persons with pacemakers should:

• ALWAYS keep the smartphone more than six inches 
(15 centimeters) from their pacemaker when the smartphone is 
turned ON. 

• Not carry the smartphone in a breast pocket.

• Use the ear opposite the pacemaker to minimize the potential for 
interference.

• Turn the smartphone OFF immediately if you have any reason to 
suspect that interference is taking place.

Other Medical Devices, Hospitals: If you use any other personal 
medical device, consult the manufacturer of your device to determine 
if it is adequately shielded from external RF energy. Your physician 
may be able to assist you in obtaining this information. Turn your 
smartphone OFF in health care facilities when any regulations posted 
in these areas instruct you to do so. Hospitals or health care facilities 
may be using equipment that could be sensitive to external RF 
energy.

Repetitive Motion Injuries: When using the keyboard or playing 
games on your smartphone, you may experience discomfort in your 
neck, shoulders, hands, arms, of other parts of the body. To avoid any 
injury, such as tendonitis, carpal tunnel syndrome, or other 
musculoskeletal disorder, make sure to take necessary breaks from 
use, take longer rests (such as several hours) if discomfort or tiring 
begins, and see a doctor if discomfort persists. To minimize the risk 
of Repetitive Motion Injuries, when Texting or playing games with 
your phone:

• Do not grip the phone too tightly

http://www.palm.com/environment/
http://www.palm.com/environment/
http://www.palm.com/recycle
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• Press the buttons lightly

• Make use of the special features in the handset which minimize 
the number of buttons which have to be pressed, such as 
message templates and predictive text

• Take lots of breaks to stretch and relax

Audio Safety: This smartphone is capable of producing loud noises 
which may damage your hearing. When using the speakerphone 
feature, it is recommended that you place your smartphone at a safe 
distance from your ear. 

Blackouts and Seizures: Blinking lights, such as those experienced 
with television or playing video games may cause some people to 
experience blackout or seizure, even if never experienced before. In 
the event a smartphone user should experience any disorientation, 
loss of awareness, convulsion, eye or muscle twitching or other 
involuntary movements, stop use immediately and consult a doctor. 
Individuals with personal or family history of such events should 
consult a doctor before using the device. To limit the possibility of 
such symptoms, wherever possible every hour take a minimum of 
15 minutes, use in a well lighted area, view the screen from the 
farthest distance and avoid exposure to blinking lights if you are tired.

Operating Machinery: Do not use your smartphone while operating 
machinery. Full attention must be given to operating the machinery in 
order to reduce the risk of an accident.

Aircraft: While in aircraft, follow all instructions regarding the 
operation of your smartphone. Use of your smartphone while on 
board an aircraft must be done in accordance in compliance with 
airline instructions and regulations.

Vehicles with Air Bags: Your smartphone should not be placed in a 
position that would affect the operation of air bag deployment or in a 
position that, should the air bag inflate, could propel the smartphone. 
Air bags will inflate with great force and care should be taken to 
protect within a vehicle that has air bags. Do not place a phone in the 
area over an air bag or in the air bag deployment area. Store the 
phone safely before driving the vehicle.

Hearing Aids: People with hearing aids or other cochlear implants 
may experience interfering noises when using wireless devices or 
when one is nearby. The level of interference will depend on the type 
of hearing device and the distance from the interference source. 

Increasing the separation between them may reduce the 
interference. You may also consult your hearing aid manufacturer to 
discuss alternatives.

Small children: Do not leave your smartphone and its accessories 
within the reach of small children or allow them to play with it. They 
could hurt themselves or others, or could accidentally damage the 
smartphone. Your smartphone contains small parts with sharp edges 
that may cause an injury or which could become detached and create 
a choking hazard.

Keep the device away from the abdomens of pregnant women and 
adolescents, particularly when using the device hands-free.

To reduce exposure to radiation, use your device in good reception 
areas, as indicated by the bars on your phone, at least 3 to 4 bars.

CAUTION Avoid potential hearing loss.
Prolonged exposure to loud sounds (including music) is the most 
common cause of preventable hearing loss. Some scientific research 
suggests that using portable audio devices, such as portable music 
players and cellular telephones, at high volume settings for long 
durations may lead to permanent noise-induced hearing loss. This 
includes the use of headphones (including headsets, earbuds and 
Bluetooth® or other wireless devices). Exposure to very loud sound 
has also been associated in some studies with tinnitus (a ringing in 
the ear), hypersensitivity to sound and distorted hearing. Individual 
susceptibility to noise-induced hearing loss and other potential 
hearing problems varies. The amount of sound produced by a 
portable audio device varies depending on the nature of the sound, 
the device, the device settings and the headphones. You should 
follow some common sense recommendations when using any 
portable audio device:

• Set the volume in a quiet environment and select the lowest 
volume at which you can hear adequately.

• When using headphones, turn the volume down if you cannot 
hear the people speaking near you or if the person sitting next to 
you can hear what you are listening to.

• Do not turn the volume up to block out noisy surroundings. If you 
choose to listen to your portable device in a noisy environment, 
use noise-canceling headphones to block out background 
environmental noise.
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• Limit the amount of time you listen. As the volume increases, 
less time is required before your hearing could be affected.

• Avoid using headphones after exposure to extremely loud noises, 
such as rock concerts, that might cause temporary hearing loss. 
Temporary hearing loss might cause unsafe volumes to sound 
normal.

• Do not listen at any volume that causes you discomfort. If you 
experience ringing in your ears, hear muffled speech or 
experience any temporary hearing difficulty after listening to your 
portable audio device, discontinue use and consult your doctor.

• You can obtain additional information on this subject from the 
following sources:

American Academy of Audiology

11730 Plaza American Drive, Suite 300
Reston, VA 20190
Voice: (800) 222-2336
Email: info@audiology.org
Internet: www.audiology.org

National Institute on Deafness and Other 

Communication Disorders 
National Institutes of Health
31 Center Drive, MSC 2320
Bethesda, MD USA 20892-2320
Voice: (301) 496-7243
Email: nidcdinfo@nih.gov
Internet: http://www nidcd nih gov/health/hearing

National Institute for Occupational Safety and Health

Hubert H. Humphrey Bldg.
200 Independence Ave., SW
Washington, DC 20201
Voice: 1-800-35-NIOSH (1-800-356-4674)
Internet: http://www.cdc.gov/niosh/topics/noise

Product Handling & Safety

General statement on handling and use: You alone are responsible 
for how you use your smartphone and any consequences of its use.

You must always switch off your smartphone wherever the use of a 
phone is prohibited. Use of your smartphone is subject to safety 
measures designed to protect users and their environment.

• Always treat your smartphone and its accessories with care and 
keep it in a clean and dust-free place.

• Do not expose your smartphone or its accessories to open 
flames or lit tobacco products.

• Do not expose your smartphone or its accessories to liquid, 
moisture, or high humidity.

• Do not drop, throw, or try to bend your smartphone or its 
accessories.

• Do not use harsh chemicals, cleaning solvents, or aerosols to 
clean the device or its accessories.

• Do not paint your smartphone or its accessories.

• Do not attempt to disassemble your smartphone or its 
accessories; only authorized personnel must do so.

• Do not expose your smartphone or its accessories to extreme 
temperatures, minimum 32F and maximum 113F (0 to +45 
degrees Celsius)

• Please check local regulations for disposal of electronic products.

• Do not carry your smartphone in your back pocket as it could 
break when you sit down.

Battery: Your smartphone includes an internal lithium-ion polymer 
battery. Please note that use of certain data applications can result in 
heavy battery use and may require frequent battery charging. Any 
disposal of the smartphone or battery must comply with laws and 
regulations pertaining to lithium-ion or lithium-ion polymer batteries. 

Demagnetization: To avoid the risk of demagnetization, do not allow 
electronic devices or magnetic media close to your smartphone for a 
long time.

Normal use position: When making or receiving a phone call, hold 
your smartphone to your ear, with the bottom towards your mouth or 
as you would a fixed line phone.

http://www.audiology.org
http://www.nidcd.nih.gov/health/hearing
http://www.cdc.gov/niosh/topics/noise
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Emergency calls: This smartphone, like any wireless phone, 
operates using radio signals, which cannot guarantee connection in 
all conditions. Therefore, you must never rely solely on any wireless 
phone for emergency communications.

Smartphone heating: Your smartphone may become warm during 
charging and during normal use.

Accessories: Use only approved accessories. Do not connect with 
incompatible products or accessories. Take care not to touch or allow 
metal objects, such as coins or key rings, to contact or short-circuit 
the battery terminals.

Connection to a car: Seek professional advice when connecting a 
phone interface to the vehicle electrical system.

Faulty and damaged products: Do not attempt to disassemble the 
smartphone or its accessory. Only qualified personnel must service 
or repair the smartphone or its accessory. If your smartphone or its 
accessory has been submerged in water, punctured, or subjected to 
a severe fall, do not use it until you have taken it to be checked at an 
authorized service center.

Interference in cars and to other Electronic Devices: Please note 
that because of possible interference to electronic equipment, some 
vehicle manufacturers forbid the use of mobile phones in their 
vehicles unless a hands-free kit with an external antenna is included 
in the installation. RF energy may affect improperly installed or 
inadequately shielded electronic operating and entertainment 
systems in motor vehicles. Check with the manufacturer or 
representative to determine if these systems are adequately shielded 
from external RF energy. Also check with the manufacturer of any 
equipment that has been added to the vehicle.

Driving Safety

Driving Safety Tips Overview

Always obey all laws and regulations on the use of the smartphone in 
your driving area.

Safety—Your most important call. The Wireless Industry reminds you 
to use your smartphone safely when driving.

1 Get to know your smartphone and its features, such as speed-dial 
and redial.

2 Use a hands-free device.
3 Position your smartphone within easy reach.
4 Let the person you are speaking to know you are driving; if 

necessary, suspend the call in heavy traffic or hazardous weather 
conditions.

5 Do not take notes, look up phone numbers, read/write e-mail, or 
surf the internet while driving.

6 Dial sensibly and assess the traffic; if possible, place calls when 
you are not moving or before pulling into traffic.

7 Do not engage in stressful or emotional conversations that may 
divert your attention from the road.

8 Dial your national emergency number to report serious 
emergencies. This is a free call from your smartphone.

9 Use your smartphone to help others in emergencies.
10 Call roadside assistance or a special non-emergency wireless 

number when necessary.
Driving Safety Tips Details

1 Get to know your smartphone and its features such as speed-dial 
and redial. Carefully read your instruction manual and learn to 
take advantage of valuable features most smartphone models 
offer, including automatic redial and memory dial. Also, work to 
memorize the smartphone keyboard so you can use the 
speed-dial function without taking your attention off the road.

2 Use a hands-free device. A number of hands-free smartphone 
accessories are readily available today. Whether you choose an 
installed mounted device for your smartphone or a speakerphone 
accessory, take advantage of these devices. If driving while using 
a smartphone is permitted in your area, we recommend using a 
phone headset or a hands-free car kit (sold separately). However, 
be aware that use of a headset that covers both ears impairs your 
ability to hear other sounds. Use of such a headset while 
operating a motor vehicle or riding a bicycle may create a serious 
hazard to you and/or others, and may be illegal. If you must use a 
stereo headset while driving, place a speaker in only one ear. 
Leave the other ear free to hear outside noises, and do so only if 
it is legal and you can do so safely.

3 Make sure you place your smartphone within easy reach and 
where you can grab it without removing your eyes from the road. 
If you get an incoming call at an inconvenient time, let your 
voicemail answer it for you.

4 Suspend conversations during hazardous driving conditions or 
situations. Let the person you are speaking to know you are 
driving; if necessary, suspend the call in heavy traffic or 
hazardous weather conditions. Rain, sleet, snow, and ice can be 
hazardous, but so is heavy traffic. As a driver, your first 
responsibility is to pay attention to the road.
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5 Do not take notes, look up phone numbers, read/write e-mail, or 
surf the internet while driving. If you are reading an address book 
or business card while driving a car, or writing a to-do list, then 
you are not watching where you are going. It's common sense. 
Don't get caught in a dangerous situation because you are 
reading or writing and not paying attention to the road or nearby 
vehicles.

6 Dial sensibly and assess the traffic; if possible, place calls when 
you are not moving or before pulling into traffic. Try to plan your 
calls before you begin your trip, or attempt to schedule your calls 
with times you may be temporarily stopped or otherwise 
stationary. But if you need to dial while driving, follow this simple 
tip: dial only a few numbers, check the road and your mirrors, 
then continue.

7 Do not engage in stressful or emotional conversations that may 
be distracting. Stressful or emotional conversations and driving 
do not mix—they are distracting and even dangerous when you 
are behind the wheel. Make people you are talking with aware 
you are driving and if necessary, suspend phone conversations 
which have the potential to divert your attention from the road.

8 Use your smartphone to call for help. Your smartphone is one of 
the greatest tools you can own to protect yourself and your 
family in dangerous situations—with your smartphone at your 
side, help is only three numbers away. Dial your national 
emergency number in the case of fire, traffic accident, road 
hazard, or medical emergencies. Remember, your national 
emergency number is a free call on your smartphone.

9 Use your smartphone to help others in emergencies. If you see 
an auto accident, crime in progress, or other serious emergency 
where lives are in danger, call your national emergency number, 
as you would want others to do for you.

10 Call roadside assistance or a special wireless non-emergency 
assistance number when necessary. Certain situations you 
encounter while driving may require attention, but are not urgent 
enough to merit a call to your national emergency number. But 
you can still use your smartphone to lend a hand. If you see a 
broken-down vehicle posing no serious hazard, a broken traffic 
signal, a minor traffic accident where no one appears injured, or a 
vehicle you know to be stolen, call roadside assistance or other 
special non-emergency wireless number.

End user notice

Microsoft® Voice Command Version 1.5 for Windows Mobile®

NOTE The Voice Command application is not available in all 
languages. See Setting up voice commands.

IMPORTANT Do not become distracted from driving safely if 
operating a motor vehicle while using Device Software. Operating 
certain parts of this Device requires user attention. Diverting attention 
away from the road while driving can possibly cause an accident or 
other serious consequences. Even occasional, short diversions of 
attention can be dangerous if your attention is diverted away from 
your driving task at a critical time. Do not change system settings or 
enter data non-verbally (using your hands) while driving. Stop the 
vehicle in a safe and legal manner before attempting these 
operations. This is important since while setting up or changing some 
functions you might be required to distract your attention away from 
the road and remove your hands from the wheel.

Microsoft makes no representations, warranties, or other 
determinations that ANY use of the Software Product is legal, safe, or 
in any manner recommended or intended while driving or otherwise 
operating a motor vehicle.

General Operation

Voice Command Control: Many of the functions of the Device 
Software can be accomplished using only voice commands. Using 
voice commands while driving allows you to initiate the command 
with a button and then operate the Device mostly without removing 
your hands from the wheel.

Prolonged Views of Screen: If you are driving, do not access any 
function requiring a prolonged view of the screen. Pull over in a safe 
and legal manner before attempting to access a function of the 
system requiring prolonged attention. Even occasional short scans to 
the screen may be hazardous if your attention has been diverted 
away from your driving task at a critical time.

Let Your Judgment Prevail: The Device Software is only an aid. 
Make your driving decisions based on your observations of local 
conditions and existing traffic regulations. The Device Software is not 
a substitute for your personal judgment.

Volume Setting: Do not raise the volume excessively. Keep the 
volume at a level where you can still hear outside traffic and 
emergency signals while driving. Driving while unable to hear these 
sounds could cause an accident.
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Use of Speech Recognition Functions: Speech recognition 
software is inherently a statistical process which is subject to errors. 
It is your responsibility to monitor the speech recognition functions 
and address any errors.

Hands-Free Capability

All CTIA Certified portable products provide the consumer with a 
toll-free number for the purchase of a compatible hands-free device. 
1-800-881-7256.

ESD Safety

Electrostatic discharge (ESD) can cause damage to electronic devices 
if discharged into the device, so you should take steps to avoid such 
an occurrence.

Description of ESD

Static electricity is an electrical charge caused by the buildup of 
excess electrons on the surface of a material. To most people, static 
electricity and ESD are nothing more than annoyances. For example, 
after walking over a carpet while scuffing your feet, building up 
electrons on your body, you may get a shock—the discharge event—
when you touch a metal doorknob. This little shock discharges the 
built-up static electricity.

ESD-susceptible equipment

Even a small amount of ESD can harm circuitry, so when working 
with electronic devices, take measures to help protect your electronic 
devices, including your PalmTM handheld, from ESD harm. While Palm 
has built protections against ESD into its products, ESD unfortunately 
exists and, unless neutralized, could build up to levels that could harm 
your equipment. Any electronic device that contains an external entry 
point for plugging in anything from cables to docking stations is 
susceptible to entry of ESD. Devices that you carry with you, such as 
your handheld, build up ESD in a unique way because the static 
electricity that may have built up on your body is automatically passed 
to the device. Then, when the device is connected to another device 
such as a docking station, a discharge event can occur.

Precautions against ESD

Make sure to discharge any built-up static electricity from yourself 
and your electronic devices before touching an electronic device or 

connecting one device to another. The recommendation from Palm is 
that you take this precaution before connecting your handheld to your 
computer, placing the handheld in a cradle, or connecting it to any 
other device. You can do this in many ways, including the following:

• Ground yourself when you’re holding your mobile device by 
simultaneously touching a metal surface that is at earth ground.

• For example, if your computer has a metal case and is plugged 
into a standard three-prong grounded outlet, touching the case 
should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.

Conditions that enhance ESD occurrences

Conditions that can contribute to the buildup of static electricity in the 
environment include the following:

• Low relative humidity.

• Material type (The type of material gathering the charge. For 
example, synthetics are more prone to static buildup than natural 
fibers like cotton.)

• The rapidity with which you touch, connect or disconnect 
electronic devices.

While you should always take appropriate precautions to discharge 
static electricity, if you are in an environment where you notice ESD 
events you may want to take extra precautions to protect your 
electronic equipment against ESD.

Owner’s Record

The model number, regulatory number, and serial number are located 
on a nameplate inside the battery compartment. Record the serial 
number in the space provided below. This will be helpful if you need 
to contact us about your phone in the future.

Product: Treo™ Pro Smartphone by Palm

Model:

Serial No.:
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www.palm.com/recycle

http://www.palm.com/recycle
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Specifications

Radio • CDMA phone

• EVDO and 1X bands 

Phone features • Personal speakerphone

• Hands-free headset jack (3.5 mm, 3-barrel connector)

• Microphone mute option

• TTY-compatible 

• 3-way calling

• HAC compliant (M3/T4 rating)

Processor technology • Dual-core MSM7501A processor—528MHz 

Expansion • microSD card slot

Battery • Rechargeable lithium-ion

• 1500mAhr power

• Removable for replacement

• 3.5 hours full charge time

Operating system • Windows Mobile® 6.1 Professional

Camera • Still image capture resolution:1280 x 1024, 2 megapixel

• 8x digital zoom

Size • 114mm x 60mm x 13.5mm (4.5 in. x 2.36 in. x 0.53 in.)

Weight • 130 grams (4.6 ounces)
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Connectivity • Infrared (1.0 compliant)

• Bluetooth® wireless technology (2.0 + EDR compliant)

• Wi-Fi (802.11 b/g)

Display • Touch-sensitive LCD screen (includes stylus)

• 65,536 colors (16-bit color)

• Resolution: 320 x 320 

• User-adjustable brightness

Keyboard • Built-in 30-key keyboard plus 5-way navigator

• Backlight for low lighting conditions

Included software • Today/Phone (includes Speed Dial and Keypad)

• Messaging (text, multimedia, and email)

• Internet Explorer Mobile (web browser)

• Camera

• Pictures & Videos

• Windows Media Player Mobile

• File Explorer

• Contacts

• Calendar

• Tasks

• Notes
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Included software 
(continued)

• OneNote

• Task Manager

• Calculator

• ActiveSync®

• Microsoft Office Excel Mobile®

• Microsoft Office Word Mobile®

• Microsoft Office PowerPoint Mobile®

• Adobe® Reader® LE

• Voice Command

• Quick Tour

• Search

• Remote Desktop Mobile

• Wireless Modem (not available from all wireless service 
providers)

• Java (not available from all wireless service providers)

• Windows Live (not available from all wireless service 
providers)

• Windows Live Messenger (not available from all wireless 
service providers)

• Sprite Backup
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System requirements 
(for sync with desktop 
sync software using 
USB cable)

• Windows XP or Vista (later versions may also be 
supported)

• 170MB of free hard disk space

• Available USB port

Operating and storage 
temperature range

• 0° C to 50° C (32° F to 122° F)

• 5% to 90% RH
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Index
SYMBOLS
! on battery icon 22

NUMERICS
112 calls 52, 286
1st day of week option 214
1X icon 65
1xRTT data connections 65
3G networks 57
5-way navigator 29, 31, 327
911 calls 52, 286
999 calls 52, 286

A
accented characters 37, 38
accessing

applications 281
menu items 33, 34
on-device help 13
online support 13, 25
remote files 269, 297
the Internet 297, 312

accessories 340, 342
account picker 122
accounts

See also email accounts
enabling TTY/TDD devices 

and 73

getting help with 13
making calls and 55, 58
preventing unauthorized 

use of 286, 292
sending messages and 

136
troubleshooting 321

Acrobat Reader. See Adobe 
Reader

activating
items on screen 32
phone 20

active calls 55
See also phone calls

ActiveSync application
defined 329
opening 87
synchronizing with 87
troubleshooting 314

ActiveSync desktop software 
182, 329

ActiveSync icon 87, 88, 329
Add new device option 68, 

175
Add new phone number to 

Contacts option 74
Add Server Source command 

90

Add to Personal Address 
Book command 318

Add to Speed Dial command 
62

adding
a second call 58
applications 281
appointments 209, 211
attachments to email 112, 

130, 257
connections 297
contacts 53, 115, 144, 

205
document templates 230
expansion cards 264
files to playlists 200
folders 233
notes 206, 216, 218, 219, 

247
tasks 215–216
untimed events 210
web favorites 158–159

address books 116–117, 
123, 207, 318

Address List Lookup 255
addresses

copying 318
creating multimedia 

messages and 137
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creating text messages 
and 133, 134

entering email 111, 123, 
205

entering web 156
getting 117, 123, 208
highlighting 32
looking up corporate 255
searching for web 43
selecting 324
synchronizing 318
verifying 111, 116

ad-hoc connections 168
adjusting screen brightness 

278
Adobe Flash Player 84
Adobe Reader 223, 228
Adobe Reader icon 250
Adobe Reader LE application 

249–252
Advanced Composer 

command 134
Advanced tab (Power 

Settings) 294
advancing slides 143, 234, 

235
AES encryption 169
Agenda View (calendar) 209

airplane mode 48
alarm clock 291

See also clock
alarm sounds 291
alarms

adding 210, 214, 216
setting 278, 291
turning on and off 277

Alarms tab 291
albums 191
alerts 64

See also alarms
aligning the screen 280
alignment settings

documents 232
spreadsheets 235

Allow USB connections 
check box 316

Alt key 38, 39
alternate characters 37, 38
alternate characters list 38
animation 195, 234, 235
anniversaries 211
answering phone calls 53–

54, 58, 73
antenna 333
Appearance tab 275, 281
application icons 39, 281

applications
See also third-party 

applications
associating with buttons 

281
choosing menu items in 

33–34
closing 41
copying 267
customizing 281–286
deleting 260, 327
downloading 257, 258
error reporting for 292
highlighting 39
included with device 346
installing 257–260, 326, 

327
losing information in 305
marking as exclusive 41
moving to expansion cards 

267
opening 39, 40, 265, 281
reinstalling 303, 305
running from expansion 

cards 265, 327
running multiple 40, 41
scrolling in 30
selecting 39, 40
sorting 42
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storing 327
switching between 43, 56
synchronizing info in 80, 

81, 82, 96
troubleshooting 305, 308
turning sounds on or off 

for 277
viewing memory usage for 

293
appointments

adding 209
appearing in wrong time 

slots 319
creating reminders for 

210, 214
deleting 213
displaying 43
marking as private 212
scheduling repeating 211
sending 138, 215
setting options for 214–

215
viewing 209, 210

area codes 207
arrow icons 29
arrow keys 30
Assign a program list 282
attachments

adding 112, 130, 257

downloading 114–115
embedded objects in 115
internal memory and 327
opening 114
removing from messages 

138
setting maximum size 125
storing 114, 123
troubleshooting 323
viewing information about 

135
attendees (meeting 

requests) 211
audio 53, 196
audio modes 73
audio recordings 138, 248

See also voice notes
authentication 168, 169
auto-completion options 284
AutoFilter settings 

(spreadsheets) 236, 243
Auto-Keyguard feature 287
Automatic Send/Receive 

option 126
automatic updates 297
auto-off interval 329
available memory 293
available storage space 293

B
background colors 139
backgrounds 183, 193, 201, 

275
backing up information 303, 

305
backlight (keyboard) 36, 295
Backlight Settings screen 36
backlight shut-off interval 36
Backspace key 32, 37
backup application (on 

device) 89
backup utilities (third-party) 

303, 305, 306, 320
backups, restoring 306, 320
banners (calendar) 210
battery

charging 21–23
connecting to Bluetooth 

devices and 174
conserving 23–24, 104, 

295
disposing of 306
handling 336
removing 305, 306
replacing 306–307
troubleshooting 308
viewing remaining power 

for 294
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viewing status of 22, 64
battery icons 22, 64
battery specifications 345
Battery tab 294
battery technology 330
beaming 24, 192, 257, 261–

263, 329
birthdays 211
blank screens 309
Block Recognizer option 284
Bluetooth devices

See also hands-free 
devices

beaming and 262
connecting to 173–177
conserving battery and 24
synchronizing over 94–95
troubleshooting 313

Bluetooth feature
turning on or off 24, 67
viewing status of 43, 64

Bluetooth icon 94
Bluetooth Settings screen 

174–177
Bluetooth technology 153, 

329
bonus software 260, 346
bookmarks 158

See also favorites

border highlight 31
brightness, adjusting 278
browsing files and folders 

256, 267
Browsing History command 

162
browsing the web. See web 

browsing
built-in applications 260, 346
built-in camera. See camera
Burst mode 184, 186
button settings (Media 

Player) 202
buttons

assigning voice 
commands to 282

associating with 
applications 281

disabling 286
reassigning 281–282
selecting 29, 31
turning sounds on or off 

for 277
Buttons Settings screen 281

C
calculations 238, 270
Calculator app 270–271
calculator buttons 271

calendar
See also Calendar 

application
adding items to 209, 210, 

211, 215
displaying 208
hiding items on 212
moving through 209
removing items 213, 217
setting alarms for 210, 

214, 216
sorting tasks on 217
unavailable slots on 212
viewing appointments on 

43
Calendar application

adding contacts and 205
customizing 214–215
managing schedules with 

209–213
opening 208
sending meeting requests 

and 129
Calendar icon 208
calendar settings 214–215
calendar views 208, 214
Call History list 60
Call Status softkey 55
call waiting 58
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caller ID applications 326
caller ID blocking 57
caller ID pictures 183, 192, 

205
caller IDs 72
camera

capturing videos with 
187–188

overview 183
taking pictures 184–187
troubleshooting 325

camera icons 184
camera modes 184, 186
Camera Preview Mode 325
camera settings 185, 188–

190
camera specifications 345
cancelling selections in lists 

35
capitalization 36, 285
Capitalize first letter of 

sentence check box 285
Caps Lock icon 36
Caps Lock mode 36
captions 137, 138
Capture Settings tab 188
car kits 66, 67, 69
carrier. See service providers
cascading menus 33

case-sensitive searching 
230, 244

cell patterns (spreadsheets) 
235

cell references 
(spreadsheets) 239

certificates 126, 155, 292
Certificates icon 292
Certificates screen 292
changing

alarm sounds 291
calendar views 209
color themes 275, 281
connections 297
contacts 206–207
date and time settings 290
information 244
picture or video resolution 

325
sync settings 92
text 230
text size 279

characters
See also text
capitalizing 36, 285
creating messages and 

134
entering 36, 37, 239
highlighting 32

moving to specific 30
typing alternate 37, 38

charge indicator 22
charging smartphone battery 

21–23
charging status 22, 64
charts 236, 243, 244
chat sessions 143
chat view 140, 141, 143
check boxes 31
Check Names command 111
Clear Now Playing command 

200
Clear Type tab 279
clearing

Browsing History list 162
Call History list 61

clock 279
Clock & Alarms icon 279, 

290
Clock & Alarms Settings 

screen 290, 291
closing

applications 41
drop-down lists 35
Internet Explorer Mobile 

156
menus 33
screens 31
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color settings 139, 325
color themes 275, 281
Comm Manager 48, 175
commands. See menu 

items; voice commands
Company Directory 

command 117, 208
company names 207
comparisons 243
completed tasks 216, 217
compressed files 257
computers

accessing remote 268
charging smartphone and 

22
connecting to 80
installing from 259
reinstalling desktop 

software on 303
setting up device and 12
synchronizing with 88, 95, 

96, 181, 225
conference calls 58–59
confidential events 213
configurations

data services 312
mail servers 323
troubleshooting 312
TTY/TDD devices 72–73

Configure Server command 
323

Configure Wireless 
Networks screen 166

confirmation messages 146
Connect command 298
Connect via Bluetooth 

command 94
Connect via IR command 95
connecting smartphone to 

PCs 80
Connection Settings 

command 316
connections

accessing Internet and 
153, 155, 164, 297

accessing mobile 
networks and 310

accessing VPN clients and 
297, 298

beaming and 262, 263
changing 297
conserving battery and 18, 

24
creating 297, 298
displaying 297
enabling Bluetooth 67, 94, 

173
enabling TTY/TDD 72–73

enabling Wi-Fi 165
ending 298
losing 313
making phone calls and 57
manually starting 298
remote computers and 

268
setting up 297–298
synchronizing and 80, 86
timing out 321
troubleshooting 308, 310–

314, 324
viewing status of 63–65

Connections icon 297, 298
Connections screen 297, 

298, 312, 313
connectivity specs 346
conserving smartphone 

battery 23–24, 104, 295
contact categories 206
Contact Details command 

135, 142
contact lookup feature 49, 

50, 206
contact names, dialing by 

50–51
contacts

adding 53, 115, 144, 205
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assigning caller IDs 192, 
205

assigning ringtones 72, 
205

assigning speed dial 
numbers 62–63

copying 206
editing 206–207
getting from address 

books 117, 208
removing 207
saving info for 57–58
searching for 50, 206, 207
selecting 206
sending 138, 208
transferring to car kits 70
viewing information about 

135, 142, 207
Contacts app 205–208
Contacts list 207
Contacts picture mode 184, 

186
context-sensitive menus 33, 

34
continuous playback (slides) 

235
cookies 155
copying

addresses 318

applications 267
contacts 206
documents 231
items in folders 257
media files 182
phone numbers 51, 53, 

160
pictures or videos 192
text 159–160, 230

copyrighted items 191
corporate email passwords 

91
corporate mail systems 101, 

297, 323
corporate networks 292, 299
corporate servers 297, 323
coupling 328
coverage areas 12, 24, 47, 

310
creating

appointments 211
connections 297, 298
contacts 53, 115, 144, 

205
documents 228, 229
email messages 111–112
folders 233
meeting requests 129, 

211

message templates 139
multimedia messages 

136–139
notes 206, 216, 218, 219, 

247
passkeys 68, 176
playlists 199–200
reminders 210, 214, 216, 

217
tasks 215–216
templates 230, 237
text messages 133–135
untimed events 210
web favorites 158–159
workbooks 235, 237

credentials 298, 321
cropping pictures 193
currency symbols 280
Custom domain option 106
customer assistance 13
customizing

applications 281–286
Calendar 214–215
Contacts application 207
dates and time 290
email settings 121–129
Excel Mobile 246
format settings 280
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Internet Explorer Mobile 
160–162

Media Player Mobile 201
Notes application 220
Quick Menu 42
Remote Desktop Mobile 

269
system settings 290–295
system sounds 276
tasks 217–218
Today screen 275
Wi-Fi settings 170–173
Word Mobile 233

cutting. See deleting

D
daily schedules 209
data. See information
data encryption 169
data formats 279
data service icons 311
data service providers 12, 43, 

57, 322
data services 12, 311

See also accounts
data transmissions 12

See also connections
date format settings 280
dates 240, 280, 290

See also calendar

Day View 209, 214
decimal places 280
decimal symbols 280
decompression utility 257
defined names 

(spreadsheets) 242
delays 312
Delete All Calls command 60
Delete Call command 60
Deleted folder 124, 327
Deleted Items folder 119, 

145
deleting

applications 260, 327
attachments 138
certificates 292
contacts 207
documents 233
email 119, 123, 124, 127
email accounts 109
events 213
favorites 158
files 257, 327
items in folders 257
items in playlists 200
messages 145
notes 220, 249
partnerships 176, 313
pictures or videos 194

tasks 217
text 32, 50
text or multimedia 

messages 141
workbooks 246
worksheets 246

Desktop mode 156
desktop software 303, 329

See also applications; 
software

Device ID tab 88
device names 88, 332
devices

See also Bluetooth 
devices; smartphone

beaming to 262
configuring TTY/TDD 72–

73
connecting headset 66–67
discovering trusted 174, 

177
synchronizing with 

multiple 88
transferring info from 303
troubleshooting 313

Devices tab 313
device-to-device connections 

168
diagnostic information 292
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dial pad. See keypad
dialing 49–53
dialog boxes 330
digit grouping symbols 280
digital cameras 190

See also camera
digital certificates 126, 155, 

292
digital notebooks 246

See also OneNote Mobile
digital signatures 125
dimmed images 309
Direct Push Technology 89
directory services 116–117, 

123, 207
Disable touchscreen option 

287
Disconnect Bluetooth 

command 95
disconnecting from Wi-Fi 

networks 169
discovering trusted devices 

174, 177
disk space 348

See also memory
display formats 279
Display message on screen 

option 278

display names (email) 103, 
106

display options (web) 156
display settings (screen) 278
displaying

alternate characters 37
animated images 195
application menus 33, 34
appointments 43, 209, 

210
calendar 208
contact info 135, 142, 207
current connection 297
events 210, 213
folder contents 256
memory usage 293
notifications 278
on-device help 13
PDF documents 249
pictures 190, 191, 248
power settings 294
service provider 43
space on expansion cards 

267, 294
speed dial numbers 63
tasks 217, 218
unread messages 43, 48
videos 191

voicemail messages 54
web favorites 158
web pages 155, 156, 157
wireless settings 295

disposal information 2
document file types 227, 233
documentation 11, 13, 47
documents

See also Word Mobile 
application

creating 228, 229
deleting 233
finding and replacing text 

in 230
moving or copying text in 

230
opening 229
renaming 233
saving 228, 229, 231, 233
setting margins for 232
spell-checking 232

documents list 233
Domain Enroll settings 299
Download messages option 

127
Download size limit option 

92, 125
Download Size Settings 

screen 128
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downloading
Adobe Flash Player 84
applications 257, 258
attachments 114–115
email 24, 92, 113, 124, 

126
files 125, 159
images 195
Media Player 81
multimedia messages 141
Palm information and 

updates 13
pictures 159
ringtones 70
software updates 296
videos 195

down-pointing arrows 34
drafts 112, 135
drawing 218
driving safety tips 340
drop-down lists

cancelling selection in 35
closing 35
highlighting items in 29, 

32, 35
scrolling through 30
selecting items in 34

drop-down menus 33

E
EAP authentication 169
earpiece 328
echo 328
Edit sender’s message 

option 118
editing. See changing
email

adding attachments 112, 
130, 257

adding contacts and 115, 
205

adding signatures 120
conserving battery and 

104
creating 111–112
deleting 119, 123, 124, 

127
dialing from 52
displaying unread 

messages 43
downloading 24, 92, 113, 

124, 126
forwarding 119
getting attachments 114–

115
getting from corporate 

servers 297, 323
internal memory and 327

opening attachments in 
114

receiving 99, 112–113
replying to 118, 122
saving 112
saving passwords for 103
searching 118, 255
sending 112, 130, 157
setting maximum size 128
setting priority 112
setting security options for 

125
sorting 119
storing copies of 122
synchronizing 80, 113, 

128
troubleshooting 321–323

email accounts
changing display names 

for 103, 106
changing settings for 109
deleting 109
selecting 110, 122
setting up 101–109
troubleshooting 321

email addresses
adding 111, 123, 205
highlighting 32
verifying 111, 116
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email applications 324
email client software 323
email providers 102, 104
email settings 121–129
email shortcuts 120
emergency calls 52, 286
emoticons 137, 151
Empty Deleted Items 

command 119, 145
Enable Clear Type option 279
Enable local network time 

option 291
Enable Quick Menu option 

42
encryption 125, 155, 169, 

268
ending data connections 298
entry fields

deleting text in 32
highlighting text in 32
moving to 29
scrolling through 30

Erase all data? prompt 306
erasing. See deleting
error messages 277, 320
Error Reporting icon 293
Error Reporting screen 292, 

293
errors 182, 292, 310, 320

EV icon 65
EVDO data connections 65
event categories 213
event icons 214
events

adding reminders for 210, 
214

creating 210, 211
deleting 213
displaying messages for 

71
filtering 213
marking as sensitive 212
selecting sounds for 71, 

278
Excel files 223

See also Excel Mobile; 
spreadsheets

Excel Mobile application 
235–246

Excel Mobile icon 237
Exchange ActiveSync 89, 

323, 330
Exchange Address Book 318
Exchange server credentials 

screen 321
Exchange servers

changing email settings 
for 109

changing sync settings for 
92

deleting email accounts on 
109

finding contacts and 208
getting email from 112, 

113
sending email over 102, 

106, 116
sending meeting requests 

and 212
setting up accounts for 

90–92
synchronizing with 80, 86, 

89, 92, 93
troubleshooting 320–321, 

323
Exchangeable Image File 

Formats 330
Exclusive Programs list 42
EXIF formats 330
expansion card slot 345
expansion cards

browsing on 267
displaying available space 

on 267, 294
encrypting 268
formatting 264
inserting 264
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installing apps on 259
moving apps to 267
moving info to 245, 266
opening items on 265
organizing info and 327
organizing pictures and 

videos on 193
removing 265
renaming 268
searching on 255, 257
storing attachments on 

114, 123
transferring files to 196, 

199, 266, 267
external power sources 294

F
factory defaults 202
factory-installed applications 

260, 346
favorites 81, 137, 158–159

See also web pages
Favorites application 81
features (smartphone) 11, 13
Federal Trade Commission 

website 293
feedback 328
fields. See entry fields
File Explorer 255, 256–257, 

267

File Explorer icon 256
file names 231, 255
file types

documents 227, 233
media files 195
multimedia 136
pictures 190
ringtones 70
videos 191

files
accessing from corporate 

accounts 297
attaching to messages 

130, 134, 135, 136, 
138

browsing 256
copying 182
decompressing 257
deleting 257, 327
downloading 125, 159
moving 233, 257
saving 266
searching for 255, 257
selecting multiple 257
transferring to expansion 

cards 196, 199, 266, 
267

viewing information about 
135, 142, 200

fill series (spreadsheets) 240
filtering

Call History list 61
events 213
information 207, 243
recent calls list 59
tasks 217

finding
contacts 50, 206, 207
email messages 118, 255
information 244
text 230, 251

firewalls 314, 317
first-letter capitalization 285
5-way navigator 29, 31, 327
Flash Player 84
flicker adjustment 189
flight mode 48
folder names 233
folders

accessing Outlook 318
adding documents to 231
browsing 256, 267
creating 159, 233
moving items to 233, 245, 

257
opening items in 257
organizing pictures and 

videos in 193
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organizing web favorites in 
158, 159

sorting contents 257
synchronizing mail 128

fonts 228, 231, 235, 279
forgetting passwords 288
format settings 280
formats

losing 228
saving documents and 

231
sending email and 125, 

128
setting display 279

formatting
charts 244
expansion cards 264
paragraphs and lists 232
spreadsheets 235, 241–

242
system data 279
text 231, 247
text messages 138, 139

Formatting toolbar 232
forms (web pages) 157
formulas 236, 239, 246
forwarding messages 119, 

142

freeing memory 260, 320, 
327

Freeze Panes option 238
Full Screen mode 156
full-charge indicators 22
functions (spreadsheets) 

236, 239

G
games 260
gestures 284
Get WorldMate icon 163
Getting Started guide 11
Global Address List Lookup 

feature 255
Global Address Lists 89, 

116–117, 123, 207
Global Input Options 221
Gmail accounts 102
GPRS networks 57
GPS icon 64
graphics programs 193

H
Hands Free check box 313
hands-free car kits 66, 67, 69
hands-free devices

connecting to 67–69
entering passkeys for 68
making phone calls and 69

purchasing 342
troubleshooting 313
turning Keyguard on or off 

for 287
turning on or off 69

hard resets 288, 305
hardware 11
headset button 66
headsets 66–67, 69, 174, 

287
hearing devices 335, 338
heat sources 24
help 13, 301
hiding calendar items 212
highlight 31
highlighting

applications 39
email addresses 32
items in folders 257
menu items 33, 34
options in lists 29, 35
phone numbers 52
text 32, 231
web links 31, 157

Hint tab 288
hints (passwords) 288
History list 160
holding phone calls 58
home locations 290
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home page (browser) 157, 
160

Hotmail 102, 109, 146
hotspots 164
HSDPA networks 57
HTML formats 114, 118
hypertext links. See links

I
icons 63

See also specific type
Identification tab 289
Ignore softkey 53
image files 136, 190, 327
images

See also pictures
dimmed 309
downloading 195
embedding 115
incorrect color settings 

and 325
setting background 193, 

275
troubleshooting web page 

324
IMAP email accounts 101, 

102–109
inactivity 294
Inbox 43, 104, 141
Inbox folders 113, 119

See also specific folder
incoming mail server settings 

107
incorrect passwords 288
indentation 232
indicator light 22, 47
information

backing up 303, 305
changing 244
displaying 42
entering 36–38, 79, 205
erasing all 314
filtering 207, 243
losing 228, 305
managing 253
moving 266
protecting 286–288
removing battery and 306
restoring 305, 306
searching for 255–256
sharing 261
sorting 243
storing 264, 327
transferring from previous 

devices 303
updating 79

infrared port. See IR port
infrared transmissions 95, 

330

Input icon 284
input options 36, 221, 284
Input screen 284, 285
inserting expansion cards 

264
installation, troubleshooting 

305, 326
installing

applications 257–260, 
326, 327

sync software 80, 84
VPN clients 297, 298

instant messaging 
applications 146, 326

internal memory. See 
memory

Internet 297, 312
See also web browsing

Internet Connection Speed 
option 201

Internet email accounts 101, 
106, 113

Internet Explorer Mobile
browsing with 155–160
closing 156
customizing 160–162
installing from 258
scrolling in 30
starting 156
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unsupported elements for 
324

Internet Service Providers. 
See ISPs

IP-based push updating 89
IR connections 263
IR port 95, 262, 330
ISP settings 297
ISPs (Internet Service 

Providers) 101, 297, 322
Items tab 275

J
Java applets 155
Java applications 260

K
keyboard

accessing alternate 
characters on 38

dialing from 49, 50, 51
entering information from 

36–38, 285
locking 286, 287
looking up contacts on 50
resizing keys 284
scrolling with 30
selecting menu items with 

33
sending email and 120

setting key combinations 
for 281

troubleshooting 327
keyboard backlight 36, 295
keyboard icon 36
keyboard specifications 346
Keyguard 286, 287
Keyguard icon 287
keypad 51
Keypad softkey 51
keys (keyboard) 35, 281, 284
Known Caller option 70

L
language settings 112
lanyards 18
leading zeros 280
LED light 22, 47
Legacy Pocket Word 228
Letter Recognizer 284
libraries (media) 197, 199
Library screen 201
lightning bolt 22
Li-Ion battery. See battery
links

creating 248
highlighting 31
playing media files and 

199

saving 327
selecting 122, 157, 248
sending 157
troubleshooting 324

list separators 280
lists

cancelling selection in 35
closing 35
creating 229, 232, 247
formatting 232
highlighting items in 29, 

32, 35
scrolling through 30, 157
selecting items in 34

Lithium Ion battery. See 
battery

Live Mail. See Windows Live 
Mail

Live Messenger. See 
Windows Live Messenger

Live Search 147
locating

contacts 50, 206, 207
email messages 118, 255
information 244

location 290
location-specific formats 

279, 290
Lock icon 156, 191, 288
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locking
smartphone screen 287
smartphone system 287
spreadsheet rows and 

columns 238
the keyboard 286, 287

logging in to
corporate networks 292
corporate servers 297

looking up contacts 50, 206, 
207

lookup feature 255
losing

connections 313
information 228, 305
passwords 288
smartphone 89, 289

low coverage areas 310
low light conditions 36
lowercase letters 36

M
magnification. See zoom 

settings
mail. See email
mail servers 107, 323
Main tab 293
Manage existing connections 

option 297, 298

Manage Folders command 
113, 129

Manage tab 277
MAPI clients 323
maps 324
margins 232
Match case option 230, 244
Match entire cells option 244
Match whole words only 

option 230
measurement units 280
media file types 195
media files

adding to playlists 199–
200

copying 182
playing 197–198
storing 199
synchronizing 81, 181–

183, 196–197
transferring 196, 199
troubleshooting 319

Media Player 81, 319
Media Player library 197, 199
Media Player Mobile 81, 

195–202
medical devices 337
meeting invitations. See 

meeting requests

meeting requests
addressing 117
creating 129, 211
receiving 129
sending 211–212, 215

memory
displaying available 267
freeing 260, 320, 327
low conditions for 293
running apps and 265
storing numbers in 271

memory buttons 271
Memory icon 267, 293
Memory screen 293
memory usage 293
memos. See messages; 

notes
menu items 33–34
Menu key 33
menus 33, 34
Menus icon 281
Menus screen 281
Message Detail command 

135, 142
Message format option 125
Message Options screen 

112
message preferences 145–

146
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message templates 139
messages

See also email, 
multimedia, and text 
messages

dialing from 52
displaying notification 278
displaying unread 43, 48
formatting 138, 139
storing 327
viewing info about 135, 

142
viewing voicemail 54

Messaging application
See also text messages; 

multimedia messages
adding contacts and 205
receiving meeting 

requests and 129
receiving messages and 

141, 142
sending email from 101, 

111, 116, 121
sending messages from 

133, 136, 145
starting chat sessions and 

143
messaging applications 326
Messaging icon 133

Messaging Options screen 
109

messaging services 312, 
330

microphone 56, 64, 328
microphone icon 283
microSD cards 264
Microsoft ActiveSync 

software. See ActiveSync 
desktop software; 
Exchange ActiveSync

Microsoft Exchange 
servers.See Exchange 
servers

Microsoft Media Player. See 
Media Player; Media 
Player Mobile

Microsoft Office Excel 236
See also spreadsheets

Microsoft Office files 223, 
225

Microsoft Office Outlook. 
See Outlook

Microsoft operating systems. 
See Windows Vista; 
Windows XP computers

Microsoft Windows Mobile 
software 258

Microsoft Windows Mobile 
website 303

Microsoft Word documents. 
See documents

Missed call option 70
MMS messaging 133, 330
MMS video icon 187
MMS video mode 184
mobile accounts. See 

accounts
Mobile Device component 

330
mobile devices 262, 303
Mobile Favorites folder 81
mobile features 13
Mobile mode 156
mobile networks 310
mobile phone numbers 205
Mobile to Market certificates 

258
Modem tab 297
modems 173, 177
Month View 209
most recently dialed 

numbers list 52
moving

document files 233, 257
files to expansion cards 

196, 199, 266, 267
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information 266
pictures or videos 192
text 230
workbooks 245

moving around the screen 
29–30

multi-line fields 30
multimedia file types 191
multimedia files 190, 327
multimedia messages

checking for 63
creating 136–139
deleting 141, 145
dialing from 52, 141
displaying 43, 48
forwarding 142
internal memory and 327
opening 141, 142
receiving 141
removing items from 138
replying to 140, 141, 142
selecting links in 144
sending 136, 140
setting preferences for 

145–146
sorting 145
troubleshooting 312
viewing status of 63

Multimedia Messaging 
System. See MMS 
messaging

music 53, 179, 196, 277
See also media files; 

playlists
music files 181, 319
muting phone calls 56
My Device folder 256
My Device library 199
My Documents folder 182, 

255, 305
My Music folder 181, 183
My Pictures folder 181, 183, 

184, 187
My Playlists category 200
My Storage Card library 199
My Text phrases 111, 134
My Treo application 25
My Videos folder 181, 183

N
names

dialing by contact 50–51
displaying service provider 

43
finding contact 50, 206, 

207
naming

document files 231, 233

expansion cards 268
folders 233
templates 230, 237
workbooks 245
worksheets 241, 242

national emergency numbers 
52

navigation features 29
navigator buttons 29, 31
negative numbers 280
network keys 169
network protocols 201
networks

connecting to 166, 167
disconnecting from 169
logging in to 292
registering device for 299
troubleshooting 310–314

New Sound command 277
note options 220
notebook 246
notes

See also Notes 
application; OneNote 
Mobile

adding 206, 216, 247
changing 248
creating 218, 219
deleting 220, 249
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renaming 220, 249
saving 220, 221
sorting 249
viewing 248

Notes application 218–221
Notes icon 218
Notes list 220
Notes tab 289
notification options 278
notification screens. See 

notifications
notifications

creating events and 71
enabling or disabling 278
receiving information and 

177
receiving messages and 

140, 141, 146
receiving phone calls and 

58
receiving voicemail 55
sending messages and 

134
setting ringtones for 70
setting system sounds for 

277
silencing sounds for 276
troubleshooting 313

Now Playing playlist 200

number format settings 280
number sign symbol 280
numbers

See also phone numbers
entering 36, 37
formatting 235, 240
pasting into Calculator 271

O
Office files 223, 225
Office Outlook. See Outlook
Office Word documents. See 

documents
on-device components 17, 

18
on-device help 13
OneNote files 223
OneNote Mobile 246–249
online address books 116–

117, 123, 207
online support 13, 25
online travel information 163
onscreen keypad 51
open networks 165, 166
opening

ActiveSync 87
Adobe Reader 228
alternate characters list 38
application menus 33, 34

applications 39, 40, 265, 
281

chat view 143
documents 229
email applications 324
email attachments 114
File Explorer 256
Inbox 43
items in folders 257
meeting invitations 130
multimedia messages 

141, 142
Outlook folders 318
Quick Menu 43
Quick Tour 13, 43
sync software window 86
text messages 141
Today screen 42
web pages 155, 158, 160, 

324
operating system (device) 

308, 332, 345
operating systems (PCs) 83
Option key 30, 37, 40, 49
Option Lock icon 37
Option Lock mode 37
options

displaying 213
highlighting 29, 31, 35
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selecting 35, 97
Options tab 276, 285, 289
Organize Slides command 

139
organizer features 48, 203
orientation (slides) 234
outages 312
outgoing mail server settings 

107
Outlook

accessing folders for 318
copying addresses to 318
receiving mail and 101, 

113, 114, 124
synchronizing with 80, 89, 

90, 118, 128
overdue tasks 217
owner information 343
Owner Information icon 289
Owner Information screen 

289

P
paired relationships. See 

partnerships
pairing. See partnerships
Palm online support 13
Palm OS applications 258
Palm OS devices 303
Panorama mode 184, 186

paragraph formatting 232
paragraph highlight feature 

32
partial envelope icon 114
partially-charged battery icon 

22
partnerships 173, 176, 313, 

330
passkeys 68, 176
Password tab 288
Password type list 288
password types 52, 288
passwords

entering 37, 91, 287, 288
forgetting or losing 288
locking device and 286, 

288
saving 103, 105
setting up email accounts 

and 103, 105
spreadsheets and 236
storing on smartphone 91

PCs. See computers
PDF files 114, 223, 249
performance 308, 326
Personal Address Book 318
personal computers. See 

computers
personal events 212

personal information 287, 
289, 329

personal information 
managers 318, 331
See also PIM applications

personalizing device 273
phone

See also phone calls; 
phone numbers; 
smartphone

activating 20
answering 53–54, 58, 73
customizing sounds for 71
dialing 49–53
disabling touch-sensitive 

feature for 286
driving and 66, 340
getting started with 20
playing music and 53
redialing 51
running applications and 

57
selecting ringtones for 70
sending text messages 

and 56
silencing ringer for 53
turning on or off 24, 47, 

48, 53
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phone as modem feature 
173, 177

phone calls
See also phone; phone 

numbers
adding a second 58
adding notes about 56, 60
adjusting volume for 72, 

342
ending 56
holding 58
making 20, 49–53
muting 56
opening Today screen 

during 43
receiving 53–54
rejecting 74
sending to voicemail 53, 

58, 74
setting up conference 58–

59
transferring to hands-free 

devices 69
troubleshooting 328
viewing info about 55, 59, 

60, 61
viewing missed 48
viewing status of 63–65

phone headsets. See 
headsets

phone number codes 50, 51
phone numbers

See also phone; phone 
calls

adding to contacts 74
assigning to speed dial 

62–63
copying and pasting 51, 

53, 160
entering 49–53
getting device 21
getting from address 

books 117, 208
highlighting 32
saving 57–58
selecting 52

phone off indicators 63, 64
Phone Off message 47, 331
phone on indicators 63, 64
Phone screen 55, 56
phone settings 70–75
Phone Settings screen 73
phone specifications 345
phone status icons 63–65
Phone/Send button 49, 53
phone-off icon 47
photo albums 191

photos. See pictures
pick lists. See drop-down lists
piconets 331
picture file types 136
picture formats 185, 190
Picture Message command 

136, 140, 145
Picture mode 186
picture playback settings 194
pictures

adding as backgrounds 
193, 275

adding to notes 248
adding web links to 157
changing resolution for 

325
deleting 194
downloading 159
editing 193
organizing 192
previewing 325
renaming 194
sending 137, 191–192
storing 184, 327
synchronizing 181–183
taking 184–187, 325
viewing 190, 191, 248

Pictures & Videos application 
190–195
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Pictures & Videos icon 190
PIM applications 331
PIMs 318, 331
Play Slide Show command 

191
Play Sound list 291
Play Sound options 71
playback controls 198, 202
playback options 201
Playback screen 201
playing

media files 197–198
presentations 234, 235
ringtones 71
video clips 195
voice notes 219, 249
voicemail messages 54, 

55
playlists 196, 197, 199–200
plug-ins 155, 276
POP email accounts 101, 

102–109
pop-up menus 33, 34
port numbers 298
ports. See IR port; USB ports
power accessories 336
Power button 48
Power icon 294
Power Save Mode 24

Power screen 294
PowerPoint files 223
PowerPoint Mobile 

application 234–235
PowerPoint Mobile icon 234
preferences 273

See also customizing
preinstalled applications 260, 

346
presentation playback 

options 234–235
presentations 234

See also PowerPoint 
Mobile

Preview Mode (camera) 325
previewing

pictures 325
ringtones 71
sounds 278
text messages 135

prioritizing
email 112
tasks 216
text messages 140

private events 212
processor 345
Program Buttons tab 282
Program Files folder 267

programs. See applications; 
software

Prompt if device unused for 
option 288

protected spreadsheets 236
protecting

information 286–288
Treo device 286

proxy servers 298
punctuation marks 37
push technology 89

Q
Quick Menu 40, 42, 43
Quick Tour 13, 43
QuickTime Player 195

R
radio 48, 345
RAS connections 297
reassigning buttons 281–282
Receiving Data message 263
recent calls list 59, 60, 63
rechargeable battery. See 

battery
recording

sounds 138, 277
videos 187–188
voice notes 218, 221, 285

recording toolbar 219
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recurring appointments. See 
repeating appointments

recycling 2
redialing phone 51
redirector (websites) 324
refreshing web pages 157, 

324
Region tab 280
regional settings 279, 290
Regional Settings icon 279
Regional Settings screen 279
registering smartphone 25
regulatory information 333
reinstalling software or 

applications 303, 305
Reject call with text message 

option 75
reminders

creating 210, 214, 216, 
217

system alarms and 291
turning on and off 277
viewing 64

remote access servers 297
Remote Desktop Mobile 

268–270
remote files 269, 297
Remove Programs icon 260
Remove Programs list 261

Remove Programs screen 
260

removing
See also deleting
battery 305, 306
expansion cards 265
Quick Menu 42
Quick Tour 13, 43

renaming
documents 233
expansion cards 268
items in folders 257
notes 220, 249
pictures or videos 194
workbooks 245
worksheets 242

repeating appointments 211
repeating sounds 71, 278
repeating tasks 216
replacing

information 244
smartphone battery 306–

307
text 230, 251

Request message delivery 
notification option 134

reset button 304
resets 288, 304–306, 310

caution for 305

resizing keyboard keys 284
resolution (camera) 325
resolution (screen) 346
restarting smartphone. See 

resets
restoring

backups 306, 320
information 305, 306
sound settings 276

restoring factory defaults 202
reverse type 32
right-click menus. See 

shortcut menus
Ring tone command 72
Ringer switch 53, 276
ringer volume 72
ringtone files 70, 136
ringtone managers 326
ringtones

assigning to caller IDs 72
assigning to contacts 205
downloading 70
previewing 71
selecting 70
sending 138

roaming 64, 93, 319
Roaming option 71
rotating pictures 193, 194
running programs icon 40
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S
safety information 2, 334, 

337, 342
Save as Template command 

139
Save password option 91, 

103, 105
Save to Contacts prompt 57
Save to Drafts command 112
Save to list 266
saving

documents 228, 229, 
231, 233

email messages 112
files 266
notes 220, 221, 285
passwords 103, 105
phone numbers 57–58
web links 327
workbooks 235, 237, 246

Schedule command 93
Schedule screen 93
scheduled syncs, 

troubleshooting 319, 322
schedules. See calendar
scheduling synchronization 

92–93
screen

activating items on 32

adjusting brightness 278
adjusting display 278
aligning 280
caring for 17
changing color themes for 

275, 281
conserving battery and 24
disabling touch-sensitivity 

for 286
fitting web pages to 156
highlighting items on 29, 

31–32
locking 287
scrolling in 29–30, 286
selecting items on 30, 32
setting backgrounds for 

193, 275
troubleshooting 280, 309
turning on or off 47, 48, 

294, 329
waking up 48, 56

screen fonts 279
Screen icon 279, 280
screen resolution 346
screen saver 48
screen specifications 346
Screen view 280
screen-locked icon 64

screens, returning to 
previous 31

screensavers 195
scroll arrows 30
scroll bar 30
Scroll upon reaching the last 

line option 286
scrolling

device screen 29–30, 286
spreadsheets 238
web pages 157

SD expansion cards 264
Search dialog box 255
Search for list 256
Search icon 255
search results list 256
Search softkey 256
searching

contacts 50, 206, 207
documents 230
email messages 118, 255
PDF files 251
spreadsheets 244
web addresses 43
web pages 146, 155

searching for files 255, 257
searching for information 

255–256
searching for signal 24



I N D E X 373

secure networks 165, 167
Secure Sockets Layer 331
secure websites 324
security

browsing websites and 
155, 168

creating passkeys and 69
downloading updates for 

296
protecting information and 

286–288, 292
sending email and 122, 

126
security certificates 292
security software 286
Send Options command 140
sending

appointments 215
copyrighted items 191
email 112, 130, 157
meeting requests 117, 

211–212, 215
multimedia messages 

136, 140
pictures 191–192
sounds 277
text messages 60, 61, 

133
videos 191–192

web links 157
sensitivity settings 212, 216
Sent folder 122
servers, troubleshooting 

320, 321, 323
service contracts 12
service providers 12, 43, 57, 

322
See also accounts; ISPs

Set as Hands-Free command 
313

Set up my proxy server 
option 298

setting alarm clock 291
Settings menu 110
settings. See options
sharing information 261
sheet list 238

See also worksheets
Shift cells options 245
Shift key 36
Short Messaging Service. 

See SMS messaging
shortcut menus 33, 34
Show half hour slots option 

214
Show list 191
Show start and due dates 

option 218

Show Tasks entry bar option 
218

Show week numbers option 
214

Side button 17
signal, searching for 24
signal strength 63, 310, 328
signal-strength icon 47, 295
signatures 120, 121
Signatures screen 121
silencing system sounds 276
silencing the ringer 53
silent alarm 277, 278
Simple PIN passwords 52, 

288
sketching 218
skins 201
slide show settings 195
slide show toolbar 191
slide shows 191, 234, 235
slide timing option 235
slider 30
slides 138, 139, 143, 234
smartphone

caring for 339
charging 21–23
freeing space on 260, 327
getting help with 13



I N D E X374

getting phone number for 
21

getting started with 12, 
13, 33

locking 287
losing 89, 289
low light conditions and 36
moving around on 27
personalizing 273
registering 25
resetting 288, 304–306, 

310
setting up 15
storing 17, 18
troubleshoot tips for 301
unlocking 288
unpacking 11
updating info on 79

smartphone components 17, 
18

smartphone features 11, 13
SMS messaging 133, 331
soft resets 304
softkeys 32
software

See also applications
accessing 12
caution for hard resets and 

305

downloading updates for 
296

included with device 346
installing sync 80, 84
purchasing 308
reinstalling 303, 305

songs, selecting 198
See also music; playlists

Sort By command 119
sort order 243
sorting

applications 42
email 119
folder items 257
information 243
messages 145
notes 249
pictures or videos 193
tasks 217

sound clips 136
sound settings 71, 276, 277
sounds

See also specific types
changing alarm 291
customizing 276
previewing 278
recording 138, 277
repeating 71
sending 277

setting system 277
silencing 276
turning off event 278

Sounds & Notifications 
screen 70, 277

Sounds & Notifications 
Settings icon 277

Sounds tab 277
speaker 196
speakerphone 56, 328
speakerphone icon 63
special characters. See 

alternate characters; 
symbols

speech recognition software 
342

speed dial 49, 62–63
Speed Dial command 63
spell-checking 112, 134, 232
Sports mode 184, 186
spreadsheet templates 235, 

237, 246
spreadsheet toolbar 238
spreadsheets

See also Excel Mobile; 
workbooks; 
worksheets

accessing 223
adding charts to 243, 244
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calculations in 238–240
creating 235
customizing filters for 243
deleting elements in 245
display options for 237–

238
entering data in 237, 240
formatting 235, 241–242
insertion options for 240
scrolling 238
searching 244
sorting in 243

Sprite Backup application 89
SSL protocol 331
Start button 39
Start menu 39, 281
starting

data connections 298
Excel Mobile 237
Internet Explorer Mobile 

156
PowerPoint Mobile 234
Quick Tour 13
synchronization 86, 88
Word Mobile 229

stereo headphones 196
stopping playback 198
stopping synchronization 97
Storage Card folder 267

storage card symbol 257
Storage Card tab 294
storage cards. See expansion 

cards
storage space 293, 320
storing

applications 327
document files 229, 231, 

233, 245
information 264, 327
media files 199
pictures 184
smartphone 17, 18
videos 187
workbooks 245

streaming 199, 331
Strong alphanumeric 

passwords 52, 288
stylus 29, 31
submenus 33
Suggest words when 

entering text option 285
support 13
symbols 37, 38, 239
sync applications 79, 87
sync conflicts 92
Sync dialing options 93
sync errors 182
sync icons 64

sync mode 86
sync options 79, 96
sync schedules, 

troubleshooting 319, 322
sync settings (Exchange 

servers) 92
sync software

installing 80, 84
selecting links to 12
synchronizing info and 82
troubleshooting 303

sync software window 86
synchronization

backing up info and 305
conserving battery and 24
defined 331
enabling wireless 80, 89–

94, 95
getting started with 25, 

79, 80
hard resets and 305, 306
initiating manual 93
initiating offline 318
initiating over Bluetooth 

devices 94–95
overview 77, 79
scheduling 92–93
sending meeting requests 

and 212
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setting up multiple 
computers for 95

setting up multiple devices 
for 88

setting up smartphone and 
12

starting 86, 88
stopping 97
transferring media files 

and 181–183, 196
transferring Office files 

and 225–227
troubleshooting 304, 314–

321, 322, 323
updating date and time 

info and 290
system alarms 291
System Center Mobile 

Device Manager 299
system dates and time 290
system errors 310
system locks 286, 287
system requirements 83
system settings 290–295
system sounds 276, 277
system warnings 277

T
tabs 30
taking pictures 184–187, 325

tapping 29, 32, 280, 284
tapping sounds 277
task categories 216, 217
Task Manager 41
tasks

adding reminders to 216
completing 217
creating 215–216
deleting 217
filtering and sorting 217
marking as sensitive 216
sending 138
setting due dates for 216
setting options for 217–

218
setting reminders for 217

Tasks application 215–218
Tasks entry bar 216, 218
Tasks icon 215
Tasks list 217
Tasks Over The Air (OTA) 89
Tasks tab (Connections) 297, 

298
technical support 13
temperature display 164
templates

documents 229, 233
messages 139
notes 219, 221

spreadsheets 235, 237, 
246

Templates folder 229, 237
tentative appointments 210
text

aligning 232
changing 230
copying 159–160
creating documents and 

228
deleting 32, 50
entering 36, 221, 285
finding and replacing 230, 

251, 285
formatting 231, 247
highlighting 32, 231
moving or copying 230
resizing 279
spell-checking 112, 134, 

232
text captions 137
text files 292
Text Layout command 139
text messages

adding web links to 157
checking for 63
converting to multimedia 

134
creating 133–135
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deleting 141, 145
displaying 43, 48
forwarding 142
making phone calls and 

52, 141
opening 141
previewing 135
receiving 133, 140, 313
replying to 140, 141, 142
selecting links in 144
sending 60, 61, 133
setting preferences for 

145–146
sorting 145
troubleshooting 312

text phrases 111, 134, 138
Text Size tab 279
themes 275, 281
third-party applications

5-way navigator and 29, 
327

accessing Outlook folders 
and 318

caution for hard resets and 
305

deleting 327
getting help with 327
installing 257, 258, 326, 

327

previewing pictures and 
325

reinstalling 303, 305
synchronizing with 81, 

305
troubleshooting 258, 308, 

326–327
time. See clock
time format settings 280
time stamps 188
time system settings 290
Time tab 290
time zones 290, 291
timer 186
tips 11
TKIP encryption 169
Today screen

accessing 42
changing color themes for 

281
connecting to Bluetooth 

devices from 175
customizing 193, 275
dialing from 49
recovering settings for 

320
removing Quick Menu 

from 42

removing Quick Tour from 
13, 43

selecting running apps 
from 40

starting web searches 
from 155

viewing info on 42–43
viewing voicemail 

messages on 54
touchscreen. See screen
touchscreen lockout 286, 

287
touch-sensitive feature 286
transactions 324
transition effects (slides) 235
transmission delays 312
Transparency level list 193
travel information 163
troubleshooting 13, 301
trusted device list 174, 175
trusted devices 174, 177

See also partnerships
trusted pairs. See trusted 

devices
TTY icon 73
TTY options 73
TTY/TDD devices 72–73
Turn Hands-free Off 

command 69
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Turn Hands-free On 
command 69

turning on or off
alarms 277, 291
event sounds 278
reminders 277
screen 294

Typing mode 220

U
UMTS networks 57
unauthorized users 286, 292
unavailable time slots 212
Unknown Caller option 71
unlocking

smartphone 288
spreadsheet rows and 

columns 238
unread messages 43, 48, 

141
unretrieved voicemail 54
untimed events 210
Update Library command 

199
Update Setup screen 296
updating information 79
uppercase letters 36, 285
URLs 122, 234

See also web links
USB cable 22, 85, 88

USB controllers 317
USB hubs 85, 316
USB ports 85, 317
Use network time zone 

option 291
User Guide 12, 25
usernames 332

V
vCal attachments 323
vCalendar attachments 134, 

138, 215
vCard attachments 134, 138, 

323
Vibrate when… check boxes 

71, 278
vibrating alarm 277, 278
video albums 191
video controls 188
video files 136, 191, 319
video icon 187
Video Message command 

136, 140, 145
Video mode 184
videos

adding web links to 157
deleting 194
downloading 195
organizing 192
playing 195

recording 187–188
renaming 194
sending 137, 191–192
setting options for 187, 

201
setting resolution for 325
setting ringtones for 183
storing 187
synchronizing 181–183
transferring to expansion 

cards 196
viewing 191

View All Calls command 60
viewing

alternate characters 37
animated images 195
application menus 33, 34
appointments 43, 209, 

210
calendar 208
contact info 135, 142, 207
current connection 297
events 210, 213
folder contents 256
memory usage 293
notifications 278
on-device help 13
PDF documents 249
pictures 190, 191, 248
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power settings 294
service provider 43
space on expansion cards 

267, 294
speed dial numbers 63
tasks 217, 218
unread messages 43, 48
videos 191
voicemail messages 54
web favorites 158
web pages 155, 156, 157
wireless settings 295

virtual private networks. See 
VPN connections

Vista operating systems. See 
Windows Vista computers

voice calls 63
voice captions 138
Voice Command application 

282–284, 341
Voice Command button 284
Voice Command icon 283, 

308
voice commands 24, 283, 

308
Voice mail option 71
voice notes

creating 218–219, 221
playing 249

saving 285
Voice recording format list 

285
voice recording formats 285
voicemail

checking for 63
listening to 54–55
sending calls to 53, 58, 74

voicemail icon 54
voicemail notifications 55
Voicemail softkey 55
volume

caution for 338
phone 72, 342
ringer 72
tapping sounds 277

VPN clients 314
VPN connections 113, 297–

298

W
waking up smartphone 

screen 48, 56
wallpaper 183
warnings 277
warranty 11
weak signals 310, 328
weather information 164
web addresses 43, 156, 324

See also web links

web browsers 155, 162
See also Internet Explorer 

Mobile
web browsing

getting started with 155, 
157, 269

memory consumption and 
327

secure sites and 155, 156, 
324

troubleshooting 324
wireless connections and 

153, 164
web favorites. See favorites
web forms 157
web links

creating 248
highlighting 31
saving 327
selecting 122, 157, 248
sending 157
troubleshooting 324

web navigation features 29
web pages

accessing 324
adding to favorites 158
arranging on screen 156
clearing links to 327
copying from 159–160
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dialing from 52, 160
downloading items from 

159, 259
moving around in 157
opening 155, 158, 160
playing media files from 

198
refreshing 157, 324
returning to recently 

viewed 160
scrolling 157
searching 146, 155
selecting addresses on 

324
sending email from 157
setting as home 157, 160
synchronizing favorites for 

81
viewing 155, 156, 157

web-based email 102, 113, 
146

websites
See also web browsing; 

web pages
accessing 153, 164
connecting to 155
ending connections to 298
redirectors and 324
searching over 146, 155

streaming from 199
submitting transactions 

and 324
Week View 209, 214
WEP encryption 169
Wi-Fi button 165
Wi-Fi feature

turning on or off 18, 24, 
165

viewing status of 43, 64
Wi-Fi networks 164–170
Wi-Fi settings 170–173
Windows Live Hotmail Inbox 

149
Windows Live Mail 147–149
Windows Live Messenger 

150–151
Windows Live Search 147
Windows Live services 146, 

192
Windows Mobile Device 

Center 79, 87, 314, 332
Windows Mobile devices 

262, 303
Windows Mobile operating 

system 308, 332
Windows Mobile software 

258

See also built-in 
applications; software

Windows Update application 
296

Windows Vista computers
enabling Bluetooth 

connections for 94
opening sync application 

for 87
synchronizing with 84, 89, 

183, 227
troubleshooting 314

Windows XP computers
enabling Bluetooth 

connections for 94
opening ActiveSync for 87
synchronizing with 84, 88, 

181, 225
troubleshooting 314, 317
viewing synchronized files 

for 182
wired headsets 66, 69
wireless connection icons 64
wireless connections

browsing websites and 
153, 164

conserving battery and 18
ending 169
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synchronizing and. See 
wireless 
synchronization

turning on 165
wireless features 295, 326
wireless service indicator 43
wireless service providers 

12, 43, 57
wireless services 295
wireless synchronization 80, 

89–94, 95
Word application 223

See also documents
Word Completion tab 285
word highlight feature 32
Word Mobile application 30, 

227–233
Word Mobile icon 229
word-processing features 

228
workbook list 246
workbooks

See also Excel Mobile 
application; 
spreadsheets

creating 235, 237
deleting 246

displaying 237–238
moving around in 238
naming 245
organizing 245
replacing information in 

244
saving 235, 237, 246
searching 244
setting default template 

for 246
worksheet names 236
worksheets

See also spreadsheets; 
workbooks

adding 241
adjusting column and row 

size for 242
changing order of 241
deleting 246
entering defined names in 

242
entering formulas in 239, 

246
entering functions in 239
filtering data in 243
formatting options for 

241–242

inserting cells, rows, and 
columns 240

moving between 238
naming 241
removing cells, rows, and 

columns 245
renaming 242

WorldMate 163–164
WPA networks 168
Writing mode 220

Y
Yahoo email accounts 102
Year View 209

Z
ZIP files 257
zoom settings

documents 229
PDF files 251
pictures 186, 248
presentations 234
smartphone screen 285
spreadsheets 236, 238
videos 188
web pages 157
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